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Wl Goig ([risue s 2azu) B Rred A Ay diud Wl Algedr Udw
Syl el 8, Fl wousl aduy Fdl 518 uel awAicdl Rial sal (@Al disedadl
Gualal 53 w3 3 d-l eedl ws. UGHL wsAYRASL M2l cudl Hldsles dAAdl AgedR WR
AHARA &S Adl vewRAsH 2WHRA WYL, 3 duR sl vuasdl weus. vl
Guald HiRel 84 wals Qoo AR sl vl €l wa v v e, v,
syl [ARY [yl w2 diud ARl AR Ried A dd yRidld wiud Akl
AUlgedR 2@ WHRA +q [Andag e 92112 2 sUqUR Y3 wsalil ey 8.

Q8L 109 2L WesAYads ‘se-vitnad’ [Avudl selul oy yads 8. k-9l [Reueil
iud AR IR Rren Gorrg, liud AHiBA woe UBAs ASR, Wl W2 2d SW,
grexdedl Guuldid adldl Wlfadl-dl b, $-48a, s1a AGAAUL QdlIAl w[APBL dal
drdll wal (B2 ewn 53 Ysul B, eAML HRWAAL AL USAYRASHL dHl UM
dotdey A dil HIRALAL w2 W2 HTML -Adisil Haoid WSy eunil uRay sadqaim
il 9, diud 2RAHL R A Wsalle wesdl ual [Rgd 2wl sl 2udl 8. AR
ugdl duil AL Giardl uglivil 2 Al Waufior eunt (A9 e 528, Al el wa
Yl W2 viAs Gelgel dl [Qarw AlRd 2uvdl sul 8. 3y wig 8 3, Wl
aulrl vedud Fenaldl dsandidl (@S sl va9d Hee3w Allid @

AN BUAL B F, L WAA R 1070 QenellolA Gualoll «flasd »id uw wa v AR
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Ra Qenl,
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0L 10 21 ulsAYRes us@ 1 el 43 WU ounl HTMLeAL ldeil Helisl
AUAA SN Ul V. 2L USWUHL HTMLAL [a51%, HTML ecudy~y oy A edides
oirladl W2 %331 Al 200l Gelewl AR Ayl unggdl dwuanl sudl 8. Aeild Gelswl
U Head i Body 201l auydl dsteit dpauul el 530 2uuciul 2udl 8. »idui HTML
sl Roll, welal v slesedl 3dl Ad Gualol A ud dell /RUd A wuydl [@lay
GelsBUL gl 2uuai il 8. wsw 5 ¥l 8 Hi iuAZuUAL Widle WAL ues Cale-l
ANAL s vl 8. SQ{AL oAUl [Qoidll YuBw (editing) il AU (formating),
3Rl [A8Ul A AW sl A SAUML Bl B, AMRUIAL G3d wqA wulial
ol walls siv Adcdd 33 Sl sl Al wulel el ausil,  wlBus,
velaliall, SqyepuGeye uBwal, Felywomi, 33, quid- wavi a4 ¥l [@8dlH

WA UsW 9 ol 16 Ui sl Ul 8. 2uld Yerlld (AW sl wils Gelswil dloy
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A5y QR ¢d s2uer sdlon WuRel Guldl dad 8. wuR & & dofl ay swe) wsslla
A AL B AW o AW adfl kB, vial vsellri A AN HWRAAL WY HWRR
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58 8. deerderl Wesil W B aduddl WRA e v &, ¥ aed ads A, WWW
Al gs4l Aot 48 B, dol 2 uddl R 19914 Ru ol (2ugla 1.1)A 2ued sd, sl
Al RAzRA viid CERN(3RU- uasugy dells A2, hitp:/cem.web.cern.ch/CERN/)4L 514 sl
gdl. A8 3 grernz Wzl wr-dll QY wwHdl (MLBEIRH) WRAA woadl ], daldy a3zl
Guasy dol-i¥dlA suGBR (AR Aadl Fgiar -l vuan AFQLL)HL Gualal gl A8 asy
8. vl AnASeradl AR 2u-) dé saladl AR (links) dlu B, wiL ALl siduA+ (hyperlink)
Ay vl 2d 8, dl aduRRig wR Bas sa AS ya alid Wil SR @A wR
wgladl a2 8. 3 Bun didubvs WA g sy B, wlks avus,
R, susld @l A6 we RAA wdl @durpars wd wisll any B.
avil Bl dLufhvs Aot u A8 29 43 wsu Al sl GG glal Bk
Asil ey 3¢l Ald eulai A asladl a2 HTML-AL g4t -1 sdueiid] glduse
Whuy dodoell 32 W, WM, HTML 3 oidoyef cgld sl 215 ount 8,
HTML A deiddor-i s, nae, sres, 9ol 4l dal avial Rau-l wuna
W2l eacud Gl 8. Q Ut Wdal 8 3 dell HTML gtl-u Gualal o3 eviida
£3% @uLEl dMIM B2z oG adlsd B,

HTML 3 3s sl wfany (AaiBq) cuvt 8. 2dsu et 3 d2dls
Aussy Aaall (o)) wyg B, % Aol aviail 3l fd 9 59 d susid
auiidl URA (An WRA BuAbd) 4Ad &, HTML s15d 9 dl 2522
5184 & ¥ i Ast-RA WA wd 20 23U aquiu-dl sidHBa iy WRA 4ud . HTML 2
MUk Wby ounl 8 2 d 2ol Aussu Ay 4Ud B, HTML R SGML (Standardized General
Markup Language) el Gldl sudl &, ¥ 198631 uidRAMU Hids A JSO) gL Hall iyl
Aal eRald el Bilel-Helerll YR 12 Ui sl el gdl.

i, HTIML 58 3 oG gl A6y v sladidl uRdl w9 i uRdldl 3@dd qeezu
& Al B, vl WRAMIY ¢ @R oAy W URA sulaa] vasy 8. vufl Anldy
AQuR R, A wdded A WA WA R4 HIML 8 avial $Bd o 8,

s WE\ HTML &:ldy

dl wd), HTMLA Guaa 531 s wg dsldy qur s33, ¥ RAINBOW [ 2l si. dsldy
w2y sl R fes 11w eulda B,

2ugld 1.1: By siizl-dll



RAINBOW

Rainbow consists of seven colours. These colours are Violet, Indigo, Blue,
Green, Yellow, Orange and Red. They are also acronymed as VIBGYOR.

Rainbow is caused by reflection of light in water droplets in the Earth's
atmosphere, resulting in a spectrum of light appearing in the sky. It takes
the form of a multi coloured arc.

ses 1.1 : HTML 43 Qe W % KA awue

g 1130 ealda @uumd ealaar w2l HTML 58 Ss-lE@Ea 1140 2wda .

<html>
<head>
<title> About Rainbow
<fitle>
</head>
<body>
<h1> RAINBOW </h1>
<p> Rainbow consists of seven colours. These colours
are Violet, Indigo, Blue, Green, Yellow, Orange and
Red. They are also acronymed as VIBGYOR.
<ip>
<p> Rainbow is caused by reflection of light in water
droplets in the Earth's atmosphere, resulting in a
spectrum of light appearing in the sky. It takes the
form of a multi coloured arc.
<ip>
</body>
</htmbP>

as-akEa 1.1

wdl 2 v wadls R 3 S[R30 1140 rainbowell @vlRl GuRid J2dis Rl S A d
gasdl A1 s e 3 wsel ue sula B, 2 v Sd wA Al el qeeld 2o s B

L A 6 ouy R Sl Weald R, UKL A, LI sl U B, A3 Udl &3 ¥A
ot dl 2ol Q2 3dl avuel AswA As ARA2 (Element) 8 &, HTML ARA-2 wudl &
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wadl R ealad w2 olsaell A wsiwr WiRd awRidl ALl wa QS W gl 1.2
GelgRel WA 23 oitm  wA AR euld 8.

4 | A\

Opening Tag Content Closing Tag
<title> About Rainbow 4 </title>
< >
Element
. J

agld 12 : HTML Al&d-2

gl 1.2 g swld B 2, <title> About Rainbow </title> 2 HTML 51l A2 8. 214l 3, Ay
el 3 ol udL 2o wserll woie QA9 <title> AUl diedl B, 3 29 ARA-2AL 2d eald B,
&3l s A d-l a2 avuel o) aulld, HTML A2 oi-ud 8. udl Title 230 HTML 418 43
oiriell Aol o, s A8l 43 B,

wlldl vy, Wg HTML W[3rer Geleml I 3oty 8 :
<h1> RAINBOW </h1>
3l hl 221 3aon w2 8.

GuR ealoul yore <h1> uA <hl> <l a2 quiel qm a2 o 204 =1 wan ¢33 w9
SRl vlad, A ¥ Ad, <p> WA </p> 3L 93 Guask quiBl F5L dd ARlAR] udd wA el
g5 A2 Y AL BUad. B Ay <html> wA <html> 2ol A safaid,

SUGEAR gl 2l W kg eulad d Fama {A 2udal waidl iRl :

Ydg 1 : Applications > Accessories > gedit e 3 gedit -unl AR W3uy vel. gedit A
GNOME (GNU il aviicl W¥serdl col, MIT giRl siiuldd 3sd Algedr), R
wraiudilee, Mac OS X i 3udslillge R 32 ey dq wes 25w ARR 8. A
oigd, d Wl Hawdl Guasy e gedit AR2+L Widsel Guadol watL 53 us.

wig 2 owiel gedit Rl SRR 1141 wle HTML S-RiER0L 8w s v 418 adu 430
gl uedll gedit AR23-D Toua vusl 1340 euldd 8. ARe Haw-l Qi U2 e
Save [Asey uie s3A "pL.html" d?13 23l 53, w1l A spotarl <y @) 3, HTML $15é htm
¥l himl 2o 0 Al 2453 B, 2l 1.4 A3 g w2l Ad sufd B,
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© @6 *Unsaved Document 1 - gedit

File Edit View Search Tools Documents Help
o lgoren v iSave = @y Undo B K o8

| *Unsaved Document 1 &

<html>
<head>
<title> About Rainbow
</title>
</head>
<body>
<h1> RAINBOW
</hl>
<p> Rainbow consists of seven colours. These colours are Vielet, Indigo,
Blue, Green, Yellow, Orange and Red. They are also acronymed as VIBGYOR.
(/p)
<p> Rainbow is caused by reflection of light in water droplets in the Earth's
atmosphere, resulting in a spectrum of light appearing in the sky. It
takes the form of a multi coloured arc.
</p>
</body>
</html>

PlainText ¥ TabWidth: 8 v Ln19, Col 1 INS [

augld 1.3 : gedit WR2ui @ HTML 53

© @ SaveAs..

Name pl.htmi

Save in folder: i@ Desktop \

+ Browse for other folders

Character Encoding: | Cumrent Locale (UTF-8) | v | Line Ending: | Unix/Linux ¥

Cancel | Save

25l 1.4 : Save As... S vlisy

uag, 3 : Mozilla Firefox 3 dsial s*wy2ul wllid s3d vy A uBl alBa-d v,
File - Open File Ydie $2\. d®l Open File siuelol ol sl adil & 16 vladl
d ude s?1 Open o2+ ¥R [R5 3. -l Aseu3d ail 1854 YR soie [Fas ua 30 w8l

156 N Mozilla FirefoxHl vleaiil 2ud dl a-dl 2riid 219 R gl 1.5 euld 8.
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© ® ® About Rainbow - Mozilla Firefox

File Edit View History Bookmarks Tools Help

@ @ | file:/home/pss/Desktop/html screens/pl.htm v v R

f5 Most Visited v |¢| Getting Started [JLatest Headlines v

o/ About Rainbow i 5

RAINBOW

Rainbow consists of seven colours. These colours are Violet, Indigo, Blue, Green, Yellow, Orange
and Red. They are also acronymed as VIBGYOR.

Rainbow is caused by reflection of light in water droplets in the Earth's atmosphere, resulting in
a spectrum of light appearing in the sky. It takes the form of a multi coloured arc.

Done

23R 1.5 : HTML 831 Guidat s suGor gl salg dody

A W wA wdlug 6B 3 HTML slsui Gualoml daidl 2oL $u-AlRARa <l Wed 3, wyal 2aq
Wal (R 3u) 3 Ul (AR 3u) A8 wral s Flagl 5309 uL qull aglal aygul, Al ay
A2 vy o i wo el wny B, A, o @l Yl e3s ARARA Adl dldl uR @vial ASH win
QUL AL W =R DY 32 Wl Quig AT,

HTML 83dy+ v

HTML €2c1dy Yol 6] ool aduide €y ® : uus yewon [Aeuol (Head section) €ld 8 i oflof
olldl [ReudL (Body section). da sH3s &8 (A2 (Head Element) st sildl s\ -2 (Body Element)
a?ld ueL aemanl 3ud &, wa @ewrd wew @A R Fd 3, iy (title) 2L we agld
(description) 414 . i 61t % MRl <head> 7l </head> 231l 42 A saladl W .

8lldl Aowal <body> A </body> 29i+ll a2l el eula B, 2 A Aold B ¥ sUGR WA AS
wsid B, e Rowdl viq olidl Rowdl 21 el <html> uA </htmb> 201l 92 214 salaiy 8.
HTML 2llMs

Aol o s TITLE ARA-2 gRRL Y sA4 B, ¥ excldo-il Mol Reuaml ysani »ud 8, 23
2wl Aluely, © % £S5 uBl eddldyq ot W o title WA dlu V. A Fd erldy-l auuee
savial W2 d Guyll V. adl, titled @viel ercidy-l dviatl eal Aol U HRENUR U dLRL
AWE vl §ld AT A dul siduaes Fal QAN s 4AAdl €l A ASH. L Title ¥
v eladl Bedeu olds a2 2vud. Bookmark list ¥iudl siGa-l SRSA(history)dl YRl i
title < 2w W V. ¥l ddl title sl dedl 25l dlal ASY Adl el AU W B,
Ne-TuRRa 1140 Ss-[af@oL Yoot wiven Gelgeldl HTML 518 W2 "About Rainbow" 3 oflds 8.
gl 1.540 ealon Homt A ealaidl Rl Guad oudl eafan B,

HTML &Qa 2184

HTML €214 iy Jld 3o A8 43 an 8. -E2a 1140 eulda Geldel Harst weion 32
e YsiR+l @ude (hl) 29t Guildii dals 8. nawni-l uan wsr-dl R18a (hl) 34l 2vuy 8 A A
W2 sl 1540 sulda yaml RAINBOWA 93l HTMLML 2uell ay wia usiel s 2ida

HTMLA uRau 5



Guacy B. ga © yduefid Rida siquir Hule] culdl asny 8, ¥ s hi, h2, h3, h4, hS ¥ hé

Ul 2oy S, HAAHL 21 69 R 2[R 164 20l HTML el adda 8,

© © ® Source of: file:///fhome/pss/Desktop/p2.html - Mozilla Firefox

File Edit View Help

<html>
<head>

<title> About Rainbow

</title>

</head>

<body>
<hl>
<h2>
<h3>
<h4>
<h5>
<h6>

</body>
</html>

| N

Ralnbow
Rainbow
Rainbow
Rainbow
Rainbow
Rainbow

</hl>
</h2>
</h3>
</hd>
</h5>
</h6>

wi5ld 1.6 : HTMLHL 9EL YEL AR+l HAw W2+l HTML $18

gedit ARz GuAlaL s 20 S8 26U sAUML e B, 2 Sl “p2h

"ol AAS S

Ul WL S8 WD suGHR gl Rl cud A 2wgfa 1740 salon yasid e 2y R4

W2l @Rl oG <hl>, <h2> el <h3>«l @uiBN ecdldal dulBirl A 58 5l M2l sedl
edld &, <h4> ARA-2-L qria] se @uua-l W 56 Fod o sulald, A3 AS @ 20w
se ddal Dl A yFuiRa s w3 B

© & 6 About Rainbow - Mozilla Firefox

File Edit View History Bookmarks Tools Help

%3 r@ |@} | file:f//nome/pssiDesktop/p2.html

s Most Visited v (@] Getting Started [5jLatest Headlines v

@| About Rainbow

Rainbow
Rainbow

Rainbow
Rainbow
Nainbow

Rainbow

Done

2ugld 1.7 : HTMLAL Haun-n o6l sl s wReun
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avuarll Yusd awrd 2o

hl ¢l h6 ¥l qeno-l ARY @18¢ Guld HTMLAL ofle usfl Al 201 v 3B 32 Guasy
8. 3l 2011 HTML 513+ olldl [Renaiil Gualail 4 s 8. sudl J2aus yoejd 2oL A 3o, & ¢

g5 MR <p> A </p> 23l

<p> 23 @ulled §5RU 1IN Olsd B, duiBirl €35 §5AA <p> A </p> 23l 9 Ysdl ASA.
{A wial An You Geldw Wiy B

<p> This is first paragraph. </p>

<p> The second paragraph is here. This is about multiple
colours of raimbows.

Though it is a temporary event it leaves a great impact
on human mind. </p>

<p> Best of Luck! </p>

Gux culda GeigRel U4l ofly Gels@ tud @l ad A AS wh Lk, ofln s wAs vudl
oo A 3y Red (wul Enter 4l eoidll & ud avuel «dl dldl wa vudl a1 8.) acuu 8.
il W Aldla S % wudl vuedl ooui(white space)l s o vudl woul dild sl wad, sl
HTML 58 suGoRul salaid il avua suudd awla-l dyel wdas ad ad. A ad a6l
R se sleasl dl suGR @vian Adl endrnl af wdl. vid) suell ¥ouL (white space)-dl @dre
HTML £3 duiR -7 add S8 Wil Ad il sy Q 202 s sk wdl eafaadl duy
slvll axd w3dl audl vudl aul Gl g2 Wl B,

4l il wredl Avud WR: <br> ud <br

ey 23l sl Glag, <br> ARA2A 3vldedl A diadl 290 ) «ell. <br> A breakd 3§ «Un
8. lal &3 vudl (Empty) 23 dild ugl wdosud 8. XHTML %dl seldd 2ugii <br /> 23l
Gualal s &, wdl A e @l ¥ br wl Ml aR aowl ddl w3dl S,

<br> dsll usdl wadl @vied QA dldl U2 @ wu B, A awl Vsl ay vudl dldlwl el
du L ¥R Hwol sl Ay <br> 23l 4. <b>~dl Gudlal salad Gewra (A Haw B

First example <br> <br>
Second example

$5UAML <br>rll GuAloL sl @uuerli 5 s @d B, B YU ud iy GR [Axdd
st ogddl quid @ el (wrap s307) Adl @t w2 A wuui dsdls W B,

PENDERT )

gell alR w8 wuyse avie suGoR oied «dl ddl Ad sl ay vuel ¥ouL (white space) wd
el ay el eulay Ag SR Bl W W2 BN WML WA @uuA <pre> A
</pre> el 8 R-s1302¢ Bopil wiadld ealdl afla. <pre> WA A3 Ydl B </pre> WA Y21
adl QS ve aviridl olsaell Fudl au s W B, Gewgw A Yoo S -

HTML- uay 7



<pre>
This is first line.
This is second line.
This is third line.

</pre>
UGl ealalg @vial 2l axd =32 (indentation) WA 2uud B, A Gelgrwl wa oL 531
W\ :
Bold: <b> and </b>
18] 53 @LUAR W2l WAL U W2 21 291 GUAL AU B, v Gersrel (1A Hort Ry 57 ALY ¢

<p> This is the <b> first </b> paragraph. </p>
wdl “first" e dl2l Al euldai 2wdldl,
Underline: <u> #1 </u>

duilaiiql wys ol e 1A Il D3l sulauy d W2 2 L GudDML ¢S uny B, ¥
GelgRl <l 3wl Wl umy

<p> This is the <u> first </u> paragraph. </p>
»dl, first el 1A 12l wd ealad.
Italics: <i> amd </fi>

QLRI BYs Aoel Sl (Seifs a8l) siudl W2 W 2ol Guulol sl wid B, F< Gers@
A oo il wsy -

<p> This is the <i> first </i> paragraph. </p>
il first At olAL NN WA W,
B4 Aival el <> wA <>

<s> YAl <strike> W[AHAwerl QuuBidl 20E) Qual Yl B4l Alval dly d A weel v wasll 24
wd oy B, dl s 2 strike st g5 UH B, DLl Alvlal ALl Y s Gelgel {1 yorer B ¢

<p> This is the <s> cancelled </s> paragraph. </p>
wdl cancelled cviial B4l vl el Fq oual.
aduuder g-2: <> A <>

<tt> WA duigl AU Bl AAuL quud O, F HAD-AR §i’ RR-218Y nall Fa)
dild uR oeuy B, B Geskm A ywyu & ¢

<p> This is the <tt> first </tt> paragraph. </p>
wdl first a0t WAl-A sieeul sulaid.
WAl Jedls vy AldA2 4@ B, ¥ ey 1241 cwuldd 8.

8 SR uHu ¢ 10



A2 agi-

<small> ¥, </small> 2l W[QAreed @uiel d-l BAWAA QL Rl s g2
W Fed -ud eulan 8,

<big> ¥\ </big> 2l WA dviel dvll vAWAA QLI SRdl Vs 2
won %ed W ealaw B,

<sup> ¥ </sup> L ARA2] avlgl dell AL @uiRL sl i, 2 sl
sl 8§ G QuaRse R «d3) wuu 8.

<sub> A </sub> <sup> sl Glag, > dRdeed avu dell 2N aviel
SRl el uA dl sl A AL (usRee war o)
Uy 8.

<acronym> ¥+ </acronym> 2 A quiRl 35 U (acronym) adld edlan .

<dfn> sid </dfn> d s A yed AR 53 D,

<g> ¥ </g> d vadel Qs (quote) suld &.

£6zs 1.2 : d2dis vy siARoy 3
Anchor Tag

sl S5 auia HTML sdide-ll e o salan &, Wl duuer ud d«l a3 REbBd R
gl (291) Guld vy @vied Asladl ardl wRdl ua #3dl oA B, wRll qud QAN var)
Rl o33 B, Al eals vaRl 3 At A ¥ el ol (Ruaed Ad oL atel) A
(A QA QNN enlcny & AN @lduies dx vy . dlURes <a> AlHAL 23 QR sl
»d B, ¥l ‘all el anchor 8. dl 2wd), "plhtml"d S{aRZ 1240 slwen W YA

<html>
<head>
<title> About Rainbow
<hitle>
</head>
<body>
<h1> RAINBOW </h1>
<p> Rainbow consists of seven colours. These colours are Violet,
Indigo, Blue, Green, Yellow, Orange and Red. They are also
acronymed as VIBGYOR.
<p>
<p> Rainbow is caused by reflection of light in water droplets in
the Earth's atmosphere, resulting in a spectrum of light appearing
in the sky. It takes the form of a multi coloured arc.
<fp>
>
<a href= "p4.html" > Click here to visit Theory of Rainbow. </a>
<>
</body>
<htmP>

f$-aRE 1.2 : gifud-sd Guala enladl HTML 53

HTML-) uRay 9



§15an "p3.himl" % WAL R 2l A SUGIR g2l Fislneuml wiad R A vigll 1.8 Yoot el

£ @ @ About Rainbow - Mozilla Firefox

File Edit View History Bookmarks Tools Help

c @ o| | file://fnome/pss/Desktop/ntml screens/p3.html v| 2~ 1§

[ Most Visited v || Getting Started [RjLatest Headlines v

RAINBOW

Rainbow consists of seven colours. These colours are Violet, Indigo, Blue, Green, Yellow, Orange
and Red. They are also acronymed as VIBGYOR.

Rainbow is caused by reflection of light in water droplets in the Earth's atmosphere, resulting in
a specttum of light appearing in the sky. It takes the form of a multi coloured arc.

Click here to visit Theory of Rainbow.

Done

2sld 1.8 : pd.htmlf wWReun

o1} Guoisdl gidulars w2 (RS 2 U 'Theory of Rainbow' ddladl FuiRd $ia viadl ASA.
dl wd), eidubdcs g1 Fe sida 4R SRR 1340 eulon st HTML 58 steudl,

<htm[>
<head>
<title> Theory of Rainbow
<fitle>
</head>
<body>
<h1> How Rainbow Developed </hl1>
<p> Rainbow is caused by reflection of light in water droplets
in the Earth's atmosphere, resulting in a spectrum of light
appearing in the sky. It takes the form of multi-coloured arc.
<p>
</body>
<htmP>

ss-fafEa 13 @ adwlds wd Asda wRA w2 HTML 518
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As-faR3aL 1340 eulde HTML 8-l “pAhtml” a3 s s3L aud dd sugfa 1.840 el Yool
AisAd (anchor) @visl (Click here to visit Theory of Rainbow) W (545 53l dl dRd ¥ p4.html
sided avial oGl dudl ¥ (3D wsld 1.9.)

© @ ©® Theory of Rainbow - Mozilla Firefox

File Edit View History Bookmarks Tools Help

\‘_J A < @ _cl:__fﬁle:.f‘Hh0mefpsstesktop;‘html screensﬁ‘pa‘..html v f!l' L

[ Most Visited v [g| Getting Started [§jLatest Headlines v

o Theory of Rainbow v

How Rainbow Developed

Rainbow is caused by reflection of light in water droplets in the Earth's atmosphere, resulting in
a spectrum of light appearing in the sky. It takes the form of a multi coloured arc.

Done

2gld 1.9 : pdhtmid apumt

SLSURRE W erdldard GIBUR 252 (hyper text) si-Ulld Al ey edldy W Alselld 6 HTML
tcldal Adaldl Ad B, Ns dsiude, 3 ¥ ual oul daldedl Ays du B, A v Qs
AW HREd dAAd By B, wdl B Audly & 3, 2uRl sAddl dulgy, ddl HTML $W$Hi
2 ¥ A euldd & A wud @wuen Y K2 B, 2wal A6y culdd WRAA Rud (static
% fixed) @3 ¥ WY Sl €S dd “RRs A0UY” a3 Al e D,

yel A il ar-uy

A3-RER 1.240 eulde <a href= "p4html" > Click here to visit Theory of Rainbow. </a> <\ 3%\,

hitp://www.somedomain.com/p4.html g, Y&l U3 BUNUA oled WD Hiot §LSas] A "pd.htm]"
o s B, 2 Ad Aol gifad wun o edladld] Al o Asy @ ¥ wd wnell plhtml #de
3 iyl neyd sleladidl vid 8 d. (Adl sidad ‘SR sifd’ 3 A2 sifd’ s8 8.) A
"nd htm]" Fq odenaadi (call sAMi) »ud B, (2udl §16ad Nsd s1fa’ ¥ Ga ada’ K D)
d ol As o Riszdlul Guasy &S elaldaril swadl (called) sidasd @ 3 sdela-R sida-
AeifBid du B A A A A AsiBd A (Relative Address) dE oy B, wud iyel
W Yol Al (absolute address) dix awapi »id @, A sdeiaci wadl s1a g
Risedl Gua 2dd]l & dl wud side Ul swi o/ adudl wgdl,

-y :

A gdadil Awndl W AS U WAL A W] QU dl suGR Ag wedl AL F sdaqal
el s1fe olana-iz (UWe) aifadl Risednl o B,

2L ARl

2ol wd ay WRAA ealaar 204 WA awia gl Al 2ud B, ol wlHi sQA A
ARy @l (ARA-2) ousid ay Radl 21l 8. A5 va ARARAL @l Al AFvude (QUFR)
2l wd sulan B, el & cworl sdal du B, FD udel el dEbdd ux du B A4
ofl2d ool d-l w2 w3kl Buaarl i 8,

HTML-A wE3y 11



daidd i sd) danl olisadl A suld . AR 1241 eulda <a> 200 href 2 ol
A B, Bud 3 e w2 olsaaidl Bud 8. hrefi Ruul Bud pdhtml 8 (F ARl A-w3
8). 2w Bud & vade el wadlq caladl Q. st w1 Buardl a2l sRier (=) o Ba g
W B3, ol wdAl 2o 3dl Ad euladl A Gesw ¢4 ugl-u Rouwsmi WS,

Align Oﬁlﬁlﬂ

align oeital Aq eald B 3, send] il giofl ougy, ol sugr & Wl sl 2 Buiig, AR, A Ad
el il diofl sugy o sl lu B, Align dpansd wd QA 2ol A A As B sdsdl s,
Left : avua weusdl gl sy s 8.

Right : avuel Wl omell suy sy 8,

Center : @8l Wieledfl uui sy 8.

align @t Guilol euladi deais Gewgrel A you B :

<p align="right"> This content will be displayed in right aligned form </p>

<p align="center"> This content will be displayed in center position of the page </p>

2l Ul Jeals el B 3 ¥ @deal eds 2 Al wdl a3 S, sua i wdBs gl
s34, align N Al ¥ 3s ol B, wdBis Rl dam € align e 1A ealan Yoo
heading WA d& AuIl sy,

<hl align="center"> Centered Heading </h1>

YR &AL QuiRA A sl (align) d B, il ARl dsaw sal W2 dviani el
Q) suis suis aRuedll vidl oo Gl wud 8. . Ad 2wl Gl wdl wowd “dlg
A" (soft space) s& B, A Gurloisdl Wl wiell arouy GAI ) A “¢1d WA (hard space) sdai.
9 HTML $.$di <pre> ¥l </pre> 23+l a3l avida evusl Ry avieni 2udl @i @A s
dl 4 Al sl Alvanl 2l

-y W22 SciTE-L Gualal

SciTE ¥\ @viieirl YHIRdL 22+, vls 2422 3WR2: (Text Editor) 8, ¥ Scintilla [hitp://www.scintilla.org]
el “gl AR A ARRaL sleive” (Free Source Code Editing Component) Y2 2UtRd 8. d Y3yl
ARl A8 (source code) A vl AW 2wd B, F Asl A uR Fuges 3 Hudy Alged Gowed w2
Gualol s2ael il YUl B, SciTE «ll 2via vugla 1,104 enlew Yool Boiy B,

2 © ® (untitled) - SciTE
File Edit Search View Tools Options Language Buffers Help

DOBEX a0 XDD QAQAXARXR B0 GO

Untitled

li=1 co=1 INS (LF)

wiyld 1.10 : SeiTE R22-) gwua

12 5R23-UYA : 10



UG Ael® (rainbow) RAAl Rl euldaw w2 awdd HTML S8l sl 1.3.)4
2R 111 enfen Yool SciTE AReui wa avl s,

© © ® rainbow.html - SciTE

File Edit Search View Tools Options Language Buffers Help

DOEHX @ XD AQAQAR AT S
\ rainbow.html
o - <html>
= <head>
<title> About Rainbow </title>
</head>
= <body>
<h1> RAINBOW </hl>
= <p> Rainbow consists of seven colours.
These colours are Violet, Indigo, Biue, Green, Yellow, Orange
and Red. They are also acronymed as VIBGYOR.
</p>
= <p> Rainbow is caused by reflecton of light in water droplets in
the Earth's atmosphere, resulting in a spectrum of
light appearing in the sky. It takes the form of a muld
coloured arc.
</p>
</body>
</html>

sugfd 1.11 : SciTE AR2:ui HTML 53

2R L1140 Al Gurel cud salaida Aqour Ased Gur tue Ul Aq Rsed s15a v+l
Bud, avud yararl ddad, WRA dud, Reimdl duy i yaed Adddl 4ud 8, A+
Rseldl drd Al didil dedls yaed Bl B4l &, new, open, save, edit, search 433 w2~
WS Y KL B, SciTE AR guld s il Ald agude wial wgudld el asal.

wig 1: ¥ sdan wadl du dd Andl

WG 2 ¢ Al W g slet (B4 50 vl Open With waie s sugla 11240 eulai ool
Bl Ruial.

wig 3 : SciTE 25w 3R wdle s A s18a SciTE AR wledl. SciTE giRl suldidl §x2
(indentation) W2eil MZal nA 2o1ell N AAld @l U A S 219 200 [QRY PO
e i @uue w2 el ddl WA 8 A A iyl AL oA B,

HTMLA. W3y 13



2 @ Open With

Open rainbow.html with:

n: UPN—IIUIII\_\—-UIB AL LAYT IR 3

| ?I OpenOffice.org Formula

6? OpenOffice.org Presentation

ﬁ OpenOffice.org Spreadsheet

ﬁ_', OpenOffice.org Word Processor

.;i‘_;;:‘ Remote Desktop Viewer

é{} Remote Desktop Viewer
Report a problem...

©) Rhythmbox

@ ScITE Text Editor

i‘ Theme Installer

A Transmission

Programming editor

+ Use a custom command

@ Remember this application for "HTML document” files

Cancel | Open |

wusld 112 : Open With €L slisy
wdg 4 : ouGMRAL himl &< uReus Al W2 Tools > Go wde $A »udl F5 4 eondl
HTMLAl adwq »ugk

HTML- Qsiusiani df - d-il R dig 3=d &, #dl &A1 vl ady s dur
sag v wslid R vEBRS W, MU HTMLAL a4 1 ay daadl GHudl af 2
504 A Adl G, Al 2slellew 2 AFA] Udd aldl ¥l HAA AU sl A3 wq

Guddl ud 23, HTML<{l edd dugid HTML 5.0 a3 2laviaiil 2Ud 8 ad d vl
dlil disfu uf wdl 8.

L usveni 2uadl la 3a

L WAL 2uR Sres 1340 ealda 2ol wal s B,

£922- U 1 10



2o (Tag) Q@ (Description)

<a href> ... </a> Yo glSaq Rics gl sl vudd) (referred) s1da 118 wistl B,

<b> .</b> ariel 2 wEAM suld 8.

<body>...</body> HTML el 3w cuol (Body) <8l 43 8. <html> 20l
Adefl axdl ealan 8.

<br> or <br /> Q. »id (Line break) suld 8. A wyox 20 8.

<h1>...</h1> wad Re Hey ewld 8.

<h2>...</h2> Rl 2z waw sald 8,

<h3>...</h3> Qi el ] euld 8.

<h4>...</h4> Ul e Maw euld 8,

<h5>...</h5> wip R wawe euld 8.

<h6>...</h6> 92l R wawg euld B,

<head>...</head> HIML eidy-l 3o Rewd sald 8.
<html> 2o+l Al g2 wd B,

<html>...</html> vl HTML tadaqd wad a 8.

<> <> aviel =i (italics) @3l e B,

<p>..</p> 65 euld B,

<pre>...</pre> yd3uilkd (preformated) avuer sald &.

<> .</s> QA «ivle 2430 auel suld 8.

<ttle>...</title> eldore s euld B, <head> «unrll 2oiell Aldlrl a2d 204 8,

<tt> ..</tt> avlen adude F wadal culd B,

<w> .</u> aviizi, (A Il O3a €l dal @zl zauld 8,

a2k 1.3 @ wskw 1Ml 2uadl dada HTML 231

TR

2l WRAHL W HTMLAL Gualal s34 Aoy 3dl d duir sal 4 v, HTML 3 3dl
wood YU 8, ¥ doidl R 3l Ad dwr wy, wslid Wy 2ud Ao gGxAl Gudla &1
3l JQ eulddl A asid &, 0 wsenl, HTML sxclda-il 3umidl 8 déxaedl oudl ¥4l 3,
HEAD % BODY 3Rd ¥2ais yu 201 agldaini e, R Gudldt s ddl el Qe
Quiz 57 AN, AU el 2As AoUdw ail 2L WML Al Ra Wesa 29 R A 2, HTML~L
yood vl v HTML-L $Rgid Y32l Wl Gurid 20 wswdl HTML 6didy ddil sl
gedit 2 SciTE %al xRz A wel R 2iuaml 2dl 8.

HTML- uRay



ALY

HTML-L $lasid 3id ddl As @ s Ale duil
HTML edldore 34 Gelgel sl HTML exdida-il w53,
HTML &2 22d 3 ? HTML aU&AArerq W uxamdl.
HTML iAol ddial 324 v idl 0 Rl sy ?
S el sel suboRr<dl wel oeudl.
HTML waiou-dl RQRAY 2o Gelgg wd 3l
HTML-A [RRY 3Ra 32 Gewser wd 2l
HTML~{ yd3uild (preformatted) 201l Geigoer wdl al 3,
HTML-AL ¥R &3l R gs <y anil
HTMLAL yel w9 eifd w-usidl epvqy sl af s,
A sl w2 2lan Rsedwidl Aoy Rsey wrie 3 :
(1) Aol RA safaar w2 5§ sy epudll %32 W d?
(2) CML (b) HTML () NML (@& WML
(2) DA-uniell AoAsey aglaar Wl eunl &5 opny & ?
(2) HIML (b) WML () NML (@& CML
(3) DA-wnidl HTML 43 -un 54 & ?
(a) Hot Text Manipulation Language (b) Hyper Text Manipulation Law
(c¢) Hyper Text Markup Language (d) Hidden Text Markup Language
(4) QAnil SGML Y3 un 54 & ?
(a) Standardized General Markup Language
(b) System General Manipulation Law
(c) Standardized Genome Markup Law
(d) Standardized Gigabyte Markup Language
(5) -0A-sil HTML ARA-e O dsdd & 7
(2) u3vlarl 2o, aviR A viadl 20 () Rl S

:agoqa\m.hmun-

ki
[l —
L] -

(©) aws @ wdapil S ua

(6) HTML ARzl W auudll Dsaa sa QAqapiedl g Guiloml daw & ?
(2) vl (-iviR) (b) ARl (Reye)
(c) Rwell (s13-2) ) avua (s2-2)

(7) Qi 50 Qs vuell 200 g 2 B, i AS @ridaddl 3R Wl el ?
(2) Compete (b) Empty (c) Nul @ Void

(8) DAl su opuddl usik AS ul 0 WA widl w3 ?
(a) w%¥$ (Unique) () wdBis (Universal)
(©) Bt o~ (Trivial) (d walis (Preliminary)

16 sPe-wYA : 10



(9) HTML ol st wsieell Rl audl asu ?
(@) HeZMRu R ) wbts HRd
() &fariineg uuen A s un d wld dqm
(10) HTML exidy yaal we {3 A4 s »RR & ?

(a) SciTE (b) BrIE (c) LigHT (@) SpiTE

WwAlBis 2eneny

1. audl wen QA Wk R wug Aty sl s Wil 3] "My School” .
o33l SIRoL A Bdsal 29l GulaL s

2. Bs A6y o-ldl, ¥ Rl sl wWRay sud, Ml R adlfas, v Quaqa Ras
wl ¥ Al ad el oL ddl AR wuda s w0 weiy waw] "My School” N
%3l SR A Wgidsal 2o GuoL &3

3. B JRUYAL USWAHL dl AR 53d AoUSwel olldlddl W2 B [BUAL WA 1 AL dur
sid Ao YAl “dl2 2571 3l dd olsd 3, ¥l U My School' ui-l well [Bus
sl wd Al A "My Class' wisl w2 udill oy,

HTMLAL 9REay 17



Head [(douat

A8 ya HTML &9y Head A Body+il <l slaviidl & ool adaai »ud ©. HTML
gcldar)l head [@cud eudy QAL o338l WRA ueld 53 ®. Head Rodll @sua <head>
. </head> Al & 23{l <A awari 2wd V. B 6= L A Al aAU @R head
AldiAe a3 souanl wud B,

Head Reunni andl asidl wan 3dl ousd 8, s (title). wdl 3 v g ASA 3
iy Amdde-l auurl ddd ealdd Adl A Ao AsASwqd ealadl subnr Redq dids dA¥ ealay
)

il B uRlL i iug AW 3, W head Rowsr s aviadi A e U d), Helewsi-i suGR
g SUGR RA-dw s a?ld URL ua waa sifad «un salaiy @, ayui, title 204 2id ya
adl 290 @oluldl A olad ASA, A 2id 290 @l oell ay ¢ dl vk Qv s wdl
daui suad uA se1d Wg wal o & HTML ekdo suGmR A<Ml dlami « »ud,

Head [cuaii HTML gdida »iq asiial sioid 32¢ls atiil sulRdl el 2ud 8. qiusll *uldl
2l 2R Ael-edl (meta-tag) aild voweHl wid &, A21-gdiel GualdL W2 el suGoR nA Al
2\(F-(Search Engine)n siMd WRA Ansal w2 iy S, Aoy vid siydudl Ae-2adl GAN
Syl wsl agid & wud Ad AH g WASYA AR T Dhaly, W ol B,

agi

Wareuorl A WA Gualigdid ol dud uBRun Y 24 R A add calad. sud aglqsdl
uRRQAL Brual, Bl AF Wl agpid-u s w8l galad. A21-201-l description atald]
GelgrRl (1A yoayny B:

<meta name="DESCRIPTION" content="About rainbow and its colours'>

adlau Asel

2l 200 iyl wde w3y uedl (Keywords) 3d [« gl Guaomi Qaid. ol
alaRisciad- Ay, Andday-l Gia w1 Mol Y f-al ad 2y sdl sy, Keywords deladl
Rar-aL sl A oy B

<meta name="KEYWORDS" content=""Rainbow, VIBGYOR'">

avy

QAL Neiga qanel, AedAdel u¥s 3 Aus (Author) RAA R ue K 8.
<meta name="AUTHOR" content="M K Gandhi">

18 £922-BUA : 10



(Bwell (Comments)

Rwell (sidtrey) HTML &l aurill ®uRdl sunadl as Ul 8. sial-ey uReus a3l ealaa
W2 Ayl &dl. A2d ¥ HTML-L i 8 Rain A8 wa aownl Rwgll AS and 4l Ruwsil
Hsal W2 WD <t A > oAl Gulal sl WL <! 2oL Rl azwud eald 8 eud
> oL gl Ruell-)l wid ealawy 8. Ruelld “wuyw” (prologue) adld uel o »1d B,
<l-- This is a comment --> % Rweld s Gerg@ 8,

iy N21-291

Bal wa deals A21-2a B, ¥ AoASwA s Ass ul AS Ay URLA @ vuqaud s »ua
AN sdl £ 3 wel o wwadl AdA. (A Gelgw €2 uin Asy ughl el yq: aidl (reload
§91) dsudeq dzu (refresh) 3 8.

<meta http-equiv="REFRESH" content="'5">
A Gelgwl http://test.com/ «ld-i URL <l dvi@id €2 Wit As= Yo 1y s34
<meta http=equiv="refresh"” content="'5" URL~'http://test.com/'"'>
HTML. base
<base> 291 deddarsll dma sifid URL 32 2wz URL/2slz FBid 53 8.
<head>
<base href="http://test.com/ " >
</head>

201 2141 uRIA3L J2als il HTML head (@i 3y 4 8.

gal agi
<head> gxldy QA Rl cwrnla 3 8.
<tifle> eldy- s arald s 8.
<base> Ao ore{l M [Birs H1Z BLs A1 AU, AL Dl el R 53 8,
<link> ERAUAY WA GlEL AHA Q) Aoy Ald 53 8.
<meta> HTML tdidy 208l Hal-32L albafd s 8.
<script> see gl RFe a5 8.
<style> gl W2l eoill HWRA ayd s 8,

#n2s 2.1 : HTML 6ld Head W2

HTMLA{ Head ¥ Body [Qou21 19



head ARz WA 2adlsdt W2 gl 2.4 ewlde HTML 54 ud dl,

DOEX @a XDD ARA/AR BTFTO £
2_2.html

- <html>

- <head>
<meta name="description” content="About rainbow and its colours">
<meta name="keywords" content="Rainbow, VIBGYOR">
<meta name="author" content="M K Gandhi">
<!— This is a comment —>

</head>

- <body>
= <p> <h1l>Nothing will be printed but this line... </p>
</body>

</htmi>

1i=22 co=1 INS (CR+LF)
2us(d 2.1 : HTML L Head 21832+ yaloL
Gurl Sl uAd s A suGRAL df WRRUA ol d Blaga wugld 2.2 ¥4 erud.

2 ®6 Mozilla Firefox

File Edit View History Bookmarks Tools Help

% @ | | file://fnomefpss/Desktop/e8.html v [(*gv| @, |
fi5Most Visited v [g| Getting Started [EjjLatest Headlines v

lo| file://fnome/pss/Desktop/e8.html = v

Nothing will be printed but this line...

Done

2ugld 2.2 : wugld 2.140 ealdd HTML 834 uReun
Body [Qeuat

HTML tidy«l 3o Rowsl <body> sl </body> édll aw a@utari »ud 8. HTMLe body
D2 G-l viter ¥ culdadl u Q cusidldl ey a3 Hd L2 B,

20 sugz-ntad : 10



VUM WSWHL VUM HUNL, 531 VL @VUBLAL A3 WAl Sedis 2oL QA A A ¥ %
body (Rewdini wudl ad. upuey Jd, 21 2ol 43 455 avuel ¥Rl da 8. vdl el Jedly &l
AU B ¥+l 43 A avuell ¥3 didl A2l vl 2aq vl 3 (Empty Tag) s& 6. sual sudl
2ol GewR@l 8 <br/>. dl Awd, HTML eadida«il body [Qcuami Gualaiii daidy deais ay

A el A

sisauGes tooll
AR YL, v A4l HTML 58 Au 8, ¥ wlel ude olsqb= uA v eauld. Amazuer
A (A S4B W @i Y sal Body 2oL WA 34 background @il uaL Gudlal
s3 wdla, el SAsB= W2 WU 2UNRL 3422 U Guasy A el ol Gudla &30 wdA.
HTML Wl W2l 653G olsaal »und A yaordl 20l Gudlol 53 adlA :

<body background ="rainbow.jpg">
[ background #se A As R A B, e As Dy Bad 2wl W, 2 Bad 2
D Al sfdd A wug ASA (D2eudl woll-ll s15a), I FA A AsG dF ealaa
$aflal ¢dla. qvel Bl d rainbow.jpg 6. WMEL S uRL Wiy 98] |@3u Fal § jpg, bmp,
png A tiff 20yl Wl

DOBEHX @a XDD QAQAQARXR BAFTO B H

2_3.html
- <html>
= <head>
<meta name="description" content="About rainbow and its colours">
<meta name="keywords" content="Rainbow, VIBGYOR">
<meta name="author" content="M K Gandhi">
<!-- This i1s a comment ->
</head>
- <body background="rainbow.jpg" >
- <p>
- <h1> Nothing will be printed bur this
line in a rainbow background... </h1>
</p>
</body>
</html>

li=25 co=1 INS {CR+LF)

2R 2.3 : 6ls36-3 960l Hgal W) HTML 518

dl ), sugl 234 sulen ot HTML 88 avllRl 3 %, rainbow.jpg tell ssofl a¥ s
A W dlug WS 3, gl dd W rainbow.jpgl ded dadl wies(lHdl A wa ool sideqd wa
oladl wf\,

ol Iyl HTML Sl »ie eofl s1da-dl Gualal sdn ¢la, Ul 2uvel » widil 431 adl

HTML¥4{ Head 311 Body [eua 21



AN 3 d sifad U, A Mo M ddl ug Yoy dd auiadl el 8 3 AR, A §ldad
i sdlddl suod AS @@ ud d Wikl A6 adld S ue Bwd «dl

sugla 2340 ealew yousl A8 AU A 2 Al SuoqUR sSal A WA wadl €. (wdl Q
e7.html a1} uyas B.) suGRUl A el isaB e9ofl GARaue uRRuA vyl 2.4 eald 8.

© ® @ Mozilla Firefox

File Edit View History Bookmarks Tools Help
‘?1\ o | file:/tfhome/pss/Desktop/e7.html v M~
[ Most Visited v [@ Getting Started [5]] Latest Headlines v

o| file;//fhome/pss/Desktop/e?.html & v

Nothing will be printed but this line in a
rainbow background...

Done
2 2.4 : tisuGes adld t9of) Girell

agll auid, G5Bl woll Al @vilel sl ay sty QL B, N N sod-ll ua A suw Adl
ASN T s il @eud uell ¢ UG W Hkd L ad AU ARG ddld Y AR il
P il ASH 2 Qv dizal R Adl Qdl RS Adl 3, avim S d adl aull, A GlssuGs
goofl ay uidl W € dl AN suGoRML Wi wel WY @), Wl Ny dlud AN % A
OB M2 GudoR Al tofle g8 Wl s£ Rl U e dl 2l YA vl YlH RS Al
any @l Yl s A oofldl Wy ukl s wagldpl sirdl WA AN DA 2R dA SR Wla
sl Al Asusw ool W 4d, Ray 3, ddl a0 sulen Yoo, RA2 1 €L

<body background="rainbow.gif" bgproperties=""fixed">
sisuG3 301
ASAB~sHL 9ol sl e1ed Bls3uGs I GualoL s3I0 vgt 2D AsAdw Bsds ol w4,
Wi 3, 2y siueu daddee Ssubes Ylou 3o s2q du dl A ool 2ol s ud ¥,
<body bgcolor="#FFFF00'">
2dl, bgcolor A 5B 301 FElRd Rl el B, wudl A vy Ain d 3, 2ud 02 culen
WGl A5G 696l wA I3 BsWA osdl Wl
<body background=""rainbow.jpg" bgcolor="4#FFFF00">
2l s, wul Y suGoRHL Ayl sefl widl A Mu cul YL Asubw 3oL sulaid. audl 2R
AUy Fd e Hweui tuidl, Bl 5123 UR dl sl BUNEL S A NS A il dg aA.
PR v syeeil LAy AL e B SAsAFLE Ul A5 uRL 3L AR Yaod L, e
Red), dlel (Green) i aletfl (Blue) wael 28l 30l AY-30 ¥ A2y 8. d-L gs4l RGB dild
uel ANl wd 8.

We s, ouuRdl dfl 8 ¥ ay dld Fuser s Adl U sirlladl &l ! wsy B 3 sen vl
L oirladl dil deoll WA ag o B & dal

2 SW22-MAU : 10



syl PR Avigl ugla Yo 00 Rl FF Rl ylAL 3 2ncinil 2ud 8, 2 86 291
Y sal dedls dle, kedly dldl wA d2dls alesll (RGB) 01 Y sl 6 Bisdlvl S18 sirllad) W3,
B2d %, eis L WAL 6 uisdl, cwd 331 A2l 518 FF0000 ad. il ale a1 FF Bad (eaia
vyl 255+ Al Wil Aw), dlal PR 00 w1 aweell W2+l BGod vet 00 8. i ARy i
wfel 004l FF Y40 B. (A2 3, 0ell 255 34|, ga 256 Bud)) e, clay 29 aieell-l 0¢fl 255
YHl-l Cncdlef 2idlyel (256 x 256 x 256) 16 sA8 ARY o Wil B, W4l 23U b wsesuon
eulaawell 2l RAY 30 caldl wdla. gl 2.540 dlA d2ails Gelewrl wwl 8.

FFFFFF>  White colour > [
FFO000>  Red colour 2>
FFFF00>  Yellow colour > ]
000000-> Black colour > D

FFOOFF>  Pink Magenta colour > ()
0000FF~>  Blue colour >

00FF00—> Green colour

wugld 2.5 : 2ol 22ais GergRel
il oi6d dfl <1 salen wwd AL AL Gedw e 1 wd:
<body background=""rainbow.jpg'’ bgcolor=""Green">
<body background=""rainbow.jpg" bgcolor=""Chocolate">

200 weenal &R 5 dA WAsRY DL UG dwR sY w8l Ss-fREaL 2,140 salda
HTML $idl wuet s30 ol

<html>
<body bgcolor="#FF00FF">
<h1>Everything is pink here, if you call this pink ....... </h1>
</body>

<himl>

A$-faRSsL 2.1 : olsmGs GARal W2+l HTML 53

HTMLML Head 317 Body [QeuaL 23



U} GUGRML (Relcimi 20l i} Wl wudlgn vugla 2.6 Fdl gwud.

S © ® Mozilla Firefox

File Edit View History Bookmarks Tools Help
(e [@] | file://fhome/pss/Desktop/ed.html v | e
fi Most Visited v [g| Getting Started [5jjLatest Headlines v

i

l@| file:/f/home/pss/Desktop/e9.html 57 v

Done

MR 2.6 : isME-S or-d Gullol
auua, 39
Fdl {ld 3 body 2o+l wd R (Adeyz)d Gualol gl Bsb 0L A el e
53 Adl % Aq, body 2ol Wi text d@ud gl @vuel(textl DN wwfd s AR, WA
3, wud A ot s Gelsaw av(lwl ),

<body text="H#FF0000" >

FF0000 (ua o text dRitpl-l Gudlol saaill @vuetd 3L awe 4, w3l 3, daid djensl 3ol Ssuibw
Gu o 301 1AM aria salad a dl, ddl 2 Yool Wil s YD 2 570 UL,
<body bgcolor="#FF0FF" text="#FFFF00'">

Rirgl 32

galldic dodderell vie2 wellar d S yel Al [ W R FEa sl aeoll o1 206) Aul ¢l
2 2106 U (B8 sl BUA L d vy Wil U2 A4S 20U B, B A HA WA UL Wl Bl AR did B
wadlsd £ ¢ ¥ 20 avuRi-l 3oL seans odl du B, dil Rivs-ll yarsa diel Qe s1d dadder gl
2l Riesel Yelisid AausS e Rivs (visited link) dilk ssiami »ud 8. wudl yausid difd Rirsn
vlink 3 sdorviail vud 8, i ¥ Riesdl yaisid day 8, A Ries 4By Rirs (active link) a3

slvidin] 208 B, WERA Riesel alink d13 sdviaini 20d 8, yaisd dus add Rirs wa 4By Riesd
of€l uigal el el 3ol Guulal sy B, 1A, Gelgel il

<body alink=""#00FF00">

<body vlink="#FF0000">
Asf@s Ad al 2w ye avll ws

<body vlink="pink">

24 S$3Y22-MWYU- : 10



Guarll Gelgammi Gudloi Aawda alink ol exdidaivl AU [@ws-d o olsd B, uBY Qs
¥ quid (Fas skl 209 A auiddl Risdl WRRAR 2y 53 B, Gua-l Gelgeil Gualaml dada
vlink daed erendoell vieal widurldsd i N B, Fll yausia Aa A B,

il 42l (Horizontal line)

<hr /> WaA2 YA Anid d ddl €3 B, <br > WRAvel ¥ o A vidl B@A-2 B, avuan
& [euorl adflsl 9g Wil a-dl Guadlal wy B, dd Wl A url s 8. sl 274 eulda

Gelga ol

M S e10.html - SciTE

File Edit Search View Tools Options Language Buffers Help
1 e10.html

- <htmlI>
- <head>
<title>About Rainbow</title>
</head>
- <body>
<hr/>
This line
<hr/> <hr/>
1s broken in
<hr/>
three parts.
</body>
</htmi>]

2u50d 2.7 : 20l A Redn
el 2740 evla A uReun gl 2.840 ealawy B,

= = About Rainbow - Mozilla Firefox

[} About Rainbow

file:///home/pss/Desktop/e10.html @ 8- Q "-,!' @

This line

is broken in

three parts.

2ugld 2.8 : suGR L A4 <hr> Su-3A ald B.
wd il wd Gudbri @ as dal wim @il B, w gEesll sres 2240 wdal 8.

HTMLM Head 44 Body [Qeun 25



atd agl-

size dla-l «nas -8l &2 8. d 3, 5 & Wdlu ay 104 s£ wAd Qe
(pixel)<l GuuaL £31 asL

color Moxzilla Firefox %al vlsawelR? (Explorer)dl dlél-l 30t «igdl 53 8. el
WL A i uglanl el avafa s7 wny 8.

width Al dous il 53 8. 2 dous sUGRA Rl uQuSl 253 3
el sl sl asiy 8, wdusSdl Bad w4 100% du 8.

align dldl ol ouy, siofl suy I wenl dsai A sl S5 B.

noshade Uil AN oed s wEl (2 eald B,

fzs 22 : wfl A yanal

Wi 3, Gualdsdl g Ssdl & ¥ 21 seell 1l eula. ¥ 2wl se-ll 25% cnal ¥ Gudld
A wd A Wl el ouy olsaudel QU dl fA Y 2o @vdl W,

<hr size=2 width="25%" align="right" >

vl A <diug w3l 8 3 HTML 4l <hr> 291 W2 o4 adl 200 avidl $lid el wud 20d
QA A ol @3 ya Rl WA AR W HTML S wudld suBor gl Rl adla.

ydeaguilia avuei Ge6@ (Example of preformatted text)

Al uRRARA seurit 5 3, Fl BUUD vuariiRL A6 WAL WS+ ndud ealadl $xda ¢l ndudxd
YAUE) (notice) Sxes 2,34 ealew yoroidl B,

-

The rainbow is made up of seven colours. When we mix all seven colours they
will become a white colour. To demonstrate this practically, we have arranged a

\1

Practicing Rainbow Colours
Attention Please !

laboratory session. The detail of the laboratory session is as follows:

Date i 6August
Time : 9:30am
Place :  First Floor, Lab-1

Instructor : I M Patel

Principal

fe2s 23 ¢ ndAdrll Yued

SPYQ2-vRA : 10



Al e, Apan ses 2.3 |30 2ANEA Al 2dd R Gur B wadls s

1. fres 234 edlada @wuia HTML didw-i body [euwdsil wiagd W

2. wau dldl (Practicing Rainbow Colours’) 3 uaie) & 27 vl salauda 8, wuqd Aoy dd
gulaal 2uyR align="center" el WA <hl> 2ol Guilal Rl W

3.  ofle cldl (Attention Please !") ¥ g avi@ B, uig A Adl dlZl w2 wami ealada 8
Al 2un ¥ Ad eulaar s align="center" 4! WA <p> ol Awly,

4, Wyl wanoni a oL A R g W el 8, WL dviRid Nl Alel
paragraph 2oL g1l eully,

5. drlv, wiy, @A v Qs @A wRdl wudl ugldl wr ) g€l Ad 1y sl
2l B, 21 ydRazuild auia (preformated text)q Gelswl B. <pre> ¥ </pre> 2dl-l
Guilol s34 R Al Blaga adl o Ad ealdl adat

sres 234 eulda @i 2y sl HTML S Sw-Ror 2240 wuvai wuda 8,

<htm!>

<head>

<title> Notice </title>

</head>

<body>

<hl align= “"center "> Practicing Rainbow Colours </h1>
<p align =center> Attention Please! </p>

<p> The rainbow is made up of seven colours. When we mix all seven colours
they will become a white colour. To demonstrate the experiment,
we have arranged a laboratory session. The detail of the laboratory

session is as follows :

<ip>
<pre>
Date : 6 August
Time : 9:30 am
Place : First Floor, Lab-1
Instructor : I M Patel
Principal
</pre>
</body>
</html>

As-[aREa 22 : wdud eulad WwEw HTML H3

HTMLA{ Head ¥ Body [Qou21 27



A8 @R 2241 yaurudlg uReun susl 2.940 sulay 8.

2 @ ® Notice - Mozilla Firefox

File Edit View History Bookmarks Tools Help

C @ o| | file://fhome/pss/Desktop/el4.html v| [*gv] L
5 Most Visited v [g| Getting Started [§]Latest Headlines ¥
©| Notice v

Practicing Rainbow Colours

Attention Please!

The rainbow is made up of seven colours. When we mix all seven colours they will
become a white colour. To demonstrate the experiment, we have arranged a
laboratory session. The detail of the laboratory session is as follows:

Date: 6 August

Time: 9:30 am

Place: First Floor, Lab-1}

Instructor: I M patel
Principal

Done

sl 2.9 : HTMLu ydeazuilBd (Preformatted) avuel

M&lﬂj Qﬂa_uiivl (Formatting Characters)

a3l da ezl a3l (bold), sl waR AU (italics) 2ia auuriddl 1A 12l 230 (underline)
edldal A uudl LUGHL WswHL Y. Y WD @viRiA Jal W3 Y 539 A W+l $EBA 201 html
818 30 wdly dl suG L YAUBNA YRAUR BqAM A v sall WU Y s, vial 291
alllas 2oL (physical style) 231 a1} adorviy B. shes 2.440 ellds aoL 1Bl 291 Y KRaAB] v S,

a1 gl
<b> ... </b> wl 20l 4 adu R4 awen alel 93l sald B,
<i> .. <> 2L 231 43 218U s avnaA Sl i 13l eald S,

<strike> ... <strike> Bl 201l 92l AU s3E LRl 2l 3 @l uedl B4 Aivy dlu
ddl @30 culdal avual Gur dldl ealad.

<sub> ... </sub> L 29ll 92 28U 3¢ ArRA d-{l AL dMIBL Sl
Al AWML A 2§ (2 enld S,

<sup> ... </sup> 2L 2ol a2 28U 538 @vid d-l 2LLMHAL dBURL $di
Al 2eAU A d§ Gu eald 8.

<tt> ... <At> W 2l A AU RA Quuan asyuseR
Wl Bal At 208A W3 euld B,

<> .. <> 21 201l 92 a8y s3a aviRd]l 1A ¢l it 2zl suld 8,

fr2s 24 : oUQAs aot W2 2% (Phsical Style Tag)

28 payeR-var : 10



Guilaidl AFUISD W2 2 Rell YR B, JUSA W2 sUBRA ollAs YA Ul oigd A
SUGEHRA ML sdald U B 3, wyd g ASY B ? 2 Nds @uis s wudl 2 alds wida
W2 29 (logical style tag) s& 8. <1 2udal 2o 3 Jeais clls wiSasl 29l Gewga B,

<em> ¥ </em>

v 2ol AL gL v ¢liRyds salaadi wud . Herardl susid Fdl 3 “sdl o usHiRl 519l (Must be
done) A “vitr” (Important) ¥ 2911l GualoL £30A @l 21514, 2 291 GergRet <A yoret &:

<em>What a beautiful rainbow...!</em>
<strong> ¥ </strong>

il 3w Al g @R ay euyds Y sRal WAl w2t Gen A yoru B
<strong> What a beautiful rainbow...!</strong>

GURAL BEIEE 4L <em> 27 <strong> gl eulcudd duuel @Al dglad gl sl dilfs @Iuis
Sl 23 s 2541 2wl wen B,

gal q@in
<dfn> gl (RalRd a8l g s B,
<em> SIS A @BlIRl YR GUR Hadl W2
<cite> Yadse] afids, wafo 43 Fal wugrarl @uiRd Y SR,
<code> £uy Wb 4l¢ sulaar o avum s seell Sieenl ealald.
<strong> 2 2oL @il ay, suayds sald B, aviigl ay el Wy a3l eufau 8,

fres 25 : dlds azuis 2 (Logical Style tag)
Font 231

DLARIAL ALsEA Feddl HAS 2L &6 ONsqdl font 290 GUALL KM wd B, d2dis Gelsa (1A
MM 2ude O,

<p><font size="'3" color="red'>This is some text!</font></p>
<p><font size="2" color="blue">This is some text!</font></p>
<p><font face="verdana" color="green'>This is some text!</font></p>

Bl adl A i gl 3, 248 AAvig] Avuid sied green, red, blue A 2Ll AW Al GUdL s34
8. Guarl GergRa font 2at-fl WA dRitp{l-) wa Gualal sl 8. 2 sl B size A color. B3 size
B, vl w18 56 158l 52 D B color B VIR 4L 32U A safany A A8l 8 D,

HTML sl a3viadl o el Qo w2 font s dl QARY @bl 4] 53 gad sy
8. wg s {0 ywe aud W:

<basefont face="Arial" size="16">

HTMLA{ Head ¥ Body [Qou21 29



A8 R 2340 eulon WA YU HTML 88 avfll Guilsd S sl asny,

<htmD>

<body>
<basefont face = Arial size=16>
<p><font color="red">This is some text!</font></p>
<p><font color="blue">This is some text!</font></p>
<p><font color="green">This is some text!</font></p>

</body>

</html>

s QRS2 23 : font 290 AsMA W2 HTML 3 "yl

GuASd S 28U 430 SuBR gl (el Nuet 5. vl HTML 58w wRRus 2uslgst »usla
21040 saulan yas 2wl

2 ® 0 Mozilla Firefox

File Edit View History Bookmarks Tools Help

c @ .b..'., file://homejpss/Desktop/el7 v| v &

{5 Most Visited v || Getting Started [ Latest Headlines v

l@| file://fhome/pss/Desktop/el? o v

This is some text!
This is some text!

This is some text!

Done
AR 210 : WHRIY s WA Iy
-y :

] gl 2l 2.1040 Boug §lSad W el7.htmid agd e17 8. WY d RdsU siaxn
Brdotrdl GUABL s3q el W §1Sar el W vigdoindl GuAlOL SNl wWd B AR A
gifa-dl viga-l @vu@ 2gal Al Gual eald B, Gerw a3 wuvmen Rwwl HTML wsjdoin
g s B 3 3 HTML wsikl s15a 8. SEdd uRew Avaql Rrisy R Guidisda siaq
sqeod galadldl %32 WAL 4ol |l F A gifan vdadl Dou WD Gudlal s B 3
adl suddl sl @ 8.

30 SR2- MU : 10



vy Rl

iRl RE ¥di 3, <, &, ©, 43 Ra ydoo ddd & (s Ra) WA deddey w2 wudl s
8. idl Ucdlsins A oed A ¥ A Re w2l ASCH Bud wa well ada, 2l o3
vledl W2 W B 3 ¥ HTML exidaui A8 '< i S Ra-l Gudlol dl 63 - asy. sk
3o 2o wd el wadll asud 8. Ses 2640 suldd v R Guala s

Rea agis uidlas e Bua
< "l sl Ay (Less than) i 60
> Al i ¢ (Greater than) gt 62
& AU (Ampersand) amp 38
© siflude (Copy right) = 169
Y s adula (One quarter) - 188
% @Y (Half) - 189
Y4 A% Aqala (Three quarters) - 190
® WrR2d 20US (Registered trademark) erg 174

S0 2.6 : vu [Bs 2 widlas i w1\ ASCII Bua
HTML 8¢, il Rdl ¥ (<) A - sKdl Ay (>) RAastl Gudlad 2y sqd Geleel..

<p align="center"> &It Basic Information &gt</p>
Gudsd A$ Aoy w2 A Haw quur salad:

< Bagic Information >

al wsRdl wuadl dadla 2

L WsRBL vl ses 2.7 eulda ol ul s B,

33 agld
<t ..-> | HIML $&3i Rwell arimq Gd2a
<b> avigil w2l wWaddi sald 8.
<base> Aol iy Wild URL W2 »u43u URL / sida eald &,

<basefont> | vl A%ASY W2rll WA (default) §le envufd 52 8.

<body> HTML ec1d 42 body [Qeusl ensuid 52 8, o+l 8 background image,
background colour, text colour, link colour 4312, a3 Guasy 6 B,

HTMLA{ Head ¥ Body [Roual 31



L
sl aBlv

<cite> yadse Alds, Betd Al add Fal ddra-ll WA Y KA g dusl
AlAL AR (italics) 13 ealauy B

<code> s22423 WgURlaL Ale-il AeuolA 2% 52 B, 2uqg v Fud se-u Si-el ealaiy 8,

<dfn> vt FaiRa 22054 29 s2a1 wUd aviR AR AR (italics) 43U salawy B,

<em> @il auyds Y sAY 9.

<font> sy UsIRUL WA el gl ollsadl glve 22l Budldml dar B,

<head> HTML txidy-l Head [owor salal,

<hr> adl ld] alvuRa s D, d-l WA size, colour, width, alignment, noshade
i Fea Rl du 8.

<> auigld Slidl 4R WL Y K 8.

<link> EUAY Bl GGl UM g ey @wfd 538,

<meta> A A, 31 2y YAeldl MU author, keywords, description, purpose
43R AN, qwalll 2uRdl yil ul 8.

<script> s ouydl e cwewla 53 8.
<strike> e e 3 avul ugl 84 divy Q. ddl dd euld 8.

<strong> dauie ay euyds ealaql wa B,

<style> gdldy W2 wdd Al WRA @arnula L2 8.

<sub> wl 29-l Q2 28U s34 qeiR sl 2L Quiel Sl il WaAHL uA
df A euld 8.

<sup> 2 &l a2 adu 53d @uuan Al UPRAL QUURL SRl il BAAH wis
0§ 6w suld 8.

<tt> wil 2ol a2 atu sid @viel adude’ ualld aral AlssA 2 @I
gald 8.

<u> 2 ool 9 adu sa quied 1A € dda @3l culd 8.

ey 2.7 : ousaw 2ui ada HTML 3

g Geg

Al wd), Al¥el Warid s Gelgwl adsl. WA 3, duld el wondl 3is wel dsude tienadl 8.
douse ol AAAL ¥ waRl-l 2pid sl da. wousdl doRuded qeu Wi vgsHRis
(index) 2adl d13U% dd Davl asy. yad AUy Y aug un uslid 4l 20 el wR wond
22 Wl Adel, bRl ez, Ayel A A dudpidl agiid WRAL waL YA usld. deBwrid
o, 2y [ARY dordde Fal 3, ‘Qals g, ‘D2 A, ‘sulsil wa WA 493 wd A
((ars) 1S ak.

32 SRL2-BUA 10



»i Aol asld A yoo, wule B:

o UL woud @t U : sl dsiuSerl e Uil YR WY Uil A, GURId W A,
wourt el g5l WRAL, weudl Altell sz, &S I Rowst W woud @ A
ol yws WAl %3 Qad-l wuda 4.

o [asmm wd Aals ugf : 3w w2 Resoedd g5 uRay 2y ad, i eds Rassd
A, slel[@{_‘x alsid, sul bl Al lwd 8 A, wd dud ARNELRE duy Qi $-ida
WH 8,

e A 3l : 3 we adldl flal, Aay, RN B diFdel Wikl suld S, wwd woflalld
A s ol vl Aroue ugldl 2 dsAdy orudl us .

o YBWL MA Aol : 2w 8wl DA sdsd 2R wAl RAN WRA v
8. ddl RAaelal 2w alelal el YRNANL A YAl we sl Geldt dl, Wdldia,
Foiauul 2l -, AugR sidsudl ndud 2«1 wRRun.

S4-RRRo 2440 2l HTML S8 ol

<htm]>
<head>
<title>About my school</title>
</head>
<body vlink="purple" >
<h1> My School </h1>

<p> <h3>

<a href="Home.html">Home</a>
<a href="Activities.html">Activities</a>
<a href="Staff . html"> Staff </a>
<a href="Gallery.html">Photo Gallery</a>
<a href="Event.htm]">Events</a>
<a href="Notice.html">Notice</a>
<a href="Contact.htm]">Contact Us</a>
</h3>

<p>

<h3>About My School</h3>

<p> My school is one of the best and most reputed school of this city. My school
offers education right from kindergarten to 12th standard. My school is equipped
with all sorts of modern day facility to enhance education. My school has a
play ground, an assembly hall, library, and activity lab. </h3>

<p>

<p> My school offers teaching in English and Gujarati medium and is affiliated to
Gujarat Secondary Education Board. The teachers in my school make learning
easy and interesting by providing presentations and demonstrations. </h3>

</p>

</body>

</html>

s13-laRen 2.4 : My School Atz Yeu Wri H2-W HTML 58
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ARzl Gudd &3 AR 2,440 euldd HTML 58 2164 $L dL Homehtml adl3 uadl.
AR SUGRML (Rt A wReun 2udgul wsl 21140 eulen Yo 2wl

M S & About my school - Mozilla Firefox

About my school

file://fhome/pss/MySchool/Home.htm B- Q - é.'\

My School

Home Activities Staff Photo Gallery Events Notice Contact Us

About My School

My school is one of the best and most reputed school of this city. My school offers education
right from kindergarten to }2th standard. My school is equipped with all sorts of modern
day facility to enhance education. My school has a play ground, an assembly hall, library,
and activity lab.

My school offers teaching in English and Gujarati medium and is affiliated to Gujarat
Secondary Education Board. The teachers in my school make learning easy and interesting
by providing presentations and demonstrations.

»uhld 2.11 : My School duiused Iy

2 o Home Renusll AS gt R u2 Brs 21l d 915a qudl 4 &l 243l-L ea 2ide salad. 21
A2 A Neal W2 saldd B, S22 3 A Home html Rl 3y A s R s3e <,

Wl sl dwr s w2 (A wuldl yaaid AU :

o 3w §16d %4l ¥, activities, staff, photo gallery, notice 4 contact M2« HTML 518 auil.
i 4y, A 2L a3 ol home.html s1an WAadd 8 A ¥ RiseAul sl Aqe R
photo gallery 32+ Aol siudaur ddl v B14 &6 usl ¥l ¢d uell wsRl AR dd
HTML tcidodi oo{lale amlaald aflvfl e 21 uel 21 GeldrRizu Wigsen YURal Ndcl
s300, B ugl dd il wousd udls (logo) UL il GARL a8l ul dsd dil Wi AsUdy-il
A5G dld AS Rst ¥ eofl 3gen und oL,

@ "Practicing Rainbow Colours” R4 8¢ RiR2aL 2241 wudd Holeslt 2iqaiz dd s YU~y
(notice) dl dwiR s o €18a B, adl 31 s15a- wn siedll Notice.html s wadl a8,

o U0 2oL Gud w3 wollull, SlsG A Rirsell GudAL 4. @l @Rl YRl u nh.
Gersrt all, HA% YR dX Rl AN AR, WOl 2o UM, Wouel ey B, wouel
Aud 42+ R 493 avll w5

AW

¥l wsRMi HTML #cudo-ii head (Qeudpii Gualoi Aaidl A2-29L (meta-tag) [ v,
2200 Al A 55 ueL euld Al A sdl A Aus, Adlau w6, WAl R aslq Aeidl
WRA wed £ B, 2dl R wAAF dul vi-d YRRA N vl o wee3u lad W1
®. Head Rouwddl %, HTML &didy-i Body (Roewsiil Gualoii Qdidl 231 aid djeiiql
we 3l sl HTML+, body Rleudt 2ol a0sasll uRd olfs A dulls 1zuis 2oL i win
R& sl ydad 4@ WA B, WMd HTML srdadl Rwell adusi-a (Relee) §le2 win
0 GRAAL Ad AS, 2Qdul, wud As gy wadll ARY w9l aslaa qeu Aol
Yaddl As Al dsise wel sl
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=1 @& th £ W N =

e,
A8 HTML exudy 2 head [@Asud w dil Gudloil dawdl A2a-2a1 QA gy <liw avil,
HTML 23l Gualol 531 3l A AS esollA doidder U oisuG~ adly GAZ] wusy, o asldl
S5l el o0l jgid qeldl, “sar AR WM’ AL vl sui aeld),
HTMLHL ¥l dldl HRel <br > 3dvel wal L
HTMLMi font 29 agld),
HTML g i R 2dl Ad 2% sud d asldl
{2 2la wal w2 wildl [Asaduidl You Bser wie 430 s il
(1) (RAeimiel s 6, HTML Sl 8 3jaod [Qewd) orid & ?

(2) Head »1A Body (b) Physical %A Logical
() Code ¥\ Browser (d) Meta-tags 2iv. Body
(2) HTML exudoti lA-uamiell sa [@Qouadi Aet-2or dvaimi sid 8 ?
(@) Body (b) Code
(©) Head (d) Special

(3) HTML wrizii 23 A2-291 Guadail daiy cud, asldy QA JAunidll g adaami
2 | ?

(@) aus, Geel A wdlw wel (b)) wav|

(©) w18 ) %
(4) Ao s [Auniell s 220 209909 euluy & ?
(8 <p> ud </p> (b) <body> A </body>
() <title> nA <fitle> @ <hl> 24 </hi>
(5) HTML adorii 0A-miel su @eudmi suvd Rwel 63 adla ?
() Head (b) Body
() Head i body 6iql (d) Head utgaw body
(6) HTML Qi do galaar w2 NA-umifl g Gudadi dau 8 ?
(a) AN¥ifl uglanl sesL (b) swy uglinl seRb8
© sar [BfRia {Re @ 2l RsAg
(7) HTML 4l yaisid dais 213d (visited) (=5 dlsdan Asiaqiell o Gualormi daiy & ?
(a) alink (b) viink
(c¢) before link (d) after link
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(8) HTML Sl »i(Ra [t odsaal w2 il o Gudori dawy 8 ?

(@) alink () vlink
(c) before link (d) after link
(9) HTMLYL 2181 a3uisd ®2- fA-unidl sw oL yeu wsl 8 7
(a) ol xd als (b) dRs ud oua
©) sMAAG uA sl (d Head ¥l Body
wadl¥ts ey

wseni 2ul 39 'My School' dsiue e-iidqid WFs2 Yl 3.

wey Qafes Al douge ol A dedl WA 2owA LA 2 @A) W2 Rwelu)
avil.

A [ Anldey dur Rl i QY i wRar B, e Bel, dcua dakls @iy
A dub w2 Weudld asiv A dsdall 2@ ad A st BARL w4l

-~

~

I, me and myself...!
AboutMe MyFamily  MyFriends  MyGoal  ContactMe
«se ... YOumay write about yourselfhere....
\_ J

wdl ol dldl W A il QA culdd we)l N AR s B, F dud Yel WA W
Asmd, ABY (WERa) Rrs u Yeisid A ada (visited) Rics olgdl. e o1 WA
853G oiridl, ¥ A UG wwuA My School' ~uu-l dsue oi-ldl d WL L Bl
Ayel Asde ol AT,

http://www.w3schools.com/ U %L, A-uidll HTML Reusl il &2l v "try it yourself
A Al gl AW s ARR B F A HTML 581 4 d 28 3 oGl Rdwdl
Sl A e Wy 52 B,
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g s3UY B , ¢ WEL sl A Bot ay sl mu 8. B viadl ool H2wewdidl el
s B vl A LA 2w udluR B, oA Aol R ¥ ool salald dl Gualatsdl drd
o drll M2 Sl 2uud. adl, A vadls 8 3wy Ad Rsl 3 well any A dlgladl sweusil
au 5N B,

HTMLHL <img> 20l Gualol s30 deldadl ooflall Glacuml wd 8, oUGL NsWHL 2N
Rl SsB ald As esefl GARL B, Andder Gua esell G- oflan uRL HRL Rl B, Gelsa@
adly, A4l ya-i dsldernii rainbow.jpg -uudl ol GRRAL.

<img src="rainbow.jpg">

Gusd GelgR@nl sre ol Gualol sudl B, ¥ 0 <img> 201 WA GudAML A AsldL Y
daailel WA aeld, sl 2w B,

image (4\w2(image 221, t9ofl A @il WAL dl ldl (line break) vnadl Ayl =2 4 S
WRA2 (Inline Element) a3 davuy 8,

sre ﬂmﬁlﬁ

sre R ssolll 2 2l WRAL YA W B, udl W Ned welld GearRaud. A WUBHRA
aud 8 % 9ol s1da sul wlel ©, ed 3 dd sl Wudl. wellair Ay 2w W2 URL-AL
Gualal 43 ¢, sselly Yo e ealon a9 UG W2 el ludl wd caladl wnusy ol
oy 8. “"http://pritisajja.info/images/imgl.jpg" a3l 2ude, URL udl ool wia sa1 2uud «(1Q
yorouefl 231 @ull wdla,

<img sre="http://pritisajja.info/images/imgl.jpg">
211 Fl0 ealadiui vidd ol s dou e9efl U ¥4 %, bmp, gif, tiff Al jpg a3y~ didl RSN,

ns Al YRRARA seurl A 3, ¥l ddl Sreatzul Rl WS WL & v ddrl S eell 2l
oy B, d A HTML S drl wdd a4l dg, Ayl URL dd 2l o Aaqall 7 oo Asen
AN B, uun [Ased B, d w0l uR G g oledt s 43 image link-l Sl Rl wA ofin
Rsed B oug oo [Rug &3 olld amwr swe-l siRwuui wadl adl. ollg [Asen yaot x4
sl udal vell-u siflade ousid wuda Wq wF B.

i auiRL WA <p> ¥aal <hl> Fal o)l GUADL sAY AR B U s WA QWi s
28 ealddid du B, 2w image 2ol GUAL AU U AR, AUNA LS @uiel Sl &g
ofl, Aot ol Ha A wA WA 2l w3l gawdl ¥ edlacil iy B, V2al W2 ¥ image
ol viel 20 52 B, A 3, awd suGRAHL wefl WA S HTML eadidy ealad Ul suBoR
d oofld W Rl o3l B, woll asRl RS e wad udami Guasy dl w3l B, A
dd URL-) Gualol sdl u dl dg $v2:2 4@ wg 8 3 3 Q askl

toollull MR s vag Slek I RIs2? oiriladl 2 vy W Mael AU, 2L WRPM oddR B,
WA s R douge well M @ v uAs ollaldl Gualal sdl Y. HTMLAL »ls sl
Wy AR 96l G WAl £ SRR 3.4 salda B,
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<htmP>
<head>

<title>My favourite food ....!</title>
</head>

<!-- -
<body>
<h1> My favourite food ....!<hl>

<t-- >
<h1> <u> Chocolates </u></h1>

>

<img src="chocolate.png">

<h1>

Chocolates are good for health, better for hunger and best for mood !
Do not forget to clean your teeth until it is too late !

</hi>

<p>

<{-- -
<h1><u> Fruits and Dry Fruits </u></h1>

<>

<img src="fruits.jpg'>

<h1>
Do not think dry fruits are dry, though they are dried fruits !
They are really really very interesting !

</h1>

<p>

<!-- -
<hl> <u> Ice creams </u> </hl>

<>
<img src="icreams.jpg">

<h1>

Ice creams are really cool ! These become coolest when you taste them !
</hi1>

<p>

<!-- -—>

</body>

As-faREa 3.1 : doldy W uAs ollvl GiRdl
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AR 3.1 J2dls 2usiawsll dldls) wud 8. i 2usindll A AnUdardi enlnd «dl, siRaL
3, dd sl 291 (<! A ->) H 2uadd sulad ], 2udl ) HTML $l4n aiacdii dandl
oadl vin ay WA Ad wxgel Ada Qe Reulrd 53 8. G WA Wy HTML Q- ¥
adlaing dlail 58 wud eusiawell dlAA AN a8y 53] wsdi Al WA vudl Regell Fdl
dlZlaA sl 2ol 2a]A saladl Ada.

AR 3140 vl HTML St wReun 2ugld 3.140 ealay 8.

© ® ® My favourite food ....I - Mozilla Firefox

File Edit View History Bookmarks Jools Help

A o file/homelpss Desktop/e3l vl M

| E
SnMost Visitedy @ Getling Started  |5iLatest Headlines v
o My favourite food ....! w v

My favourite food ....!

NG

Chocolates are good for health, better for hunger and best for mood! Do not forget to
clean your teeth until it is loo Jate!

Emmﬁgmm

Do not think dry fruits are dry, though they are dried fruits! They are really really very
interesting!

cream
&

o
4
\_____I}

Ice creams are really cooll These become coolest when you taste them!

Done

2ugfd 3.1 : AsSwul wds sseflail

oG wudal et (source) WAl s ul g e9ollall AN WA HTML S F s ealel
¢ o Wl A sl sulad. Gualowsdl e A dm ool AR W Rad D,
alt ojmusd
image 20 WA alt Al 3o ol asld B, w A ysdl A el ucwsor] B, s 3
d ool agld B. alt dRtrld Gelga fld Yoo B

<img src="rainbow.bmp" alt="This is a rainbow">
@ ooRed weld Gudlell B, dd udd sre W B 3 A ool qeld B, ¥ uell ol aua w3l
Au B, uy sRR A B 3 WA L AS uR SRR GUGR ol 4 eald dl ue as dNeq
dl nRdl o & 3 s Rot wad. Ay sre W S % A AsSy 4 IR’ (Screen Reader)

HTMLAL t5elallf sudzennst 39



Fa Alg2d2 gL Al wad sl dl selld udueqd wa ol ol (464 Ak A 2[Rl vl
qaladl dlsl W2 dwr sudd s QAR Aged )

height >0 width @i
height 19 width a3 «1A ealen R wolll QS wd udons J2al Rsda & d euld 8.
<img src="rainbow.bmp" alt="This is a rainbow"” height="120" width="180">

wdl, width @ suGoRA aeud B 3, Aoy uR tofl Jeel udlell 2ridl WSH. height ARl A
edld & 3 wofl 22el Glall &l WSH. height A width Jeieidl Bra Rsda-l Avaid 204l
glaami »ud 8. height v width ot As0A GUAML Ael %3 ], dd Al S uel Asil
Gualal 31 sl A 3, AS As o Al Gualol sl &6 vuA Gualall waL <l

sUBRA t96(l-{l oS 2l ulons QA qtul AR yl wigalel oG el 4 vuaalsi (Load
Sals]) 2L 29gild seled S A A sdan oA, w1 GG B B 3, esofl W2 Jaell roul sraadl
ugdl, A W odlug B, ¥ awdl woll il A sl DA 4 &l WS, o X, HTML £lgai 424
tooflel iy dld Al 2w B, ay Gl & Al G ¥ sl Bud »udld awdl eosfld Rga
el ¥ Afadl 2 url Aaigary Al vin saiel ssefl-ll d@ian wa guHidl el W,
align 3jR143l
align il wlel 9ol il viex o vadl eell dddl S8 wa AR dNsd B, Bl W
Gegel (1A s B :

<img src="chocolate.png"” alt="This is a rainbow" align=""right">
align otel-l wd fves 3.1 eulen yormdl AS As Bud 2l any B

Gua Basu
Top well avuelfl el dldl-i Guar ewdl asan 8.
Middle t9ol 21 Ao dlsld B 3, el 1oLl larl duipl WA vy 8,
Bottom tooflll 85 «{lA-A) eudl aviri]l daxl dlél w slsuy 8.
Left toell Rl Sioll suy ollsaly 8.
Right tool Al oipll suy olsaw 8.

sres 3. : align JRatdl asu Gudl
border @143l
ool 9ol §20 Beidl €A oolld ay susls oudl usny 8. W JAd wellada AReny
Rd Bud &dl -l
ol §2d Bewdl st w2 +0lA Yol border Al Gualami @ wsM. border dqRuML
borderl wdious RsAaui ealan B.
<img sr¢="chocolate.png" alt="This is a rainbow" align="right" border ="20">

ol ool el wwy U R Jedis suBR (¥al 4, Internet Explorer) t96{ld at wsifid
(highlight) 53 8. sl2d %, 203 w6l Aa ddld Gulonil QS ¢l Al d Bl qu ay uslia
5A4.
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id md
id ol ueedl, ad wofl w2 A6 2Davt (identifier) N2 & - 2wl AL A Wl AN (java)
¥l WouBio cwwni avidl @eni d oelld A Al AdH] sy, id Rl Guala 3l fd
sy A Al 2o g ealay B:
<img src="chocolate.png" id="choc_image">
Sta+l ?llibllg wiel o G (Adding space around image)
Syl ouy wiell woul GAAL W2 vspace ¥R hspace ORIl GUAL LA WA B, wolll
Gur 2 A eidl vuell WUl GIRAL vspace dAqRHAHL GuUlPL sl A 8 A o A, well-l
dofl 2 oiell ougRd vl ool ealaal 2 ol andidl Gudlal QA Gelsel euladl B:
<img src="rainbow.bmp" hspace="30" vspace="10">

o1y SIS t90{l @il Breige Q08 S 29 o1 UL o bl Sld A v el vt o Gudlall
QR B, t9oll{l 2134 ougy woul e9lsaiell 9ol Wi ay e ol B el AsidSar aY aiadl Ay oA B,
A-fufR3al 3.2 s N Gelgaw eald B 3 Fui Alsda-l wolldl s2d Al o izl audl B,

<htm|>
<head>
<title>My favourite food ....!</title>
</head>
<!-- -
<body>
<h1> My favourite food ....!</h1>

<!-- -
<h1> <u> Chocolates <u></h1>

>

<img src="chocolate.png" alt="Here comes the sweet image" hspace="100"
vspace="200">

<h1>
Chocolates are good for health, better for hunger and best for mood !
Do not forget to clean your teeth until it is too late !

</h1>

<p>

<-- -

</body>

</htmP>

As-afREa 3.2 : hspace i vspace qgladl HTML 5
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R ddl S-fuRoL 3.241 eulda HTML 1A allGoRal Felaal dl d 2usld 3.2 4l 2uudl. hspace
A vspace QR g2l euladidi wnadl wudl il Qell wow AS usiy B, HTML Sl 414 ay
ol GA 2 uehl Y & dAly s A eselluildl Iefl A Y 2 B.

2 © 0 My favourite food ....I - Mozilla Firefox

File Edit View History Bookmarks Jools Help

-;A ¢ | fileimome/pss/Desklop/e32 v v

LS
o Most Visited v | @ Gelting Started iLatest Headlines v

@ My favourite food ...}
My favourite food ....!

Chocolates are good for health, bet1er for hunger and best for mood! Do not forget to clean your teeth untit It
is too late!

Done

'\‘!llé[?l 3.2 : hspace e ] vspacej Mgt

¢ d A AY 3, hspace 2l vspace ARt efl{l sl Uy Ul GAY B, Wed 3, > hspace~dl
Gualal sl wd AR A welldl Aol uA onell WAn sl sy wow W B, B o Ad, R
vspace JRipldl Gualol saii wd 8 AR d selldl Gurrll A AL sugB yow 9] B, Wl
A s e o voll GRAY dq LA W2 MR ool doy Ad Yurdl W W RAsezd ya
ollll ougl wls vuell ol syald uel QR any. A 3, 2w ol QAsewdl oyl A dsagll
sl d wag ol Ay,

R s2yeal Rl "chocolate.png" S18d- £ sl HUA A 2 w2l a3 73 d
eoofl 2 A4(€s Rl B 3, "Here comes the sweet image” g, eulad ? aud selu vusld 3340
gallew yorsid wReun Aql wa,

® ®® My favourite food ....! - Mozilla Firefox

File Edit View History Bookmarks Tools Help

C QA o | file://fhome/pss/Desktop/e32 v M

B3 Most Visited v | @ Getting Started jLatest Headlines

o My favourite food ....!

My favourite food ....!

Chocolates

Here comes the sweet image

Chocolates are good for health, better for
hunger and best for mood! Do not forget to
clean your teeth until it is too late!

Done

sugld 33 : ool siuRui Asl@s agiq
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2l Rodieyaqiawdl tosll

ay Rolleya-taiofl el uell ay aow A3 B »d dsldorni 2y sl well W @R B, ay
Roleqaunaiedl ol dsildorii A HlA 29w b ol 2uuel suadl 2 Rojleqadanll sl
(1 ealon Yoot Aol 2y 530 Wl :

<img sre="rainbow.bmp"” lowsrc="rainbow_low.bmp">
A6 uRt ol west Rofleyariaoll eosfl oiriqar 32 A ool yarR-ai sl dadd sud
‘Sor 2AR[E0L 2e’l resize, crop Q33 24(Fsl GualaL &3 sl
ot Rofleyaunaiell ol sl Rseus s@tal Gualar gl 2uud suGol ARl w6l
Wil Ax i, gl Asf@s 9ol ol W A A waadl W aoll, st Rofleyairaell ol
gaull e, v guudl.
RRY @z el A
v Yl WU Image 294 bmp (Bit Mapped Picture) $1Sa-)l » uwda sl uig, esofl4l dlsi
i 3L U9 Guasy B, -l Image eoHl uHIdW 531 wsa. oofl w2l RRY 3w 14 bmp,
jpeg, png, tiff ¥ gif A ay wURd ol 230 V. sual wolRaFul asl- srves 3240 ealda B,

ol s18a 3w Qg
BMP Windows -l 08/2 H12<{l Bitmap Graphic file
GIF Graphic Interchange Format file
JPEG Joint Photographic Expert Group file
PG JPEG/JTFF Image file
PNG Portable Network Graphics file
TIFF Tag Image File Format

snzs 3.2 @ wofl a3
Rerza 3331 unl Aol Aty Ad jpg/ipeg s15all Gualal 53 8. 5181 &, 1L 2a3ul s15a3i el
Al Fld g 52 8. 512 ¥l (continuously toned) 9ol 2 jpg A jpeg t9sll W3Iu
sied B. Al QR4 tiff ollrazu ay Guala Ay B, sRAL 3 A G JRATL WA @gdd s
W eooflg AR Blel WAL AU 43 A B, Tiff 3 WIUR PRARRA R ool a3l 2
woflRagu 8. gif 3 png Fal w4 55 AN YR fsl-RARa AgAA 24deliw-l GudaL 53 8. A
%, png A3y d@val A, aladl w2 wuanl iy 8.

susia 3w iz iz a3 tooll

aell auid Wi D el eafacdi suGaR DA And @ B, U Guld 2R 2iuel WA s J ay
WAl R s weflall . i Guoisd] AR Hpariay ol B 3 56 el wum aadl. g Neude A,
3L, Yl 2l el Bl Ylrargall 1R+l viidaid WAl U+ dsRudz YR dAg b Wil 8 7 A
o A0S U dul selu qell lwarqal-dl s adq WA 28 <l oludl Al wad, wd
Wil A gl 21 WY ol ad A el el v [Bus sdl us), Fl aunl wdie Wl Yarazg W2 wil
opeladiendl wHeHi N2 ol wd wd axg RAN Rgd WRA vag daddy salad, sud sen
2 doldor yasil eds il 9ol 2AeL (Rirs) 2nucl w3, il Ae sl ast &, ] el dle 252 (hot
text) ¥d, s 53 B, A, wdl AS 2522 L B Al ! W2 vAvR WA dl2 2522 )l sl 4wy L ugA | Aol
dle 212 ¥ s1u sl 2 eseflarell aui(spot)d dle iz (hot spot) & 8, el 8 «irll 9o{l HAA] A
o el el AU g €13 ¥l HTML 418, S3-RiR2oL 3,341 3 sa14i »ude &,

HTMLHL t9olladly] caqranus 43



<htmb>
<head>
<title> Image Hot Spot </title>
</head>
<l-- -
<body>
<h1> Either you can go to office or go to temple!</hl>

<p> <h2>Click on any image below to see its larger version </h2> </p>

<br>
<)== =mme-emm--- adding links to the images -

<a href="big office.html"><img src="small_office.bmp"></img></a></p>

<a href="big_temple.html"><img src="small temple.bmp"></img></a></p>
<!-- -

</body>
</htmb>

N3RS 33 : leulz adld o]l Wd-w BHTML £3

mainhtml $lfaui GuAsd A3 28U 53 A &L A ddl 2 8 sUGR gL gl dl A 2uelgs
sugla 3440 eulon dyoan el

© © ® Image Hot Spot - Mozilla Firefox

File Edit View History Bookmarks Tools Help

[ & f{,'_\ o | file://fnome/pss/Desktop/Hot Spotymain.html v| [*fv]| R
i Most Visited v |@|Getting Started [§Latest Headlines v

o Image Hot Spot S bl
Either you can go to office or go to templel

Click ov any immage below to see its larger version

Deone

2usfd 3.4 : gz Wiz a3 ool Guda

S13-[uR20L 3340 saldd HTML 518 Guid wal 20yl AR s9ofl+l %32 uid. 2yl small office.bmp
Al A As A 9ol %32 Ul un big office.bmp ~ln-ll 2FAA A5 NA e9efl siSa-l
el %33 il A o Ad, 2udel small temple.bmp uH+ll ARl as «li-{l e90{l u big temple.bmp
Al HRAL 2l NI eoellefl uoL w3 WA AL 2 L Adl ollall dwr sl W AL ddd
£96{lallAl w13 seeld uRL Gualail a8 sl
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oA i W2 (small office.bmp) 217 R W2 (small templebmp) s16d Gueth ¢ A A d
mainhtmld 8GR gl Fawmal), d sugl 3440 eulaw yovid wReun dd Feiell wswl

DAz sUGHJL dd mainhtm]l WeHD sl Bolladln qou Fd [aell €, udl sollu) w [Ris
sl Yuel s3 A 2w ad uay ool v FRus s cud il ool iz wdle sl asll
1A wde href 231 a4 ol Wl (big office.html) dag & od,

<a href="big_office.html'><img src="small_office.bmp'"></img></a></p>
wWA A <y dl 3, WiRudl DA ool WA il big officehtm] Awy €l ¥ ASA.
wad sefl 4R[Sy Rl AR and gl 3.540 tvun B Adl i A wad.

© ©® 6 The big image - office - Mozilla Firefox

File Edit View History Bookmarks Tools Help

| & (EA ®| | file:/{fhome/pss/Desktop/Hot Spot/big_office.html v| v

3 Most Visited ¥ [¢| Getting Started [§jjLatest Headlines v

@| The big image - office e L
This is the bigger version of the office...!

My Big Office

Done

2usld 35 @ vl ad uddl ol v Gus s AR
big office.html duR $aAL W2l HTML 8§ S3-[aREL 3.440 2dd 8,

<html>
<head>
<title> The big image - office </title>
</head>
<I-- —
<body>
<h1> This is the bigger version of the office...! </h1>
<br>
<br>
<br>
<img src="big_office.bmp"></img>
<|-- -
</body>
</himl>

swfalEa 3.4 ; uan ool W &8
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3 o dld, 2l 2wl 3440 eulddl oflw soll R A Bus el AR ad Wl 3.660 ealaw

Wl uRRIM (Rl asal

© © ® The big image - temple - Mozilla Firefox

File Edit View History Bookmarks Tools Help

FaMost Visited v @) Getting Started [jjLatest Headlines v
@) The big image - temple

This is the bigger version of the temple...!

Our Big Temple ]

Done

wyld 3.6 : 2w ol el woll w2 Gas s AR
sl 3.6 Wl HTML 83 (big temple.html) S-REZA 3.541 qdlde 8.

e r ig\ o | file://home/pss/Desktop/Hat Spotbig_temple.html v v

<hmb>
<head>
<itle> The big image - temple </itle>
</head>
<!- -

<body>
<h1> This is the bigger version of the temple...! </hl>

<i- S

sisafEa 35 : oflw el ww2-u A3
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GuAsd GegRid yal seal A A e wR eoflal wA oel HTML si8a<dl ¥R udl:

1. | Small officebmp | > | bmp @usl VBAA 2lg el 96l (viadlL v S uLL Wy
ol 3u)

2. | Small_temple.bmp| > | bmp wudl Rl 25 <l ol
3. | Big_office.bmp > | bmp J3udl AIBuUA g WA 90l
4. | Big_templebmp | > | bmp a3ul iRl 35 W ©{l
5. | Main.html > | o wurl sofl Al HTML 53 §15a, 2= & HTML #8a

WA v uA A Q@wum
6. | Big_officehtml | > | 2Ba-N As DA ol wdAN HIML -l s18a
7.| Big_templehtml | > | iR+l s DA ol WA HTML sl s16e

Wy, WAl df J2ells ay AUl sollall Gl nuct s30 whl. il sollvdl wsiAda (thumbnail)
adlF ua AWmvadl 2d 8, I ad dsA ugla dNscddl wudl il ollall y (Sus
KA AR eis ool Al [Qgd (daa wueeil NA) sugf drs eR1 o

Image Map

wuot-lL Reuoui, v sefl WA As Qe (Riws) £f, Ws o e9oll i Wl AR s uaL Asy
8. wdl eds N@ el yel sy g MEA &3 B, Ws o esollul Asell ay B si-iadl WL
goollefl e Vs sl Ay (Fas 53 sy dal R AR Sl U, vl e35 WA ‘dle WL’ (Hot
spot) s8ald. g AL 3, aR]l WA qwdle LA (SR ARA), wle I (WA Hia), HRz,
WaaHas v wBAwMs eunus Fal [ARY @l suladl AS RadiAl sl 8. L eds WA
GuR Rl ARl ([Ars) orudl ufla. GergRBl dadld, el 2w Gu v Wq A ([aws)
alsdl agdl ¥ 2wurd R RAA R YAl WAl dg 4 wnu. 2 Ad Be suda dsidde
Jedls 9121, WA, HR: AA-) 2 SRer 27 HRIY 3l A udidl as & W+ Rwed- ual
galdl a3, A il WA seid AS «sal (WA 3, @Rl Asdl) QU dl sl dzals neAl(danrld,
HERY Al Al ) ‘iz w2’ oudl asa. wl AT alk sua 48 dle wle wr s s
AR «id dalda vl wsy.

s 3740 ewldel ool wud AL ool s dRR, s Hwdlu AP, s wle 3w, s
wBAAMEEN Hus i By YRAANAS B, B0 Guoll kel “sll Wa, . ot wal” wA “sll Adiw
WAl elliel 6 oUWl YR WA B, 2L WAY Usiel WA ol Rl U FAR s B, Wed 3,
Ul el el [BRR U Ald WLl olseul B, UG Rl WAL ¥ UL UL AL dsacl
A oy ‘dle w2’ 42 8. ¢l Wiz M2l vl W vy Al dal ASH, Fell Guadalsdl vuaslel
Au el 93 ¥ Al R Bas 43wl weuw de Wl wdie Ranl i BURA vl
Gulatsall dsells uddl. aymi, ol Adl R 27 sadl &l ASH 3, 2udl oo [ dle A2 6w
Fas Rall Guddisdld wie sda oow QA Rgd WRA euladl 44l doldy de ad wawi
»qdl. GeldRel a3 ru gl 37340 ealdel eosll suGaui eufay el Gusisdld “click on temple
to know more..." ¥dl ALa sicidl Asiy, e9ofl ol sl Aoy “Sla Bulad 2a’+) GuEaL &3
25 3740 ealen ool w90l QWR 43 A A city.bmp Ad, - 2u4,

HTMLHL t9olladly] caqranus 47



/@ /Police Stationﬂ\

o
Central & .
Mall 7 = g
T
el
Fire Brigade, 7 Temple

| v 4

augll 3.7 : adru vimrd fw

dlz adlerl e ool Gua<ll ool don vRlell x 27 y WANINA (co-ordinates) Wl sulaqiyi
219 B, 2 Ulawiusd o Ad GuAdHl Aanl wd &

o diz wle s 2widal 8 A salda
o [Rus wgd Guadsdl gl Y3l wsami 2da YRsAA AvqqL.

Guaoisdl oy, sUGoR Gudlsdlll Fas wRrsuAA W]l 512 & A Guilasdld culda And Sy
W 4 u B. 3 W2 Image 2940 usemap R4 WA <map> WA <area> 23l GuUAPML Ay
®. map 237 name M) s el u B, name ARHAAl BFHd usemap @Al Bua wd
wadl el «ldq Gelgw il

<img sre="city.bmp" width="700" height="600" alt="city" usemap="#roadmap">

Wl "#roadmap" W WL 6irldel usemaprll W25 UH B, <map> A </map> 3l
g ¥l ¥z WRMMA u dud AeiRd Ae (Rs) ealaa-dl du B, wdl 4R wRsiud
(518, 378, 70) 8 A A adusik B. WA U WURAA map 220 LA Yool wal @ wdlL.
<map name="roadmap">
<area shape="circle" coords="518,378,70" alt="Temple" href=""Temple.html">

<!-- —About co-ordinates of other hot spots --—————- -- >
</map>

GuAsd HTML Roewll ol il wla A-2URA0 sugla 3.740 eulde citybmp s 4R
Y 52 V. R aduusi eulay e df shapel Bad wwud "circle” il 8. WA 3, :NRR
dorR s edladld dld dl shape <l Bid di3 "rect” @viq W, area 231 gL Rkl WsR

48 5323 wtUA : 10



salain A o33l B, circle, rectangle ¥ polygon 3 W R B, d6AA rect gl ada circle
gl ¥R ogdlRl poly gl salaid B, A sied Y3 UM ¥4 3, rectangle wel Gl daw B,
ofel el AN WA area 217 adldd 1A Gelgwl il

o <area shape="poly" coords="32,301,183,301,239,352,188,399,32,399"
alt="Central Mall" href="CentralMalLhtml">

e <area shape="rect" coords—"32,432,233,532" alt="Fire Brigade"
href="FireBrigade.html">

e <area shape='circle" coords="518,378,70" alt="Temple"
href="Temple.htm]'>

sl 3.740 eulda uda-u evurl Gudal 53 $A% WY (Image map) QUIR 4l HR-L ¥yl HTML
51, sl-(aRL 3640 euladl B,

<html>

<body>

<p>Click on the location presented on map to look in detail:</p>
<l-- >

<img src="city.bmp" width="696" height="593" alt="Map" usemap="#roadmap">

<I-- >

<map name="roadmap">

<area shape="rect" coords="46,37,219,141" alt="Office" href="Office.html">

<area shape="rect" coords="407,38,632,142" alt="Police Station" href="PoliceStation.html|">

<area shape="poly" coords="32,301,183,301,239,352,188,399,32,399" alt="Central Mall"
href="CentralMall.html">

<area shape="rect" coords="32,432,233,532" alt="Fire Brigade" href="FireBrigade.html">

<area shape="circle" coords="518,378,70" alt="Temple" href="Temple.html">

</map>

<!-- >

</body>

a-[@kéa 3.6 - image map w2t HTML £
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ouGHRAL £18 (ARRDL 3.64 uRewn wugl 3840 ealon yusid Buud:

© © ® Mozilla Firefox

File Edit View History Bookmarks Tools Help
| o g} | | file:/fhome/pss/Desktop/image Map/image Map Main v | *§ v | L

[ Most Visited v [§|Getting Started [§Latest Headlines v

[o| file:/ffhome/ps...ap%20Main.html o v

Click on the location presented on map to look in detail:

(¢ 1)

Office Police Station

«===« Shri MK Gandhi Road ------

1
oo
-
]
Ceateal Mall =
e
7]
=
£ Templ
emple
| Fire Brigade "?

Done

ugld 3.8 : suborui SAx Ay

13 il gl 3.840 ealda iRl admusiz ofl U [Ris 528 U diA R RA Ratdl safadl 4a
el WR & i vuad. {RR- [@91d) 2 scdl #ird 515 euladl gl 3.9 gl

2 © 6® Temple - Mozilla Firefox

File Edit View History Bookmarks Tools Help

| @ o | file://fnome/pss/Desktop/image Map/Temple.html v| 2w

[& Most Visited v |@| Getting Started [G}Latest Headlines v

[l Temple ] v

| Gt Big Temale |
1

About the temple

The temple shown in the above lmage is very famous "Sayv Dharma Mandir” located at the
center of the clty. The temple is Arst In its kind and consecrated various idols of God and
Goddesses along with photographs of various religion and nature. People from all religion come
1o visit this temple from every cormer of the world.

How to reach

The temple )s 2 km. away from main bus stand and the rallway station of the city. you may take
city bus or auto to reach the temple. On foot It will take 15 minutes from the rallway station.

Done
w39 : dRA Radl
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sig 3.940 salda Ay o-ddal w2 -0l ¥R W A A, AR 3.7 euld B

<htmb>
<head> <title> Temple </title> </head>

<body>
<center>
<img src="Temple.gif" align="middle"> </img>
</center>

<!-- -

<h1> <font color="blue">About the temple </font> </h1>
<p align="justify"™> <b>
The temple shown in the above image is very famous "Sarv Dharma Mandir"
located at the center of the city. The temple is first in its kind and
consecrated various idols of God and Goddesses along with photographs
of various religion and nature. People from all religion come to visit
this temple from every corner of the world.

<b>
<p>

<l >
<hl> <font color="blue"> How to reach </font> </hl>

<p align =justify> <b>
The temple is 2 km. away from main bus stand and the railway station of the city.
you may take city bus or auto to reach the temple. On foot it will take 15 minutes

from the railway station.

s{alEa 3.7 @ Rl Qadl w2 A3

B o Ad, a $3A30 (Office.html), WRIMHAS (PoliceStation.html), AFWAUs e0 (FireBrigade.html)
¥ A4 Hld (CentralMallhtml) W2 HTML $156l duir s3) a8l ol o siSdl ada A s &2
8 d iR €l A 2ol 1dad AU Rt saladl yuu HTML siSasidl Fas s394 dasll wda
&3] il

HTMLHL t9olladly] caqranus 51



W@fiRu sda sl

HTML tldadi s 2ol Gudlol 39 12 salen wwd R duwy RW sidad Aslid
53 sy B

<a href="food.mp4"> follow this recipe and enjoy delicious food...! </a>

sl A suldd Gele@Hi "food.mpd” -l s YAl (movie) §15d V. ddl WA ua
dRY ydl 4154 dur &dl ASH. Gudasdl swl derdder w salade "Enjoy this... !" UsE
W By R0 Al 4oy Agedwil RN 518 calad. A Gedw suddl ydl sida wd dnusde
3 vivy 200 ¢ d) e A Gualowsdll szl Risedl U saas -2z sifa ddld dsigawai
slad, Ydl el wHa sdl avid A 3R] Alg2d A8l 1A d), sUGHR dHA 5YeR wiYalL He2rA2
vl As(@s As2dl ude sl yal,

HTML Sl @M sifed Glaal e Gewdal A xla 8:
<a href="song.mp3"> Enjoy this song...! </a>

mov 515a 13U Buid RN 518a W2 v s15a 1) yaL . Wil sl WU Lavi, .wmv,
.mpg Yl .mpeg, v .swf Bl sy, AL J2dis s1Saxl vue sal w2 R34 @y WAL
KRal ¥3: W 8.

TEIL

L wseml Wud HTML exidadi t9ofld 3dl dd Gl d v, HTML scidori w15 %
ay eell G Guaid align, hspace 4 vspace ¥l Sl Guldl &7l woflalld Al w2
3l Ad alsadl d el 2uwEl lu, ool iz wlie 3dl A siiadl d uel 28 ANy, Wl
Vs el elld o Adl aed, ol RRAY ol (F & ollollas «As2) image map AlalRisdl-)
Guadlol 430 el el dsidwvl WA M wad A WA HME ¢y ¥iddl, HTML W @[
A IR0 e 3l Ad Gladl A AL uRA ust Andl, 20 usdl 2uval ddl R
Gudol 43, Rendl HTML €dldosil Wal A vl A sisqsl % %Y sdi v sed
d dsidenil dIRY, AFAAA, o)l wa QRY AFEA ABUR—G $2el W2 Y8l &AM el

eNUU
HTML tdidodil 9o{lvla 3dl dld Gl asiu d oy Gelgel wdld uuandl.
HTML-lL image edt-u QARY medl w2 gs <l avll.
dzadlel eyvar 2w, HTMLHL s6(ln 3l fd dleadle ol Qs Guadal &3 sy A 2l
Image map U 2% ~l4 vl
{0 sl w2 wldal Rusednidl Qou [Rser wie 1 aw sl
(1) HTML gwdonii RN 518 Gl <A1 U4l 40 22 Guala Aaqin & 7

(a) img (b) image (©) href @ ime

thh R W N e
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(2) image ¥RAA-2 2] el (line break sdl) i, 2u (A4l s UA dervicusl vud S ?
(8) lAeld Sy (b SHas- s
(€) 2WGed Sy (d) odes SN

(3) DAl s -y eofl s azw B ?

(a) Img (b) Move () Mp3 (d Png
(4) wud v ool alt el Gudol sAg R QAuniell 5 wuvani wad ?

(a) AsfAs agld (b) Alt 4 cusd w
(c) As(As well (@ Asl@s HTML 2Aqa
(5) QAuniell 20 Rl solldl GRS A udousdl Bad Rsdadi sald & 7
(a) Img src (b) Height ¥ width
() Hud V (d) 2udal 8§ usl

(6) «NArmie]l s - eoll @z <l ?

(2) Imv (b) Png (c) Bmp @ Gif

(7) wfl 960 ARl (Ries) iy etfaar QA-midl s v Gudal Adiy ) ?
(2) €2 W2 da el (b) ¥z 252
(¢) uBy Aqa (AR [-s) (d) wdal 48 gl

(8) 0AMifl Image mapt A WA su S ?
(a) gstrielR suy A Gualosdl ouy (®) udR oY ¥R s ouy
() Awdl Uy A YA Ul (Wenyur) ouy (d) wlal sy

(9) image map Gl w2 (Al 5§ 200 Guaoil Qain & ?
(a) Image name (b) Htemp () Map @ Al

WAl ey

1. useldl 58 [@RAL 3,140 ada GewsaA wid dl d Asd2, Yo Ad) xA 2uSBi-ll ofl
ol 8. HTML $1q 2 3l 2001 auiz) & gl ol dd dlsde-l sefl 42 [Fis s dl d aud
Yisde RA) WRA YAddl al HTML il ¥ @ 2y, ad Alsdezdl dldl ay wofl, dlsde
R dedls eslsd), dlsdexl Slagia 2 83 Alsde s-iaalidl AR (RAM) uel GA a4,

A il ysi Al ool v (Beiy 5. dl d daid Yo Aal @A) ay 2uRdl sudd HTML wei
R 4 wd. A ¥ Ad, A ad sl 90l w2 Fus A dl A dud QR4 B aslaal

Aql HTML Wil ¥R 48 %9,
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2. Indexhtml e Wef AuRR 4. ¢l neldl A2 exdli\(personalities)dl el 96l 3s. 2w
Sl A dousu Rias, Quisl, daul B, Vdldlal €S 3. v Buid GuAsd ARY afSavil-l
ol 21 seefl eooll A Qu-it QA ay uRdl dudad AR doldyr we otridl. Index
wel v+l eds Ul ollvll uR AL Ad Ase ([As) sNsdl T Fel wde sde Al Ayel
WRA Haddl irl YR dS nd, AAY -l ool Wl ddl AR el Aaw (Rs) sal v,

(Hint : ol AR KR4l <a> ARA-2 GA, A <a> ARA-2~lL hrof ARl HAL 9oll
AN YAL.)

3. QUL gdoiv 9a (family tree) AUIR s, GURAsd NaH Gelgai AUl s AU Gyl
S iRl slel A eldldll g sRdl ay sollull WA A6ASy duiR LR A WAl U R
Ad QuR sA 3 Ffl adl 2wl ddRL eleil ool W By R, Al )l ay Wild ool
A «qd ey eulaw,

4. vl wserd yul sl oo udeg me, RAR, Rt 3y sl image map duwR S

5. 22 dadl GIAA ws 23 dd dUR 439 wd dsiRude Wws2 YA LU P AslSy W
ddl il wonddl @il 4sl

6. 59 cwd dIRY 1Sl Gualal 5 A dd dsUSnril WA R dl @Asazl dd dwll
Wolda Al v A5 WhA gl A5 R0 S5 AW 5 AN 2wl A AeAdwnl wAe
s 4,
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ulgl] oadzau-

WRA Y sl avid, el auid »uud QRN mad-madl Yasl yel Y KAl ¥z wd du
8. vl Yeruld F5 WA WDl @uidll sed WAL YEL YEL el s AL AR & Al R
el w3l Y KR A 8. yald s Ad Y KAl WEudd wWeddi awR)l Wy & A
d dlus QR B AHFAUHl WRAdl 6l B,

dl wel, s GeldW AT, U ddl Yl wys LA vidledl Susdl dla U AW A we
vl oR W B, 2wl 4.1 2l Jeels aqail wu Ad wel cald B, ¥ wdlel s wdl
auid dd wa wdl wd 6L

Items to be purchased
o Chocolates
¢ Notebook
o Practice book
o Ballpen
e Markers

augla 4.1 : weld Gewsa
HTML 1€l 4neid 218l 1s12 9: (1) $401g Y€l (ordered list), (2) x1$Mis WEL (unordered list) 27 (3)
qelrilcs Ul€l (descriptive list). Bl dHIM U1 2L WS HUDLYL icldl Reusdai yddaiui wida 8,
w40y wél (Unordered List)
gl 4.130 ealou yorol, wsBLs weliL 58 Rie a3 wel- el ealau 8. su Rad ‘4de’ (bullet) ual
58 8. 2l 4.1 ealda el A ojd2 d? ‘o’ WA sfis wel B, HTMLAL us61s wWel dur s2al

W2 <ul> 29 </ul> 291l AL QUL Ay B, wEledl As wedl s 838 Yol <li> A </li> 2ol Al
A salay B, My Wel A sl HTML Gergwe S3-RREa 4.140 calda 8,

<htmb>
<!-- -
<body>
<font color ="Blue">
<h1>An Unordered List:</h1>
<ffont>
<1-- -
<>
<font size="6">

HTMLA wé] 2 snesdl Gualol 55



<i>Chocolates</1i>
<1>Notebook</1>
<li>Practice book</li>

<li> Ball pen </li>
<li>Markers </Ii>

<!-- -—->

A3-ARE 4.1 : wsls wd

SciTE ARzl S-faR2oL 4.14] ealda A adu 4309 UGl d uReus sl A wRRLA
wolgol gl 4240 ealon yaor Bwid,

© @ ©® Mozilla Firefox

File Edit View History Bookmarks Tools Help

c a ®| | file://fhome/pss/Desktop/e3Lhtml v| @y |Google &

[ Most Visited v (| Getting Started [ELatest Headlines v

o| file:f/ome/pss/Desktop/e31.html & v

An Unordered List:

. Chocolates

. Notebook

. Practice book
. Ball pen

. Markers

Done

vugld 42 : suborul wisfs weél

sz tgadl

A A eRe A Aad ode dild A 8. ug A sl 2 Ra seag U d), AR type sl
il Gualal sl W, ojdz- ARAY wsdMl eide ada, viell adu (disc) 1 Dy S ud. (A
Gelgart oil:

<ul type="square">

56 $1Y22- MU : 10



o2 dd wudl N Rad Guadldl sal w2 wwud Ay 2oL aul wlLl:

<ul type="circle'">
SRR 4.0 wlal HTML s siedld arusdl g€l ¥€l Aa-dl sdeq uadlsd s
o2 aar-dl el

A A5 Bl Al wdbid yeell won AS ual Anddl 0d2 A ealain dq Suoa A d), i
<d> ¥ </dl> ) Gudal s agldiaws wel dwr A whl wdl, ‘dI' A description listd ¢4
A 9, adlricis weldl e AR 3el Y sal WU 635 Aal Yan <dt> A </dt> 29tk
Gualal sl W3, ¥2d 3, ye adld Chocolate ealadl w2 1A yaor 200 @vil s

<db>
<dt> Chocolates </dt>
<fdl>

Auiy qufl, V2R3 saladl 12 WD airidg 231 <dd> A </dd> Uudl AdlAL Gudal s3] A,
vzd 3, U Asdz WA 2wl ARY andl GAA wdll 2l 4.3 daldemi gel o€l Mardl
e~ Guula eald .

© ® @ Mozilla Firefox

File Edit View History Bookmarks Jools Help

C 6;’5 (@] | file:///fhome/pss/Desktop/screens 24jlyfed2.ntml ¥ qv| ) ..
B3 Most Visited v [g|Getting Started [}Latest Headlines v

o file:/ifhome/ps...%20jly/ed42.html = v

An unordered list in various formats:
An unordered List in default bullets:

+ Chocolates
» Jce-creams

An unordered List in unfilled circle bullets:

o Chocolates
o Jcecreams

An unordered list in square bullets:

= Chocolates
= lce-creams

A descriptive list without bullets:

Chocolates t
Fruit and nuts

gl 43 : gdzu gal gEL UNA
sgld 43 ¥q wReun sulaal w2t HTML S8 s-{aR@a 4240 eulde B.

<html>
<body>
<font color ="Brown">
<h1>An Unordered List in various formats: <hl>

<!-- >

HTMLA @] »a stresdl Gualat 57



<font color ="Blue">  <h1>An unordered List in default bullets: </h1> </font>
<>
<font size="6">
<>
<li>Chocolates  </li>
<li>Ice-creams  </li>
<b>
</font>
)} >
<)-- -—>
<font color ="Blue"> <h1>An unordered List in unfilled circle bullets: </h1> </font>
<ul type="circle'">
<font size="6">
<>
<li>Chocolates  </li>
<li>Ice-creams  </li>
</b>
</font>
<>
<!-- ->
<font color ="Blue"> <hl>An unordered list in square bullets: </h1> </font>
<ul type="square">
<font size="6">
<>
<li>Chocolates  </li>
<li>Ice-creams  </li>
<li>Dry fruits </li>
<b>
</font>
<>
<l-- -
<font color ="Blue">
<h1>A descriptive list without bullets: </h1>
</font>
<d>
<font size="6">
<>
<dt>Chocolates </dt>
<dd> Dark </dd>
<dd> Fruit and nuts </dd>
<dd> Milk </dd>
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<dt>Ice-creams <fdt>

<dd> Vanilla </dd>
<dd> Chocolate chips </dd>
<dt>Dry fruits  </dt>
<dd> Almonds </dd>
<dd> Cashew nuts </dd>
<b>
</font>
</d>
<1-- ->
</body>
</htmbP>
As-aRea 42 : RRY wsr-dl odza we-w HTML 43
weld Hey

el Had, wwnal W2 WA F5d <lh> 2ol Gudlal sl W, acufs Ad ¥, vay wedl
udal o viaq ASH, W, <li> ud </1i> 2o+l Al @vidl udal o Hud o3 vum WA <lh>
2ol Gualal sadl Wy, {lA wla Gelgel il :

<lh> My Shopping List </h>
$Hblg el

soig WER o d2uq sied £31 eulddl wisd 3 A HRAAdL Yerl €14 . HTML i 2udl su6ig uigl
sirilqel W2 <ol> uiel </ol> &dlell GuloL Ay B, ¢dNAAl 3 UEIUIAL €35 el <li> A <> 23l
a2 w4l ealay . suoig wEL oiiag HTML Gelgwn S-luREaL 4.34) eulda 8.

<html>
<body>
<font color ="Blue">
<hl1>An ordered list: </h1>
</font>
<1-- >
<ol >
<font size="6">
<b>
<li>Chocolates  </li>
<li>Ice-creams </li>
<li>Dry fruits </li>
</b>
</font>
</ol>
<!-- -
</body>
</htm[>

f3-[aREN 43 : susg wEl W2 HTML 538
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SRR 434 wRaun susld 4440 salda 8.
2 © 0 Mozilla Firefox

File Edit View History Bookmarks Tools Help

c ﬁf\ | | file:/fhome/pss/Desktopje33.html v 2§ v k!

B Most Visitedv g/ Getting Started [5j]Latest Headlines v

o/ file:/ffhome/pss/Desktop/e33.html % v

An ordered list:

1. Chocolates
2. Ice-creams
3. Dry fruits

Done

2ugld 44 : suog wel

A Ad, sHsg dEl dul s34 1l w3 Wy B, ad A Su) dl S AU su Asyell u@
wel 43 530 a8l W %, il wdli wdal el w3vid si 64l sl o dl ad QA ealon
Yo <oP> 29l wA start oAl Gular s wdl.

<ol start ="6">
si 6l WEll azvud KA W2 HA-RREA 4330 Wl HTML $lsd JHRL
vaRsd quadl susg wel

il o, wUD s1 eulda iy yuarl ‘A, B, 'C' vdl ‘2, B, 'c. S s visH)
wa Gudlel g9l adlA. sud <ol> 2ol WA type @t Gulal sAA s wsmu. 6 4.1 type
gamd Wl asy Bud 3y 8K 8.

Gud qeir
1 s

A e Wl youad
a dew i ymad
I Aus H2L A

i At sl 28l

s 4.1 : Type yauddl (Bud

S-RRRAL 4441 HTML A< wuadi wdd 8, 2 S8 s videw yoma widdl ua s s34 104
A3 dqdl AL i A AN 0L susg Welpll 9 W
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<htmb>

<body>

<font color ="Blue">
<h1>An ordered list: </h1>

</font>

<l-- -

<font size="6">

<b>
<ol type=A>
<li>Chocolates </1i>
<li>Ice-creams  </li>
<li>Dry fruits <>
</ob>

</b>

</font>

<!-- -

<font size="6">

<b>
<ol type="i' start="10">
<li>Chocolates </1i>
<li>Ice-creams  </lIi>
<li>Dry fruits </li>

</o>

<b>

</font>

<{-- -

<body>
<himl>

S{a@Ea 4.4 : od2 add Au A A W2 HTML 53

HTML 88 4.4 uRsud sl 4.540 2unaii 20da 8. 3 fld ¢l type el gel ¥l Bud
UA Yact &4 wf sl

2 &® Mozilla Firefox

File Edit View History Bookmarks Tools Heip
| & 'ﬁ\ 0| | file:ifhome/pss/Desktop/ed5.html v
fm Most Visited ¥ @) Getting Staited  EijLatest Headlines v

0| file:iihome/pss/Desktopled5.html 5

An ordered list:

A. Chocolates
B. Ice-creams
C. Dry fruits

X. Chocolates
xi. Ice-creams
<ii. Dry fruits

Dane

2ugld 45 : e yuad WA Axd AN wdd sue we

HTMLA weél 3 stesdl Guala 61



AR wel

S Vs weldiy aoll oy wel wwadl W ddl uet 3Rud QU B, v WEld AR v A28
el 58 . adfl, via BRuul nan Wl . A 2ie Wl ofle weld wsa el g€l ua S .

GelgwIzw HTML £18 2 s-laRaL 4.541 2ule 8.

<html>
<body>
<font color ="Blue">
<hl1>An ordered list: </h1>
</font>
<l--

<ul >
<font size= "6 ">
<b>
<li>Chocolates  </li>

<font size= "4">

<ol type="a">
<li> Dark chocolates </1i>
<li> Fruit and nuts Dark </li>
</ol>
</font>
<!-- -

<li>Ice-creams </li>
<ol type=" a™>

<font size="4">

<li> Venilla </li>
<li> Chocolate chips </li>
</font>

</ol>

<)--

<b>

</font>

<ful>

</body>

</html>

s3-[alEa 45 @ AR wél WL HTML 548

AR 454 R vl 4.640 eulda 8.
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® ® ® Mozilla Firefox

File Edit View History Bookmarks Tools Help

G @ o | file://fhome/pss/Desktop/eds.html v 4| A

fi Most Visited v @ Getting Started [ Latest Headlines v

o file://fhome/pss/Desktop/e4s.html o v

An ordered list:

. Chocolates

a. Dark chocolates
b. Fruit and nuts Dark

. Ice-creams

a. Venilla
b. Chocolate chips

Done

usld 4.6 : HTML® =28 wel

anuan ay cuaviid dd 2y s 4 dal uwani v 8. WAl s uasd shes s 8. 1Ak
Beus. HTMLMI Sles 3y 53 8.

HTMLM $bes cudzanq

WRAM Qou @3U 1Y2ud UL 2 GuAldl AL HRAdL 8 8. 4 dd A wElu Bad
AL 552U 213N wudg u Al seunil 531 sl L (RN @l 8L Y Sl dAuRL JRIusLs(usalle)s
4?7 d vl 4740 euled Fll wA Al A add aldl w2 AHAUD vEd W A el 9y Wl
woll @ Adl ¥ Adl 6@ ay Any @il u & GuRid, At gL WRA g vidued ugl
ud wmu Bdy sq.

Modern School Affiliated to Star Education, Gujarat Mr. Arvind B Patel Seat No 123
March 2013 Subjects: English, Gujarati, Science, Maths, SS*

Internal Marks (40): 20, 30, 25, 35, 25 External Marks (60): 35, 32, 48, 40, 35
Class: First Class SS*: Social Science

2usld 4.7 : @ARA ws-U Juvcsd Geisam

ad, vigld 4.8 ol 2elldl DA o dul A dudel Adl wousd A, Renelld v, adu,
Rl 8L A wRRun wewd twud wd 8.

HTML wé] #id st2s Gudlol 63



Modern School

Affiliated to Star Education, Gujarat

Mr. Arvind B Patel Seat No 123 March 2013
Subject: English Gujarati Science Maths S8 *
Internal Marks (40): 20 30 25 35 25
External Marks (60): 35 32 48 40 35

Class: First class

SS#*: Social Science

2ugld 48 : WU |WIUU YAUASL Ayl

WRAAD YFBrd J[ud U2 HTMLAL Sres ay sidasy 8. sesil vidiv) a3zl suRdl 2y
wy B, dAiRL ARladl ABdds) w2 sl al Qe A 28l vl 4Riadl @RRre Aauel awll
gl N o dd, sresil WRAA GQell A 2l €k @3 Y 430 wsu. ¢d ugll @Asuani HTML
&l Gudldl gL Aol u 3dl A As e Sy caldl asia A qelaari sual 8. A ud,
shesd ABA sl eds 2R RQddar ASY,

B Al Snesd uFn

HTMLHL §1%% QulR $dL <table> ¥Rl </table> 29l Gualal iy &, ¥ed 3, stesll u3vld v
dd A 2 A 2 g sulud B, <table> A <fable> 2ol 4zl W s s, Sresdl
B, ses w2 Goll wAd 2dl Ao Far @l Gudal s wdlal,

shesd quy, duiRl Glofl gk A wdl ¢AW AU Alsad B, Sresil wd ¢Am <> L gRL
galadidi 20d B, Sesl uud 3l A Han -l du B, ¥ <th> 23 g sald S, 3 -l
eudll 3Udl AN <td> 291 gl elvid, sl 29 B, A-RIRZ0L 4.6 od), ¥l Gers@mzu HTML 518
calaqi »uda 8,

<html>
<body>
<h1>My First Table </h1>
<p>My first table is as follows.</p>
<table border="2">
<tr>
<td> This is Row 1, Column 1 </d>
<td> This is Row 1, Column 2 <Ad>
<fr>
<tr>
<td> This is Row 2, Column 1 </td>
<td> This is Row 2, Column 2 </d>
<ftr>
</table>
</body>
</html>

SHs{alREa 4.6 : wel 2014 W24 HTML 238
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dfl dMRl AR 2L 8¢ avlld suGoRUl URRM AS 29 suGrl Al uRBsun sugla 4.9
¥q Aal Hadl.

2 ® ® Mozilla Firefox

File Edit View History Bookmarks Tools Help

[ @ l@| | file:fifnome/pss/Desktop/e47.html v| v | %
[ Most Visited v [ Getting Started [5]Latest Headlines v

o filesf//nome/pss/Desktop/ed7.html = v

My First Table

My first table is as follows.

This is Row 1, Column 1 This is Row 1, Column 2
This is Row 2, Column 1 [This is Row 2, Column 2

Done

usld 4.9 : Sy W sulwda A5 W HTML Hes

A-RZa 460 salda HTML A& L opatsil 2 ool 0l table 201+l Gudlol &3 B, Table
2ol vigx Gualoil daida wan @l Wd ¥ 2 Msda sedl Brudl sulaal W2 border datnl
8. sresul A ugl <tr> 29 WA Al Qo a2 B, sl 4940 culde fres A wd
AN B, AW w2 <tr> &l A Al Gualal aAdl W,

A AUl wig: <td> 2ol Heedl Goll A @rwRd K] Asw B, v GersRRHL BGuLL
dade 23 wd Rl aul 2 useil ugdlell sail wda B, Geswl Gea shesell WA
Gell 2 2ud A el W2 B, B WsRl @Aend sl wRdl (grid type) a3 ua
otiaHl 2 B, dl wd), s Wedl 2wy 2ol Ad QAgd wRd Aadl,

Table 231 i dil A4l

Avesd ovMd sl w2 GuAlal Adidl uad 3oL B table 201 ®. <table> 2000 uRu Ritpil
wudl asu B, Axisl dedls vasd v wARd <l W 3, AW odl dd WA Aul L. 2
Rl fres 424l ealada B,

align 2 ol stesdl olsasll w2 Guddll 8.
bgcolor 2 o] sl OlsaBeg 0L suold aRud B,
border 2w ot fresdl Budl outd omud 8.
cellpadding wirldl W (edges of cell) il Wil el R a2 asgl sul
yasiell ool el 2 Rl gL wgudl usy .

cellspacing 2 o sesrl €35 vl @2 Jedl aoul Awdl 4 weud 8.
dir 2 o dresul edlad @wurdl Ran sl sar we Guadll B,
frame v ot ghesdll Bs ol ouyell Brudld [Fuibia 53 8.
rules 2 el fresell vigrell Beudldl WElad FBa R 8.
summary W el ghes aeld 3% S 8.

width 2L Rl Sresdl ydus dadl Aw<ll d wud 8.

Sres 42 : Table 2o-u ol

HTMLAL wé] 2 snesdl Gualdt 65



AL Gudloil datdl Jeals il A adami »uda S:
Border 43

SRR 4,641 udd Geldwul border Rl Gualal 5304 2 Msde Wl Budl si-uqaim
0 8. vl ot fresll 50 WR sy Ay £3s vilelell AU Bl O3 3. Bendll udous
e 230 w8, Border dpeiyaldl Gulal 54l H0lrid 8. A di sl adld 0 Bud »iual
dl S5 Budl 2oud gl UG A-RIRRAL 4.6:0 GuadL s AuiR sAdd HIML S8 we s
wd), fA enle wud 209 Border yRitpl-l Bua Yl :

<table border="4" align="left">

€9, & Asark sl 2rua sl @l A sl 41040 salen yaor Boudl ASA.

AL §su4l wild Gelgwl 2l Gudloml dlla Bls ay o s61% ddIL A wed) ¢d),
L o] B align. o di AS susiasll <in dltl ? ad seid S 2812 Al Albll du, Ses all
ony Nsadl dNsaell (alignment) siedl. €d dil ses dNsqgll(table alignment)di 3§12 AS wsl.
Y dsqell (alignment) ~{l (Edl ueslell Sy,

2 © 6 Mozilla Firefox

File Edit View History Bookmarks Jools Help

&,;\ ¢| | file://ome/pss/Desktop/e47_1.html v v
B Most Visited v @] Getting Started [ Latest Headlines v

o file://fhome/pss...ktop/ed7_L.html &b v

My First Table

My first table is as follows.

This is Row 1, Column 1 This is Row 1, Column 2
This is Row 2, Column 1 This is Row 2, Column 2

Done

wgld 4.0 : BGuddl viganda Bud wai shes
Bgcolor @l

wd, sresil B 0L YA 2D Sresd ay, 3ofld WA 2ss s-udl, bgeolor e Sves-
sy 301 Asadld sd 53 B, au Rl Bud 51 oid Un AL © AisAd Daidl W
Auir uglarl 58 €18 Uk, dlFdPL dA Fe uleRl Sl sl d HTML 58 (S¢-(aR301 4.641 vuw
oo )l yay eldl YUl

<table border="4" align=""right" bgcolor="yellow">
UGRUL A8 [Fglelld uReun wnAL.
Cellpadding 3|43

o snesel 6 vudl visollonl sugpil sl wd A oAl wWEs quue € d 0 Wik
Gell u wd. o ol vididl W 2 @viRl 92 Yadl wu Adl Qu dl sidd el ebn al

66 £1Y22- WU : 10



Addl 4Ll A Al SR8 ainal asdls wid, ¥ o A, A s vurudl $d Bl gl wA
avual 2 Beudld g &d, dl o airal dsdls udl, 2ual Budi A vieizdai Gl ay aow
(space as padding) AuAUM 2 dl A vusUBNAL QUL QML dndl W,

s2sel 6 vl Bl wAd At @viell 92 o4 oL sl cellpadding detuell Gudlal
sl w9 . cellpadding Rl sresel vl €35 €lad(wall of cell)dl vie-{l sugy #ld
oouiefl dUel (pad) oirtd B. i Rl Gud emadlil wad Rsdan sudl ana «lidd
GeléRel YL

<table border="4" align="center" bgcolor="pink" cellpadding="25">
sl ogd {ld yws dd esl-dl Guadlbl s3I whl:

<table border="4" align="center" bgcolor="pink" cellpadding="20%"">
ddl seln A i ¢ 3, 20 align A bgeolor @l Budl upl sieel 8. Qs cisaida
guan QUG uAsIRAL
Cellspacing ?;Elﬁlﬁ
cellspacing 8], seseil wiiwadl 92 ooyl sl w2 Gudloiil e B, J2el oyl Amdl A
W2+l Bud 25Ul v Rsdenl saldl asu 8. ndl) 2s<u3] A2d resdl eds wiau-l udous-u
251 (A Gelgw yaiL:

<table border="4" align="center" bgcolor="yellow" cellspacing="20%">

uYql

<table border="4" align="center” bgcolor="yellow” cellspacing="25">
Width a4l
width ey Qresdl udous sl s w2 Gudlol dain B, 3 udws 32dl Avdl Al Bua
Ul ¥ RsAari waal Guasy wowdl asiaidlii wyl asy B,

<table border="4" align="center" bgcolor="pink" cellspacing="25" frame="box"

rules=""cols" width="50%">

w9l

<table border="4" align="center" bgcolor="pink" cellspacing="25" frame=""box"

rules=""cols" width—=""50">
Align ﬂ?lil‘li
align ot »udl @Rl 2udel dud vl @uiie A bl 52 8. wel auiridl Fu ¥ Aes
viriefl 2ied aeie gL sl asy B, shes 4.3 align Aatnl W+l asy Bud-l wel 2% 2 3.

Gud Qg

left aviand il diell dRg dllsaaml wd 8. AR @ulel W2 Hl2ieust
o olsaell wa B,

right avian el ds dNsadi 2wd 8.

center aeiel virlel viey wwui olsd B,

justify v 28l quield W Ald ollsacil wud @ 3 el d Bl vl A .

char viidly @il S8 s viaR-dl uun GuRAlA(instance)l wuWRA B SNsad

®.  (Gewgwl adl, Arun) ealn wnqdl e GuRARA a3 ANsau 8.)
sres 43 : align Jand w2 asy Bud

HTML4L wel an fnesd Gurilol 67




A align 32144l BHd char S dl 204l ¢ull viez 2udar Sres-l g5 v aria AS Ag s
war+dl uad GuRARHL 2w s, vial sl sl Dasy iR “43 MR (axis character)
A3 vl 2ud B, L el WAL 20l Al ua” W ARl suin Ra () du B,
aeuRil olsarll #i2 char dld saiy Ra (char=".")-l GualaL salefl vivinl Wl salial Ava)
salen Yool gallal el UL sendl.

1 2 3 . 5 6
4 6 X 1 2 7
<] 8 1 6 4 5 3

table 23 ¥l Q- ol [ vzl Pgd dul sul ugl wel ¢d ugl-i Qoo sresfl 2udl
g HRdAl <tr> 2031 RS

sresdl 2dl ¢ wdl 3

Sresui 2udl e eafaal WP <> 2ol GUAL sl wd B, <> 2ol de: wnadl eis
oitid W o Al W euladl BN, A s 4440 ealon Yo dul aw o@usl ealdl asy,

=L gl

align I € auury 48l sul yoreL dlsay B,

bacolor wie N4 2 ¢dardl slssuss WL oAl 2 B,

valign WL Aol 835 vl avhadl Glofl axiar slsagll saaud, <l 8 B,

8n2s 44 : <tr> Zadl Ayl
dl wd), ¢d ASA k 2w Rl HTML Q& Gudat 3l dld 53 asa.
Align QLElEl.ﬁ.
align deil 3udl Ao ot vidiNi-e quua 2 euld 8. Align dpaeld e 2@azy {1
Yoo, 8 :
ign="alignment"

align @il Bud adld fres 4340 eulen 3ol left, right, center, justify 247l char W4+l s
A8 a. s Y sl A ua HIML Sai vl @il Gualal $3),

Bgcolor ﬂ,&‘ﬂi

BPIUE Sesil GLsAG=L 301 YRaL WD bgeolor JRitd M), ¥l wud i A @l wua
el Aaigdl A 2l 0 saladl ddl. ¢d A sesdl A s Wl drA A ]l aud]
Sl dl o? &l U weel was B AsA Wi A vEd Fud Aavid S8 WA bgeolor
g, bgeolor gt 2udl ¢m AL 3o slsd B,

sese(l Asiad A 2dl GAUA el el 0L A I01AlL <tr> 391 WA bgeolor AR olg WA
Guall Ay 8. M AR e35 Bl A diadil Wdl e B, BRI 4730 e
HTML 54l GEld8lAl YUt 4R
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<htmP>

<body>

<table border="1">

<tr >
<th>Name of player</th>
<th>Points eamed</th>

<fr>

<tr bgeolor="lightGreen">
<td>Disha</td>
<td>110</td>

<fr>

<tr >
<td>Sweety</td>
<td>100</d>

<fr>

<tr bgeolor="lightGreen">
<td>Gayatri </td>

S3-faREa 4.7 : As ul A% wdl gAMA 2uen elen 3L i WU HTML 58
AR 4.7 uRRun sugla 41130 enfen yoast 2ol

2 ® @ Mozilla Firefox

File Edit View History Bookmarks Tools Help

(e @ 0! | file://fhome/pss/Desktop/ed12.html v (8| -y

{5 Most Visited v (o) Getting Started [ Latest Headlines v

@ file:/fhome/pss...sktop/ed12.html 52 \

Name of player Points earned

DDisha 110
Sweety 100
Gayatri 190
Done

sl 411 : A0 o5~ qAadl wudl Anaw] shes

HTMLui wel 21 sees4l Gualal 69



Valign 32143

Valign 32t 2l ¢darl 835 vl drii-dl Qofl anid slsasll KAl 8l KR B, g (A
yarsiell WAL QLSARUAI(syntax)l GulaL 3R 53 wsd

valign=""position"
ses 4.5, valign d@upl-l sy Badl euld 8.

Bud ael

top auigd, uidl{l 2L ool drg dlsd 8.

middle avietd vl sl ollsd 8.

bottom v vl A drg ollsd B,

bascline avigid W FAd aNsd ] 3, ¥l eis viadivi quiedl uuun dld A
o 2L Adid ]l a3 w.

Ses 4.5 : valign @l w2l wsy Bud

<tr> 23, GElRW : <tr width="150". valign="bottom">, d® WL 42l ¥l & HTML 54l UL &3
avlld UG Ad sl gl S-RRE0L 4.840 wwle HTML S duct 30 il

<htmb>
<body>
<l-- -
<table border="2">
<tr>
<th> </th>
<th> Monday </th>
<th> Tuesday </th>
<th> Wednesday </th>
<th> Thursday </th>
<th> Friday </th>
<th> Saturday </th>
<th> Sunday </th>
<fr>
<!-- -
<tr align="middle"™>
<th> 11 to 12 </th>
<td> Maths <hd>
<td> Science <itd>
<td> Guijarati </td>
<td> Maths </td>
<td> Science </td>
<td> Gujarati </td>
<td> Assembly </td>
<Hr>
</table >
<l-- -
</body>
</htmI>
As{alREa 4.8 : AwuwAs dUR R4 WA HTML 53
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Hs-RRS 4.80 culde A8 A6 Ws adl =2 el ULl & B A oiAd B, A d U
A ouGRul AW A A R 41240 salen yoro Bwd,

2 © @ Mozilla Firefox

File Edit View History Bookmarks Tools Help

@ o| | file://fhome/pss/Desktop/screens 24 jly/e416 v 'l v | |

) Most Visited v [g| Getting Started [§jjLatest Headlines v

o file://fnome/ps...2024%20jly/e416 = = \

'Monday Tuesday Wednesday Thursday | Friday [Saturday| Sunday
111 to 12| Maths | Science | Gujarati | Maths [Science Gujarati |Assembly

Done

sld 412 : HTML £34U Gualdl GRL birtg dHauAs
th N td-ll GuAleL G vuruRldl ‘gud

shesil eds vl <td> vual <th> 231 giRL 9 Y B, 3 A, 3 ol o AS As wd ¢AaA
s oML ReUlBra sadl daed Yl ul 8. A nawg] «sél saaud i dl <th> 29l Gualal
S wd B, awl Awsdl Rad WY Rl QU d <td> 20l Gudlal R wd B,

A, {d, <th> 391wl @rietl H2eus) oled AAAHL, Vil 204 AHidR 1l ledlA ealay B, a2l
<td> 2o1H] WA @UlBL AWMLY 6ol HHAAL vl AHIAR 3160l o1z dNsella) calany B, <th> A <td>
ol 201ui Vg o Ul Rl Guadal uf Ak B, vu op@ul WU Wil Wk o vitel U U, 20 @Al
gL Glofl il HiuR wivl ses W2 53l allsaell e il Guasd 2R F 2 o W2 s3dl Alsaell-l
AR vt goudl 2. <th> A <td> WL gL udl WRR A o il o

ud WA Rl B Yuod Bl @il Rl GURId <th> WA <td> 201 A Qs 4,640
elon yoroen ol va O .

saued gl
abbr wirtdl lRdly g5 azu Y3 wl 8.
align il R szd B,
bgcolor il A6 GAY B,
char il guiei S8 AU waR-dl unn GuRAR-AL dawm dlsd 8.
colspan uli 32al widl Y Brddl w3 A v euid 8.
headers widlel sifd el euld B,
height vl GlRuS -6l 52 8,
nowrap aoietn, il e ¥ WNAA adl s Gud wdl uesid B,
rowspan ui deell wdl ¢ Y Bl ud A v euid 8.
valign wiAd] duitel @oll wMidy oSlsasll s Al 53 .
width il s Asfl 53 8.

Ses 4.6 @ <td> WA <th> Yyl
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FU A YA WRAUL WO aldl ¥ A AH A ¥ el R Rodar vy
Hres U uug

s Al YA W <caption> 23+l GUAWL SAUHL A V. FUR dd Sesell Un WA QS
Qs sres ealdl AUl 2 2ol w32 W B, resd - A suld B 3, s A W2 B; uBRIHA
3q M2, AUUALs W2 udl R Wil 2udu WAL SUEIR  <caption> 2dlell @WIRIA

sl Guarll oL wyl A eald B,

e sicladl A6 wel e HTML el uast dlid-l Gur A yaeidl 1) Rl sresll Gur

"This is our timetable” ¥ £esq -un salad.
<caption> This is our timetable </caption>

S-aREs 49 suld & 3, HTML-u Gualal gt 3dl 7ld uyuusis sieidl asa,

html>
<body>
<table border="2">

<1

<!--

<1--

<caption> <h1> <font color="Brown" >
This is our time table
</font> </hl1> </caption>

<fr>

<th> </th>
<th> Monday </th>
<th> Tuesday </th>

<th> Wednesday </th>

<th> Thursday </th>
<th> Friday </th>
<th> Saturday </th>
<th> Sunday </th>

<\h; a]jgl =l'mjddle">

<Hr>

<th> 11 to 12</th>
<td> Maths</td>
<td> Science </td>
<td> Gujarati</td>
<td> Maths</td>
<td> Science </td>
<td> Gujarati</td>
<td> Assembly </td>

</table>
</body>
</htmD>

AfafEo 49 : sresd uH Gl
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A6 ua sresd A vl AS ust Gudlblsdl W2 ddes wddl ARl WS My B. 2wl
4.13 SRR 4.94 wRmum Y 2 8.

2 ®® Mozilla Firefox

File Edit View History Bookmarks Tools Help
e @ o | file://fhome/pss/Desktop/screens 24 jly/e419.html v v %
[l Most Visited v @] Getting Started [§jLatest Headlines v

ol file://fhome/pss...20jly/e419.html = v

This is our time table

\Monday \T\lesdayFWednesday \Thursday[ Friday \Saturday\ Sunday
/11 to 12| Maths |Science | Gujarati | Maths [Science| Gujarati |Assembly

Done

uigld 413 : un WA sres

oR0R Rl vadlsd 53, ¥ sugl 41340 eulada winuas wyel . Aakd a sy yel
309 A, uRsund vadsd 0 W

sresll 2iex shes

gellarr 2uvad AS Ay shesdl v olly shes Gl ¥R widl QA B, s-[aREaL 4.1040
galda Gelgeal Amesdl »iex fres suld B,

<htmI>

<body>

<-- >
<table border="4">

<caption> <hl1>Conference Activities </h1></caption>

<>

<th> </th>
<th width ="40%"> Morning </th>
<th> Afternoon </th>
<>
<>
<th> Day 1</th>
<td> Inauguration </td>
<td> Key-note Address</td>

<hr>
<{-- >

HTMLML Wl i siesl Gulol 73



<>
<th> Day 2 </th>
<td > Paper Presentations</td>
<>
<table border="1" bgcolor="pink" frame="box" align="right">
<caption> <h3> Inner Table </h3></caption>
<ir >
<th> Teachers</th>
<th> Students </th>
<>
<tr>
<td> Meeting </td>
<td> Quiz </td>
</tr>
</table>
<Ad>
<fr>
</table >
<!-- -
</body>
</htmP>

SsfafEa 4.10 : sresll viex Shes
syl 4.14, H-RRA 4,104 uRrun sald B,

© ©@ ® Mozilla Firefox

File Edit View History Bookmarks Tools Help

[ @ ® | file:///home/pss/Desktop/screens 24 jly/e421.html v| v | L

[ Most Visited v || Getting Started [5]Latest Headlines v

[@) file:/ifnome/pss...20]ly/ed21.htmi = v

Conference Activities

| Moming ! Afternoon
'Day 1 |Inauguration [Key-note Address
Inner Table
Paper
P2Y 2 Presentations Teachers [Students
| [Meeting [Quiz
Done

wugld 4.4 : sresll vie: dnes
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dil el W <lie) o ¢ & viewrd Sesd olsubeg W A Bl B, vieldl duy eldladl Wi
ol Aresq duel A wd ealawi .

srest Gerdam

sl 4.15 Qs Gegem euld B, ad suds dl AY o ¢d A wsua: A ua ¢l cnaaRa
Ul wdedlldl aoflsll wuad SIS umell Weeern A, QA B,

Star Restaurant
Starters Roti and Bread Curries
Item Price Item Price Item Price
Paneer Tikka Dry 100.00 Plain Roti 10.00 Paneer Bhurji 100.00
Panper kabab 100.00 Tandoori Roti 20.00 Mixed Veg 100.00
Drinks Desserts Water
Item Price Item Price Item Price
Tea 20.00 Gulab Jamunp 30.00 Regular -
Coffee 20.00 Rasgulla 35.00 Mineral 15
Koko juicy 25.00 Pudding 40.00 Sparkling 28
Mengo delight 25.00 Ice-cream 50.00
The prices are in Indian rupees
Customers have to pay extra taxes.
Pleaze wait for 20 minutes after ziving order.

wugld 415 @ RAReuw A s

Ss-RuRa 4,11, wisl 4.1540 salaide 3wdrre A 518 AR s W2+l Wi HTML £18 sufd 8.
<html>

<head> <title> Star Restaurant Menu </title> </head>

<body>
<center>
<table width="75%" border="1" bordercolor="#000000" bordercolordark="#000000"
cellspacing="0">
<tr align="center">
<th align="center" colspan="6"> <hl> Star Restaurant </h1></th>
<fr>
<tr>
<td colspan="2" align="center"> <h2> Starters </h2></td>
<td colspan="2" align="center"> <h2>Roti and Bread </h2></td>
<td colspan="2" align="center"> <h2>Curries </h2></td>

HTMLH W) M sines Gualol 75



<td align="center"> <strong> <font color = "Blue" > Item </font> </strong> </td>
<td align—="center"> <strong> <font color = "Blue" > Price </font> </strong> </td>
<td align="center"> <strong> <font color = "Blue" > Item </font> </strong> </td>
<td align—"center"> <strong> <font color = "Blue" > Price </font> </strong> </td>
<td align="center"> <strong> <font color = "Blue" > Item </font> </strong> </td>
<td align="center"> <strong> <font color = "Blue" > Price </font> </strong> </td>
<Ar>
<tr bgcolor="#CCCCCC™>
<td align="center"> <strong> Paneer Tikka Dry </strong> </td>
<td align="center"> 100.00 </td>
<td align="center"> <strong> Plain Roti </strong> </td>
<td align="center"> 10.00 </td>
<td align="center"> <strong> Paneer Bhurji </strong> </td>
<td align="center"> 100.00 </td>

K

<td align="center"> <strong> Paneer Kabab </strong> </td>
<td align="center"> 100.00 </td>
<td align="center"> <strong> Tandoori Roti </strong> </td>
<td align="center"> 20.00 </td>
<td align="center"> <strong> Mixed Veg </strong> </td>
<td align="center"> 100.00 </td>
</r>
<l-- —Remaining part of the table may be completed using similar cede.... -->
<tr align="center">
<td align="center" colspan="6"> The prices are in Indian rupees. <br>
Customers have to pay extra taxes. <br>
Please wait for 20 minutes after giving the order.
</d>
<>
</table>
</center>
</body>
</htmP>

A3-RIREN 4.11 : HTML &hesu Gualol gl 3eRe A sd calag

wdl A Al a3, AR 4.1140 wila HTML 8¢ iR sres sald 8. sl o a4y HTML
58 GAlA Rene(lll Sresll oudl)l onoL Y3l s wd.

SP2-HuA : 10



HTMLHI #4

HTML €2ldodl 330 Guadldl uas Asddyd Aol 50 As o Asddy a3 eulaa =y 9.
54, sUGHR-l A< apll euadHl vual V-l Reulyd 52 8 ¥ els A w4l daudy b
8. sUGHR A<AA vins 4l Reulra 53 sy 8, ¥l all el el HTML 4 adst da Aeudl
WL A A &S 2add (loading) 2 €31 4 wadisi(reloading) sid Asuell AN, UG RAQui
Pl e “34A2” (frameset) dadld WAl wd 8.

wdl A A Al ASA 3, Jeals B A2 AHdA wudl Al FHA2 eldy dUR sdl, Anan
YR <frameset> WRA-2 oi-lqal W, ¥ [ARYN FH-UL AAes dE ARl 2199, FHA2 sUGMR
Rl Qo carsilid s2 D, FHAxl uieR 635 §4 <frame> A <Arame> 291 Q salaqsi »0d 8,

FHde-{l vier, dN <noframes> ARA-2 GAA 218), ¥l w3 GUALLUL Al SUGR FH Aded) AHd-
g Slu AU d Gualoldl 12 As(@s ABA YA uR B, AR 4.1240 2wld Gelgal o,

<htmI>
<head>
<title>Creating example</title>
</head>
<frameset rows="20%,60%,20%">
<frame src="top.html" />
<frame src="main.html" /~>
<frame src="bottom.html" />
<noframes>
<body>
Your browser does not support frames.
</body>
</noframes>
</frameset>
</html>

a3 [@AREa 4.12 : 3 oi-ldal Wi HTML $38

SR 4.1200 suldd HTML 58 @vll 2 A framehtml a3 2AAd L 330 5156l oi-ud)
adl %, top.html, mainhtml e bottomhtml. i HSAM dHR HAue Quie GRRAL AWy did
vl g5l otrudl € 3 uedl v A ouGRul usRl wfA. g, wRewn sl 41640 culon
yooue, Bt il B v Al A 3 dud F wReud A Had A d sifanl i quiel 6
8 dri Wl g udl ud

wi4Q 4.1640dl A viadls LRaApl we) §, suGR [Axl »-L cudl Rewlrd sami wudl 8. [A-d-u
GuR) cwdtL queefl WL WiH 3d ® wA A tophtml Ul HTML §1Se- dvia suld 8. uwy
auolil WSR2 A W2 AE Sres o1l B, e oudl mainhtml UHl HTML 6164 3Rgd ealay 8.
et lou 33 oudel Bs A Ul bottom.html Al HTML &1 *gd ealay 8.
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2 © ® Creating example - Mozilla Firefox

File Edit View History Bookmarks Tools Help

Gy @ || | file:f/fhome/pss/Desktop/screens 25 jly/frame.html AR R L
[ Most Visited v || Getting Started [EjLatest Headlines v

/@| Creating example v

Welcome to the Star Group of Hotels ..........!

Star Restaurant

Starters Roti and Bread Currles
Item Price Item Price Item | Price
Paneer Tikka Dry 100.00 Plain Rotl 10.00 Paneer Bhurji | 100.00
Paneer Kabab 100.00 Tandoori Roti 20.00 Mixed Veg ' 100.00
The prices are in Indian rupees

Customers have Lo pay extra Laxes.
Fl¢ase wait for 20 minutes after giving the crder.

Thanks for visiting ....... !

Done
2ugld 4.16 : HTMLH 3u

wdl B ) %, suGR (A< Glow eudii adudl ueL wsa 8. suBR [@-dd Gen eudnii adual
42 20yl 1A ool Gloll ¢ (cols) A frameset WAA-2)l Gudll 43 wsll

<frameset cols="25%,*25%">
wdl, 2l suGHR R 22 Qe euddl ddualdl Uuel 53¢ B, SR 41240 <frameset
rows="20%,60%,20%"> 5" oigclld <frameset cols="25%,%,25%"> s0 i &3l d- wReus
Fgiaaidl nuet s,
WRAN

2§ WKRERAL, 2R HTML 4 gl v &wesl duiz sadll [ARY Ad A, 2uull el e
sl Wl suslg WEl BRI 2sBis wel vy A, Weldl »ied ol wel Wl oq
Rl B usRMl Wl sl widl, wel Sresl Guld shesdl vie sres oi-ladid yel wugl
vyl 20 sQUL, WML SRS YR BAR Sl JREA] GURd Badl sresll Wl A wA wad
vidibl W2l Rl uRL A

A
1. oy Gewgw wdld adond) & HTML exidoii wel 3l d enuld sami 2d 8,
2. HTMLai RRY wsr-l wel asldl
3. HIMLA weéldl viex wel Gur &s 4 avil,
4

HTMLML Stesil cdRelu- susid &5 -ld qvil,

78 $322- 28N : 10



5, (A0 nadl w2 2wld Rseadyiel Ay Qsey vae s3I0 yus UL

(1)

(4)

(7)

HTMLHL <ul> g g «s8l i 8 ?

(a) wel uigl (b) $g wel

(©) 2wlis wel (d) wWg shes

HTMLAHL <ol> gl «{A-uniell 468 sioid s8]l iy & ?

(a) wel wel (b) $dog wel

(c) uslis wel (d) W Hres

Qeluil RAdA QAuniell 56 200 Wl &2 B ?

(8 <li> A </li> (b) <items> ¥ </items>

(c) <object> A\ </object> (d) <table> wiA </table>

)2y R WEl Y sal HER QAL 5§ 2ol AL Guloi dawn B ?
(a) <ol>u- </ol> (b) <ul>u <ul>

(c) <dt> A </dt> (@ <pt> 3 </pt>

sresl Ll ¢An anala Ral w2 JAanil 5§ ol Al G af wsu ?
() <tr> ¥lA <Ar> b) <td> ¥ <td>

(©) <col> uA </col> (d) <row> ¥ </row>

a3 A6 vite s sl a4y 2ud $AOME RrdRL wig, U el [A-umisl] i) oyl Gualaai
day 8 ?

(a) colspan (b) rowspan

(c) span (d) scope

sUGR R-AA s ol [Aculrd s LAl wel Guala 430 asu ?
(a) Frameset (b) Elements

(c) Layouts (d) Design

A GUGHR framer AMdA <L g U d), Al eled As@s qvua sulaa DA-midl
s Guddpil af wsiy ?

(a) Noframes (b) Yesframe
(c) Falseframe (d) Trueframe
HTML-Al s3olg wel {A-iell sy oedll usin 8 7
() Hewlrl $4 (b) Uda-l s34
(©) 1 W2 ARG WR (d A dxm

(10) HTML $resii il 58 As(@s ousid (entity) & ?

(a) s Wi (Caption) (b) Srest Mwd (Heading)
€) sresll Qoll gAnd deviti (d el
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AR a1

1. adRt Feddl < 2 woudl wdlal Qud Aada go dRl (2s1ddl) ealad ds ses
AW sl HTML £ avil,

2. dil ddRl HA-Ra 2ds 1A adg val-dl i v dadl Rusd avidl Al s, ddg
s w2 adl wal A was) eulag fes Ui Al HTML 518 @uil

3. 2 wsR-L wed Rowsi saulain Yo RS (marksheet) AuiR s2aL HTML $18 avi,

4. A Wl WYL AU R4 MR HTML 58 avil. 20 useel eulda yayuels Fustoll
Qaeil 8l

5. A8 As w@dsu RAHL =2 ddl Guacy JaRoNA ndad dxyr wedd Ad A 2 $hes
AUIR S W2t HTML 518 @il Wil @l 3, dauRl 44l WE@&dsu Rzl o8l 4l 8,
A AU 9 APl ol 1 sl UF 5 A WA AL 9 A W Y W D, Al WA
w W UGN (late night) A 2@ gel el WBBLs cumel YAl Fal s daudl, ofly
WAL @A Ay ded) Guact o B ghesl Bl Bru3u ewia A Yt B eds v
Al wedll- AR U GHAL el S%esn "Regional Movies” g ~Ud wal WL

Timings> 9:00 am 1:00 pm 5:00 pm 9:00 pm
Screen 1

Screen 2

Screen 3 Regional Movies

6. awl ¥ Yorarg wledl U A argal-ll wel duiR sl wedl HTML 518 @), flwdrdadla
el el oudi Reubrd s F3 3, Yadd), wsole A viasdl dol. G A3z guad
oel, & sald B 3 wel 3l Qdl =AY,

List of items to be purchased
L. Books
a. Textbook of science
b. Practice book of maths

¢. Notebook
II. Vegetables
a. Tomatoes
b. Spinach
¢. Peas
IIl. Food items
a. Chocolates
b. Buliter
¢. Bread

&0 £3Y23-vtuA : 10



3l (calc) ® »u-ullBFu we- s Ay By (Sdsgifis Wisellz) Wear B, Bselle (Spreadsheet)
N ws We2dl W & ¥ edcldyril Al 2l a2 SR sl W2 dxy eraldy-ll R
sty dld olsaal w2 (FB12 Rdl) W2 aun 8. GURAA Wy dxy visds d slsadl Bus
SR sdaimi 04 B), vl Wsa2 Yol Gualol -uRifld 210 Rl el Aol @i u-HL RAUAN
dqiR seci, Wsdal el Bad WAl Wl (SrQdn) o], daFs A wisdsly A4 ue
WRA [Qsdum sl dne AR Guz RARY sl aeada Rami uy 8. A wa welle A
32l AN Sl Aril GUR A8l saL duar URAA vy A (ufFsa) Wl sl wud & B,

B2 Wer 214 sl AU (row) i Glell eQn(column)rii @3unl etmd s3ael uRdA(l Wl 8. a3
e S : ARicell 1oAY 5341 HI2 S81 A dHIRL sUIURIAL UL WS-l D2oys & il 28l 6w Qlell
g a3 Flad A i - Gualol sl sdl. Welz A e MR Ay Al BUR AR S0 Wi+
523 Wl GuHl 21dl ¢4 A Qlefl AN A oiell A aioll Alle (RdiR) B. oflay I sl dlL Wsall2
0 315 318 (oll o sitnel) B 3 ¥ Bul-wBAL Na (interactively) J21d, A 24 slan-l Ad dnd- dxay
2l 3 8. w500 AL 2 Wsellz Wdar a1 il SHBareAL Wdlag Guied Yoll elme saal
ol et 20l B, A Fely Adl 32 Guaalsdl Wialleql wininl Ba-nlBZu-l A4 321 e 53 w3,
2 g1z 53l a3 duer 2l GuR ARl [ RsdnR 53] ad B, Guadotsdl-l Rl ua ol Guald udusmi
sulels, -uaiidly, wisdlu A s 514l voL ¥ ucuyFs Fld sa0 HRHAL YL [ [[RE)L Whsalle Lo o
wRre s34l du B, Wallz Warell 21 wsR+l 2178 andlv 518 A2UR (structured) 2L Al 53¢
A dell GUR WBUL 5aL 312 A s [Qaendl WBun ddl3 auuu B, Libre Office Cale [www.libreoffice.org]
W30 A cale F AL B, 2 & Frges i 2Rl Aselle Wer ya S,

adelledl Ul w2 (Beyond a spreadsheet)

4 1 Bdalles] 58 G oiriq 24 B A A dril AU s AU 5B oAl B, Wsallewl atiell st FeaieL
W2 ades(workbook)-ll s vuie MHAM] Ygaui wieil, o fos-l Yoy o Avatein Blalled widl A dua-
Rl 8. astys Guld glgdl vy vidard Dz uel duBiy ol 2 8.

32ais s RARDNN WL3ols Wdar-) Gualol (Typical Applications of Spreadsheet Packages)

WRA Rsdwe dxer A5G0l sldl W2 Wldallz Warsdl aqusud Guadlal Ay &, iy, A Balle
Uy gL SRAUMl 2uddl J2ais [QRe saldl wdl fres 5140 2wy widel 8.

s aglv

Ay (A afle) Ry RARAL YAN wA Al AsiGee $1T20 WRlaAl uaLs

YReu Reaum 2 ARl | udlasil ¥l 3eels Rl uFaundl sweadl, A

Yl¢) sirnadl (#1008 S0sagll) any Beedldl (516 s el 2uURd wRRUH)

wisdflu 1 [AsdNg AL (5420 dNsaell), Jaidl AdRAd AMsasll v Misdsy ugldadsd
MUY, FH & WU (mean), HeURM (median) ix ielaril (probability) 4+l
ARl szl

URAy sl dlrixil €t A1), uorell AR AR Feal iy sl

ol 51l ol alFold dld Fisi (BuiRv), QAN ugRid), gyl i g2
Wl A 33 AS Rasuedl vinar ol gzdl we wdaedl wel
opeueefl

sfves 51 : Wzl dzens walda [QRRLL

sl wRuu 81



Sel WA winl (Getting started with Cale)

A duR o wag AR 3 QA 56 A wdl usy. w2 ¢ sugla 5.1 eulen W
gl el A3 : Applications > Office - OpenOffice.org Spreadsheet

-!'4" Applications Places System

\ Accessories y
oP. Games

43 Graphics

w/ Internet
m::_ M ictizoacy
m Sound & Video ’ Evolution Mail and Calendar

OpenOffice.org Presentation
= un@f‘i"f ‘ﬂ?!‘r'

oy
EPRSETnIS TRty Perform calculation, analyze information
and manage lists in spreadsheets.

ﬁ Ubuntu Software Center

v ..-..nl’l --v‘"

supld 5.0 : 3l W AZvua

L 22 B @AFMYEL grclay vlad ¥ WAl sda 8. Wl nds el adel ] ¥
afalz (worksheet) gl sdaid &, YdFulRa Aa Al Wsallewl A2 adallz i B uat 2uuell ¥3RUd
W Qui dvaeid ddl afdflz GAIL up wnd A g uR s asu B, A5 um el Wl
grclldodl Wddd 256 afdfle S i,

43} Applications Places System !’ ‘):_m 3 Wed jun 26, 11:01 AM @ pss O
© @ ® Uuntitled 1 - OpenOffice.org Calc

Eile Edit View |nsert Fgrmat Tools [Qata Window Help —m

: = "
& " | | 5 o S | %5 SR A - 3| 3. Toolbars f~ges &
% | Liberation Sans o o A 4 A | | v T38| ;
8. Formula and data input bar =]
Al B o X = | I ']
A [ I C I D | B |
i S _l 7. Address or name filed
2 of selected cell
3 4. Column headers
4 6. Active cell
5
A
- 9. Workspace
B 5. Row headers
9
12 12. Sheet tab 11. Status bar 10. Zoom tool
11
Sheet 1/3 |[Defaul I [sto][_ ]I Sum=0 I[& © @][168%]

el 52 : As well adell

oyl did Ieflul As ddl eawdy wlel ol Al sl 524l eulen wud As viell Wz ad
Ml Gu el A3l Aol 291 WA Wed-uadl w2y suldd B, W) ¢ WA €35 uesdl Radar
] A,

82 SRY22- A ; 10



2192¢ 6UR (Title bar)

as2e ou Well G R wda u 8. A el veel Beelle s (As) sawd B, A ol
giell Adl ¥ &S vidl B A Wsalled A G Afl A d AWy A wRA Wlle 8. A
Untitled Xl ealaami 2ud 8, aui X 3 As dvul B, awd A Billz ad gy amd 2Ae
s O Al dddl wieolld A aqA Yyl sid B, d dud elenl &5 adssil s g3 e
©l d oeuad. sl 534l adea o culda 8.

2 © ® Uuntitled 1 - OpenOffice.org Calc

2l 53 : adea wiR

1711 B (Menu bar)

A o134 (AAY 12l s2e Wi2el e A 2024 1Y B, €35 e DG B WAL UGN+, (submen) Y 53 D.
i AR Y416 A+, (pull down menu) 4L S8 U B, Aef AaL W2 HGY SR §6t vl GUR Y4 3R
B Al [BRas 3 206l AN 207 2614 GUR v B, AR 5441 As s A o sulda B,

File Edit View Insert Format Tools Data Window Help

vugld 5.4 : A o0
Yoy Adqell €35 wRAA Al gsl adld WAl wel fres 5240 WA B
Wi QgL

File BUAL 51 5L HI2L UL FaAl ¥ Aal B Mellaal, S15a AL 54,
BU2aL g4, M2 sdl uddl 261 GuR d-il 2viia Ad) (B Biey) a3,

Edit ER1AYHL YHUIRA-AHI S Hi2rll BUeall ¥l ¥ copy, paste, find & replace Q1L

View auRLeLsalrL Agril 828 GARAL vidl € 52, Ui Y3 A A Faud Adl (Ad s
Bley) a3,

Insert v, GQoll 4R, afdfle, 928 WA dlledyse G Q3.

Format Aa g2 sral, w2fA) wie o-uadl, AR, wdl sElla g3l

Tools QUi g Fal & AR As s M2, excldar] WRL S M2, Yol dHy
ol YAl We wdli.

Data 32142 uAL s, 21 Al sd), B WD ot 3R] 2L 2% sRd) (Ree) add,

Window adl @ wladl, dad @l WU 2wWwug A4y OpenOffice.orgril vieal
trld-l wel adR,

Help Rl duy RFRASL tusiarl Rdl A Wgedrll gl <di sueldrdl Hee

fves 52 : il RRY A

A il 516 3 Aef e 500 dl AN AU UsA-, Wl GuR Nelld A, Al Rsel Wl As Baw
(9 ) U8R s21Y dAR Br GuR v gl 2R wil usi-ll Bzl (b ) s 28+ Gu Nelld wy @l d
[Aseuni aurl Rsed Guasy g 8; auidl vy Yoy [Aseurd] waedsll ail 521 w8l . 2usla 55410 20
wsil AR saldd B, 2ugl 5,540 File Al 2iex New' Rseudl waieoll i Biolel ( b ) 282 a4l
Rsald yud 8. v [Asal ol sl Qell ¢ANAL 2auHl WU $LGe Ae, d% 3 50 ud 8.



© © ® Untitled 1 - OpenOffice.org Calc

Edit View Insert Format Tools Data Window Help

cti+0 5
Recent Documents

HTML Document
XML Form Document
Master Document

Save fs ctri+Shift+5

Farmula

Labels

Business Cards

Evoort Templates and Documents
Export as PDF.
send

Properties
Digital Signatures...
Templates

Preview in Web Browser

Page Preview
Print... Ctrl+P
Printer Settings.

Exit crri+Q
LSITEELT e et 3/ .

Euwirs ok — T ol LT e o——olfe
wgld 55 @ AU Guaoy [Rsed

A Gudatsaldl AU W Al 4R Al WRAA 23Rud du A (..) dal eulag s
suelol olls 2l GuR nelld 4f. WA ¥ adl Save as s wie 5 ¥l A gl 5,640 sulen
W IRl dd s un A &5 wowsl Qo sidadl Use sl B ddll ulddl aua yed,

Name: Untitled 1

Save in folder: '4_'Documents v

+ Browse for other folders

+ File type

Save with password

Cancel . Save .

il 5.6 : Save swela viisn

¥ o dd did "Print" Asey Fgaall dl "Print” [Qseqdi ddaul Blgdil s (1..) el ald AS
asall; B 2 N B 3 wds B2 Qsell culag Ns qudlal ollsy Wl Gu welid ud, wud
oot A RA Glaeed Al ed ugl sAy

ga%UR (Toolbar)

Al AP UBAA 266U Al GUR PEL YEL B2 1FUHL 1Y 53 B, G U2 §5d A sl2d GUR
(s 509 il A YRRAA vt 53 W8 L s213 B A8 e 4 514 52 D A ddl AL AR dL dl AR §5d
Q 812l GuR MG WiSr2RA wiHAH Fad usd. 2l dd ¥ A si2ei w3y sl d A Gu nella
2d), View = Toolbars Wit s37 a a1l ¥3Rud wud 2as1d welild 531 wa 249 217 wella ua

oit u@L 53] w8l YdFHIRA ANd (Rrex gl Ae s3d)) 2eoiR 1A wud 8 :

84 £922- U 1 10



o 2148 24vUR (Standard toolbar) : 20U+ wllH YU B A WS, 2L 24602 GUR File 21 Edit A+uiell
AR AUAA LA AL €14 B, cdlF ML Guddril daldel 2SS 3L 6UR GuR Al 1A B, - d
«ell 3eRf] £clldlor siriletel, Ald. e3ldar vileal, eaaldadi iRl el asiue, AR s2 21 We s
2 €2l Qe 520U a9l WRrll BLEAIL A Bl 221esd 26U GUR A4, gl 5. 741 s 2288 2aBUR
gulda B,

& . &N &S| R s

sugld 5.7 : 2288 aeR
o $iHE21 240U (Formatting toolbar) : A4l RN §172 sa1 W2l Wefl a4R auul 2R §ERA
200 GUR S B, 2L a1 Auell SHRAL s2eu-l uAag Yl UR B, ¥4 G adl BRI Gudlal sl

orgl) A, A A 1R (GURAL WHELA ot . A S G, 2k 6UR GU Gueist « Ay d) SR 2eii
Breigel il 7S afl 2 GARal) Rsen urie 53 AL 2wy 5.8 A8 claRis 2a0R culda B,

Liberation Sans (o bl A 4 bé;| ' | 1= | ] % O3 & | =

j| T '|Q_ @z WA

»

[ |
sugl 5.8 : gl gasu

o &ivlel 240U (Formula toolbar) : daui S Yoi duial vual duixl WRA ywral wdiag
Fade 2acur Gux i B, gl 594 s s sfar zaour eulda B,

Al B e 3 = | ‘

w59 : gxjan gaeur
246UR GUR i te siedl sty &. Gualowsal Wil Sl WA 2asiR GUR sl2w Gl U3 B, o2 g2
53 3% B Auy o2l A&l (Glsasl) sieell va 93 8. sugla 5,100 eulon W dd gacur G ws du
g2 Rl &3l sl 8l

2 © ® Uuntitled 1 - OpenOffice.org Calc
File Edit - Insert Format Tools Data Window Help

+ Normal e .
Page Break Preview 8='lv | ¥ %’ | o rl

I -setings

+ Formula Bar Align

« Status Bar Drawing

v Input Method Status Drawing Object Properties
Fontwork

' Column & Row Headers

Value Highlighting Ctrl+F8
Navigator F5

Full Screen F11
Zoom...

Form Controls
Form Design
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afl g, Glefl ¢ A A4 (Rows, columns and cells)

g3 afelled Qell ¢da (siad) wA U QAR Qeulrd 04 A4 siruqami 2d B, el
A 2 sl 30 ANAHD A B; Slada HUaR)L (WA del Ad) v QA Avaell Aoviani
wd B, adlledl Sl A 2wl 51140 qdade addl B,

Yl eds slau Aa<d Gl dell B, Asdlen dow v Gur FRus 3 2wl Slan wdie 53l
asy B, gl 51140 adslledl uddl flaw salda .
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Ad W A (Ul RAN) w dan(@ell ¢a)q Senliy 8. (ruadl 3RURYA Beal oiddl RdR
8.) Aan slaual youar (uaRl) wa A dsrdl Aol vl 29 8, eld. A4 C7. 2wyl
51130 A4 C7 suflda 8, ¥ Ad el wiie 3d Y AN sdd (ERA) A4 sddi wd D,
wdl vl A4 C7 A sded Aa sl B, (Mgl A L sl 3 Ax@As wll sda Aadl
ol slyll 1 axid R du B) Adl F A s 2w & A sdka Aad Yas B, adaa
Adel weuHL eRA) B il doll didaide Ydd 8 ¥ ABa da (autofill handle) a3
sloeid 8, F0 uul A ed ul wewdll wseni &3y,
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2edL @Ol 428 Fal 3 wRs R, vl A Yl Hud B, dil A A5 Ad 6w By sul
ugdl 3L sl As sl qwd A, slad wgd Aa ube s w8 ol
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2ol R A 2 aballedl 2 BrdiRk GuUR s HA viel A AR dd 2 uddiri Rewdeil
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dirl Yot Bl Mo Al ua 32 AU A Yoo, uRRUM Al Had,
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afofled g S /62 L W2 M 24 auuy B, ddl aud WA Fdlan w2 addlled gm 26
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" &,

C D I E I |
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Zoom tool
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els agell 2l ga Al ARl W, andR (A 56 QY dl) 2 A ]l g AL R

AN salr{l A3 B, 2 UsRAL el (Slsyiler) oirilac Wi waral 1A weudal S :

walg 1 : Al wad 12 wud vt 2udl: Applications - Office © OpenOffice.org Spreadsheet
2w 2wed wude]l i@l vad. dd keldl Aq (Srekddu) AS wsal

wig 2 : ad AS wsll ¥ Il wudaiy A2 afelle cald B, A I wdl woub weua A wwad
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AS addfled udl wisdlld A DssA A vival HR A el wud sid s
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Sr. No. Item Quantity Unit price
1 Pen 5 10
2 Pencil 6 2
3 Pencil box 1 50
4 Notebook 10 20
5 Notebook cover 10 2

sres 53 : wdldl Bad wRd

bill' sl afelleni 2l srma Ral w2 LA yys pnd s

e Ad Al GUR A2 [(Ras . ¢d 2% "Sr. No." e A i W22 4l eslldl

e Ad Bl Gu As2 [R5 s ¢d e "Item" etvd SRA A A2 4l el

e A4 C1 GWR dse (5as 4. ¢d e "Quantity” elvid A A W2 4 toldl,

o A4 DI Gu Qg2 [Ris £, ¢d Ut "Unit price” ebld A il ¥ 4 soudl,

ail Goll eQuslan)d se oleaal M2 sladn 3oL s3I wsl. dd AU aganl UM elmd 530 2wl
Ayl A Gofl ¢dud . seqadl ¥R ul W B, W sl Ral w2, ¥ Qell ¢dus Wy
ddl sgaal $L 6L d Gefl gAal WA W WEA HE WA o] doud Y A L LA (v,
dd AS AN 9 F uan dlds efld Quir aS ad 8. didl Ws waal awd Aa wie 7 AR
2e8R Al dnl w2l (bold) 431 a8l €L

¢ Ad A2 ui Avyl “17, A B24i 2t "Pen”, A4 C24L vl “‘5” 2 Ad D2 v ““10”
glud s 2 ¥ A sudldl bl WRA erva sA. ¢d addllz Wl 51640 salen wud
2uidl,
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® File > Save (s s 2l augfa 51730 eulon WA s Qualdl ol Wl Gu 2uud);
Qi sifad i A wy (Ui al sSadl AN KA %) ©) wrual.

® ¢d Save o2 Gu (Bas s

|
Name: mybill

Save in folder: |gmlDesktop v
+ Browse for other folders
+ File type

Save with password

Cancel Save

N
supll 517 : 3l erudydl NS sA

Wsdller) OpenOffice.org Cale &84 A3 A 53 B WA d viqeoi (WsA2AUA) .ods QY
8. dil sifa-dl ¥ aoul AAS R d WA dHR de g W Fdl sl d f18a Aad]l w4,

ay YL 2R §5d w3 L o ema 2l B A A ndand Aue sl B, ud WA e axgrl
Baud, sl aqall go Bud, s2 v 0wl Ysaauer il dladl 53 Al 58 sy drg-
(3 3 U)Al Boiaell amadl w2 2wwud avgll Bua(us Ul Bad)u vidlea oo (el dvay)
AR AR sl Ul wad Al ¢A9 WA dels T 10+ oud 5 Ul wdlel 0 ol Bl
uddl axgrll ga Bud T 50 wwn, o Hd e awgal W2 Ysaast A wwd 8 ¢

wad A dAM D> 5 A, el T 10 = 5*10 ¥ =T 50
ol Ll ¢Aa > 6 URd, eisu T2 = 6%2 T =T 12
A ad An D> 1 WA ollsu, edsll T50 = 1*50 ¥ =¥ 50
Al 2l g D> 10 -Dleoys, sis T20 = 10*20 ¥ = T 200
Wil audl €Aa D 10 lesys 443, e3sw T2 = 10*2 ¥ =720

Gur-l aRlddl WD, BUuR Ws A Fud diRdl 2l ¥ B AR Al x Blsn W,
25 el y (d €l dl sl W x¥y A, vl W (WRRIA) "Amount” -l Sell
Gofl ¢ eva sl W2 BUUR Al deusiR And s Aaul @vll wdal, A F d-uell WA
Riser 2uuel oaldod YA (generic formula) avfll d 9.

Acl 55 You slud Rl W2 U A8 WL (FH 3 =5*10) emd 53 sl 2wl 2L ¥ Adail
Gueed B A Aad MIn wa D s3I WA N2d 3, A4 C2 A A 5 &y A A4 D2yl 10
QY dl 2 esadl (=5*10)l Botd (=C2*D2) ciusiz ad. A ueL yoi«ll a32udil sl Rea
= duid w3l B udl A KAl Fwa adl Aqul Fud wdel wbes URA adld eva wy
8, (R eiva 531 QU dl YBL) 3 Al GuR AR sl vuddl el
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Al Bud S Aami evld 529 sl A FEu(cell reference)ril Gualoinl 32els diel B, udel e ¥
8 3 28 wd isoRid-dl B sl o3z widl dl; & 2 uys a1 ol u wRail ad, oy ae
W B & Ul »Uugl Aadi Boidd oeela R Yoig wRewn vaL Y sieals o 8. Hla ciet W 8
3 o3 J2u-l 4168 el (edly) Ay o] oflw ooriwl WALUHL 20d vdal Jzels Gofl ¥ w1l ¢
GARAUM [ 5141 Al 20 A AHA Yorui 2dal e R vy sigals »d,

wd), g UG bill' -unll aballenl e3s drgéls Ysadal sl ol W2 s Gell ¢a
afdfloui GAAN, ¢d 1A wud s s :

® Jd El Wt 5A el ddi "Amount” Ut £luid 5. d Wl 2R 4l eslldl dA Bl kA
g2l (sles) s A e

e wyl 518 eufew wud Aa B2 ui =C2*D2 adu 43 Aeul Yot GAL Wil L
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d-eteoPresgv@iee- 5 1@ %3l
#%| | Liberation Sans (o m A 4 A || =| ] [ % wm o] ;
SUM 1 fo X f [z |
A B C D E F 3
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2 1 Pen 55 10 =c2*d2
3 2 Pencil 6 2
4 3 Pencil box 1 50
5 4 Notebook 10 20
6 5 Notebook cover 10 2
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8
9
10
11
12
13
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® il A4 B34l (=C3*D3), A4 E4ul (=C4*D4), A4 E54i (=C5*D5) ¥ Ad E6HL (=C6*D6)
Yoo avfl udl ),

o -l [Ased da B2l WURA ddl Qoll ¢da-u sufl-l danl A4 E6 Yl $5d P sl 8.

vl Yoell wtse uduin 4 o). Aaqdl ARA P R R, Ad Gur [Fus R A udl
A Aadl Rl ougel A veud w3l Avul da YU L K

o vl 51940 ealen wwddl wGeye dd A wsdl,
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A B C D E F 3
1 | Sr. No. Item Quantity (Unit price | Amount
2 1 Pen 5 10 5
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8 SUM({ number }.» number 2, .. )
9
10
11
12
13 3
i v i \bill {SReetz {Shees / 1 - -1

[Sheet1/3 Default _J[wsrr][s][E ][I —_Sum=0 [[e- ® ®@][128%]
susld 520 : sUM RAx

92 SAY2-IUYA : 10
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asy B,

© © ® mybill.ods - OpenoOffice.org Calc

File Edit View |nsert Format Tools Data Window Help

d SN S vEl L DE- 36 -l@ v
| [Liberation Sans B A 4A EEEE b » 2 &|FF ;
E7 T fw E = | ]
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Aol s3 A4 B9l uelia s 2uud Gua vl 530 & wwd sum @AY dd Gulal &30 ws
vyal A4 E9 we s3I il (FE7HES) A Y avll us.

Ad DY waie sA uiA dul s "Net Amount” @vfl e 4l eoudl ddl vugla 5.23u ealon
IR uReus AS asal

© ©® mybill.ods - OpenOffice.org Calc

Eile Edit View [nsert Format Jools Data Window Help

IR TS| (MR TRl (S als - @l v u

=
& | Liberation Sans X 10 - s A A4 A | 3 | % Lo & | « ;
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(8) AAY duR 59 () uRewdd RAua

() &6 Gded R WRA Y Rl (d) dudal duy
(3) 3elui srudel adalled nqeoi A g o B2

(8) .ods (®) .odd (c) xis d) .obj
(4) kel AS Aani A =starcalcteam() elvid s3a14l 204 dl NA-uniell §f adalleni AaL 1ad?
(2) i ®) il sdiaqz gsdldl audlz

(©) ¥l vaunl (ehua-a) WuRdl @ il gk wRdl
(5) ¥ell excndordl adalloni AS A eive s3ell Budlrl waainsll aeddl 3dl A 53 23?
(8) %d dRdl 530 (b) autosum <
) YA (d) GUASA dun
(6) A 2uuel afefledl sy A1 Aadl EL YA Yordial Ada vy, woURA WALA dl
Yoruiel e 9 ud?
(2) dlde 42 Aal A (20l ¢An) A fign (Gl ¢An) sgeus wQ.
(b) Sidal U Ad-U A 61 seenS ¥,
(c) lded Y Ad-ll SlaH «oR gl %,
(d) 59 secud Al

wadlBis  xuta

2 wsRl Wl Blada GegRadl dal s gdl ddl R s,
dl A6 YuR WA Andd Biadl dewdn sA A dlul a-dl el s

L &9 el el Rudl Rl By 3R{l tldy oi-ldl. d ugl a2l NI g4 IR, U
2 26 AL

A Bl ot GARL 20 Ralua-l ol Gelgad [Qdil

SPYQ2-vRA : 10



UG WsRl Al s wdl A W Wsallani WRAAL AR 5L W) Yaod Asi A4 B,
Glofl ¢ (Slen) A wdl ¢ () golloan decull sirdl usu o Aa-d) ws Ved o Walle.
o) o 321, Yol A [RAY L Aa-l vie aumari 2ud 8. 3w unD axd 2l AREB Qe

Jal-aRl sadl Ban) w9 SR Q2 oy A 2usls a3yl alsaar) dsifd Yaed sl
R4 wlBrd udvi M.

Sellni Heid afellz sl (Basic worksheet operations in Calc)

Jedis sl Fal ¥ Al vy swd Wz vedl, WialleAl AU R, save as VLA A3 wull
Addlled -un slead, adalled un oigad, s addlle G/ g2 Rl 493 Wsalle vaw adll
AR GUR ARaR adl WBwA) B, . Qeusmi Wl WAl wal s D,

Adl £3UAY birldd) {Creating a new document)

oul} dd OpenOffice.org Calc R[M{AL vlel 1 AR A WUY A5 Ad) (budl) sacldy wlal,
o ddl uydaiel ¥ 2w sy Guyldl 3 R QM A dul aR d2ells Rl avll i dl ad
ol ~idl Bz edldx vildl a)l @l Adl kel srudy viddl w2, W2d ¥ IR Al vdaal
we (A ol Buisdl s :

e A4HR GurYl File > New -> Spreadsheet Wit
e CTRL + N goidl, el

® Ul Gur-L Al 2ok GuRYl New Document USAA Gu [Bas s uq Asallz wiie
s, 8- (dodlni safda) 2usl 6.3 sidian wwd 2eud,

2 & 6@ untitled 1 - OpenOffice.org Calc

File Edit View |nsert Fgrmat Tocls Ppata Window He

| 5 = & | S |52

10 sl & 4 A

Presentation
Drawing - l

HTML Document B C
XML Form Document
Master Document

Formula
Labels
Business Cards

Templates and Documents

6

suhld 6.1 : Al Wiellz vdaw w2 WSHA (icon)

g dil QS ] Baallz vlel 19 A A du 8L Aadl adl qdflz WA B; B A dN &5d AL WiHidl
alfRiet w2 2oy wlEl dlu Fui wdl ¢l A Gloll ¢Au g (308) €l B, d wswL 51 WALl
Bra-l R elue s2a 22 565 dd o adellz wa Waallz viel asy o v ol

Fellui ag ARBA wA gARa 97



A ewd IRl srdza qsll ol A wlell usy, 2wl wdell Qanl Anax el wdl sda
Aol open wuzd Ml ¥ Wl el Al {lA 2wl S :

e Wit s File 2> Open

® Open Juddl ollsunl YdMARd Sleauidll & wiry Dy feauiall andl 233l s15a waie L

o v Bul Open sled Gua [Ris A yol s

ey [Aseuni, udal dil swieanl o3dl sidd ) 512l usdl 1 veuen yud IRl Ws2dwl dn v,
® Places > Documents §gd (I Documents 1R Blel

o awsl 3 Vsl §1dd Wi 54 Ad vidl

A 6w Rudal uidin wqudd uRL dd Al siSd Wl + whl dl Gopgell wal (search)
Q sfad N wsl Bl v A 2w Rl w3l sdadl eoul i Wwe A QR 2w YRR
vis, Gualell B,

o R 620 Gou A-ui eulod WA Places > Search for Files w2 2,

® I di Search for Files (Y20 2uslQ 6.230 WGU dlRl Faul) Gu (s 5A 6l AR s1da-ll
WRAL yeod 2s qudlol ollsu Wl Gu uelid 1l 2 RN s1fad A, ¥ el s154
bl §u dd i ud 1WA ndadl vieadl deedls wRAA wwda i B, Wwud Bed
gdanl Ya-aiRl sl adlv Fd dedls dilv Q ua s1Sad Dl adll i, wgl 6.240
dluellal Mgy sad R 2wl As ol i,

® Search for Files Jueldl olisucl Name contains: 3 §15d Yol A el <l Q3L eual
slud 52

® ¢d Find o2+ GWR [Ris R\

s 6240 3 widizl wRA ealon B, Wball w uBuwe wRA §ia-dl As wd d welld
RA. dl sda vlaal w2 Rl 4154 Gu GUA Gudlal ST sud (Bas s

43 Applications _ System | © ©® @ search for Files

P Home Folder |§

T Desktop
File System
' Documents

P Music
R Pictures

ﬁvim wble optrons | Date modified less than v Add
¥ Downloads
@ Computer
BB 24 GB Filesys
BB 52 GB Filesys
B network
Connect to Server.

FVE—

Locate documents and folders on
this computer by name or content

¥ [ [Chapter 6 data editing ...

wyld 62 : e1fa dlwa wedl luulad uRam

98 su223-utAU : 10



Asefla-dl AAL 52w oy 53l (Saving and closing spreadsheet)

2100061 ReUAUL . A idl £cAY WAL Ul ExldY Aal WS F Qul Yru-ap we Bl
gcldyd dd wiewr YL 1Al B, vieal ercudoml Ws auid s yel wd wn Hed dul sl
WRaddldl A Rl dud wR W B, A ual 2L dpuddld uesadl W2 sial WRad-Alel aidar
Aud sl N A 8.

VG U5 5 cdelledl AL 59 Al LRl A sioid 2l s edl adslledd Age R W Wl
M) : File 2 Save. o dd cd¥l ey ol AUHAl ¥ 2nadl usidl s16a a3 AL R
$39cl &l dl il Save as [Aseuq ud wie 53 s 9L AHdl UG eusn WG, A aX Biellenl
udel i dAS S Ol s1fard AM B AR AL SR WU dHA ypdl

¥ §d vddl & (ddiid) A oY sal HR File > Close Uz Wil A dd Seal 361
s o 2l QU dl IRl dud &fd o sRdl Yddl slSadl ¥ sKadl Ay day .

afelll [QRAY biﬁllaﬁl({r\iﬁa)‘-li S (Saving worksheet in different format)

yell ydMuiRa A, Vel ods vigesid WA §15a WL Au 2 B, WA Jedis s16arazu
(eitue)-l wel ses 6,130 2wl B,

P ERC TR vindoL Q9+
ODF Asalle ods OpenOffice.org calc §ii2
ODF d:dllz 2wde ots ol Wldllz 2wde quile
dBASE dbf 2L a4l stile
wles CSV csv syl Budl anedr wddl wbzs s184;

wid RN sl g1dda RRY Weumdl wlRdl
ARx%Y W2 quay B.

HTML elde html ot S guile

(OpenOffice.org Calc)

yauel (W3ea) exdidy pdf Al awd quag sile; w s yaw
s{41Rel edcldoyd Raeudl Adsi(Adobe)q siile 8.

Rl NsAd 2007 XML xlsx BHRNUABEA 2007/2010+0 Dsalle

wssRilse Wsda 2003 xls AuAAAEA 20030 Vsl

fres 61 : [fRa sufa silz 3w AlsdlleAl Adue 59 asw
Bllledl vy g8 siilenl UUS AL W2

® Ayud File 21l ussl Save (3 ¥ eacldx-ll 210U6 ¥dle sil dl) vl Save As Rsen (vjeal wA
22UG AAS 54 eacldy HI2) uAe SR

o Wl 634 sulon wwd file type A (RER) el

sl 321 AREa A giEllBa 99



File Edit View [nsert Fgrmat TJools Data Window Help

2 L 4 R z 1
® " N ARl (P v B ‘@ wrw i
w»
1 Name Untitled 1 '—J
A gE—[—F
1 | Saveinfolder: | ‘Documents X
3 1
+ Browse for other folders
3
4
3 Save with password
o
T
8
9
10
Cancel Save
- 15 =SS J
W > w'\sheet1 (EFeez FShests 7 || - -1
[sheet1/3 || Defaulk ] I[soll 1 | Summ=0 e o @|[1568%]

susld 63 : file type A wag
o s 644 eaulon Wil ¥l afe fdledl uaeoll s

Name: Bill

Save in folder: \4_‘Documents v

+ Browse for other folders

— File type: HTML Document (OpenOffice.org Calc) (.html) {

-

Text CSV csv

HTML Document (OpenOffice.org Calc) html

Microsoft Excel 2007 XML xlsx

Microsoft Excel 2003 XML xml Ie

Edit filter settings

Cancel Save

13
vigld 6.4 : gfat unedl uieol srdl

® Save t2+ [Bas 59l sifa-l AAe LR
afallad -ux 2 491 6184 (Renaming and re-colouring worksheet)

WU WANGAU UsRERML ReA ol GuR ue [BRis s afile wale s afalled A o e
ol Wl il vAs afelle dwdl WA DU dl A gadidaHl WA AWEA W2 A DY Ay
(@A L) v ay AR B, addlled A seadt w2 A wud Busd s

100 SRY2-WYA : 10



o el afeflenil AS ua s da-dl wdesll s,

® ¢4 Ul ¥ : Format > Sheet > Rename

o Uellld Rename Sheet Judldl ollsuil «d U elvd s
e OK ot goudldl yRad-lel s s

Bitell A=y [Qseu3 o2 26t GuR caldai afalleni Azt Gur Ade Fs s34 A ealeut W38 Rename sheet
[@seu yaie 5. 20 [@Asey A ad UG vy ©), w1 Bu 3 aeudd & ¢

o auid ¥ afefled -y siead du A dle wie ) wie Nl A2 adade wddl 2wl (ude
WALEHBL wd)

o qd dlz2 Gur U2 (Bay 4. vyl 6.540 eulan W 314 Glof A uelid ad dAxiel Rename sheet
Rsen urle 42, 20l 3ugl 6.5+ Heunl @orlRA SR Bg g, JudldL ollsn Tuuy .

o ¢ l2Ad Aq un L

2 © ® Untitied 1 - OpenOffice.org Calc

File Edit View |nsert Fgrmat TJools Data Window Help
L LR R z »
® " TN & &S R R~ | @ wz w "
§| | Liberation Sans B (o ful A 4 A | ] % %3 |l ;
I fw X = | = " |
i | q
A 3 T © ® ® Rename Sheet [J -
1 | Name .
I | ','_:I |
: ' |
3 | ©Heip K cancel ISQ“ l

Insert Sheet

Delete Sheet
Move/Copy Sheet *
Select All Sheets

Tab Color...

Cut
Copy

wil 65 : dlz 20 a3 abelled -um wgag
afellz 2wl 331 ©lgddl (Changing colour of the worksheet tab)

adaflel 201l 0L olgdal W2 vgll 6.6+ eulen WA U g5 adelleqt U G USe (Bus
s34 Ul Gur uelld Gou Al Tab color 3U2Y WAie sl W B, 2wupl W 23 sl RAY
Dhiall s 2o we Doy WL we KA W B,

Salui Y21 ARBaL A iRy 101



2 @O untitied 1 - Openoffice.org Calc

A "N »

& " [ = ]S~ Bl S o ) e i
& | Liberation Sans B o i A 4 A | | w S o# | "'
. |

|

. . ot
| L IEmll L sumee  j[e-—— o @][100%]

2wyl 6.6 : afellz Znd o sgadl
afellz Gddl wA & 43¢l (Imserting and deleting worksheets)

al el ¢l ¥ usllar wys QMDD Aifid o 2 emd e w2 kel au Y wami
siadl 2 afelz yadl <ol suan AR, wud aurill adillz GRRl WQ 8. eld. 5 Wi,
g & wdsmddl Renedlildl uwin ou B, eis oo w2 sl @oRludis orilagd B, 2 Gelgaral
wia afyfle dlu A ay Susdlly B; els afalle qudls wadl wadl aaluas . glile sl Blslleui
A 2 glan GAF wna B, ydusd oeel uny 8 uAd Aaqd AU N way .

Al adellz G w2 1A wad Buad s :

o W Addlledl A ua Ad wde s ¥ ¥ afdleddl wan 3 wesn «dl addle Gl L.
e ¢d iRy 2uY: Insert > Sheet. ¥l Insert Sheet JudidL ofisn Wl Gu uella wdd.
o 2 $-ud 92 (Insert Sheet) duellal olisudi qui-u [sedl omud),

o ddi, 3 BuwA MR suadl W2 OK sed Gur (BRus &3,

awRidl Adl afellz GlRa ARl Gur weuddl Buwald sugla 674 wfa calddl 8.

2@ O untitled 1 - OpenoOffice.org Calc

pile Edit view [

(oot 373 ] [Detour ] — ) ) O e —|

wil 6.7 : srudwui Adl adsllz Glad)

sRy2- A : 10




adl sein afellz 20l wiRed Adl addfle Glaawdl asudl susd wa RAy ¢d. 2 - Guda
A adslle Gl w2 A oeudal woaid WAl :

o Afall2 wiie s dql Gur ude [Rus s
o 3y Qaj A4 wad,

® ¢d Insert Sheet Wit 53

® ol Insert Sheet dualdl ollsy A wsAl

o o3dl [Asedl 2wl OK o2 Gu [Ris 53
adllz g2 sl (Deleting worksheet)

il il s vgal ql adalle g2 s AN WL AS A chdle g2 AL W2 A F R Rl
Su9dl dlu A adalleal olz 2ot Gur ude (Bas R d dusd wsn Busdl wel weuqd. su Rsednisd
Delete Sheet Wt s il (Aseu3zd, did . Wl ey 2wl : Edit > Sheet > Delete

A A slan sall Buwsd (Row and Column level operations)

wys uud 2 afelleni dedls fan ¥ A Gl wzz QR D, A 3 afdfle well A wA Han
YAl ud B ugl B usd B % WA evd s3el Jaidl a2 Jedls vl A 3 San Gl A
e v Rewdni A A san sl e Buad wd afallenl A ud slay 55 A G wdlA
adfl wal g adellewi A (Al ¢An) Glaar w2 A wud sl LR

o ¥ Al G Al A GRaul &u d A A5 25 A4 Wit A

® ¢d ey W : Imsert > Rows

afdlleni slan (Gell ¢da) Gl W2 AA wud sl A -

o ¥ slaudl dofl oyl Adl slan GlRadl QA slanuidl As Ad wie K.

® ¢4 W L : Insert > Column

sianl udmS uA A Gl weadl (Width of a column and height of a row)

@l ol o A (Ul $A9) wel slan (Aol gAN) Asunll Gl WA uglous Hud 8. wd
A Al wrs wRdl avl 9l il well aud oy Aa-dl WA 528 da-dl wldd »ew
u oy B, 2wys AnA J2ais Yol uRRL el wug vaL <ol sandl v vaal A GRS
seaal W2 0w sd s

o sSian()di A ol widl 3w Gur (Ras

o WGUG o oled W €l R adl 3dl Rl oL sA (WA).

Slad wydl A A6 Alssu wu Ml w2 0A wd sl KR

o Slay(A)Hidl A5 uel ANs Ad wie K.

® ¢d 22y W) : Format > Column > Width »u4 Format > Row > Height

o Ul G ¥ qudlol ollsu welld wy Qi Slanedl s wear AN G Sani erudl,
® ¢d OK 824 goud),

B Sudi WM Al g A QL d 1A wud wRe )

Tools - Options - General 2ugla 6.841 sl WAUR duRl ¥3R%A 3ol A adl(General asf)al
YU Wi vidal Rsedl eed),

sl 321 AREa A giEllBa 103



© Options - OpenOffice.org Calc - General

+
+

~ OpenOffice.org

User Data
General
Memory
View

Print

Paths

Colors

Fonts
Security
Appearance
Accessibility
Java

Load/Save
Language 5Settings
— OpenOffice.org Calc

General
View
Calculate
Formula
Sort Lists
Changes
Grid
Print

4

Updating
Measurement unit \Inch : Update links when opening
% = Always

< @ On request

Never

Metrics

Tab stops 0.50"

Input settings
Down

- -

b Press Enter to move selection

Press Enter to switch to edit mode

Expand formatting

Expand references when new columns/rows are inserted
& Highlight selection in column/row headers

Use printer metrics for text formatting

s Show overwrite warning when pasting data

+ OpenOffice.org Base

+ Charts 4 _@(

D
sugld 68 : Sxllui General -u [iseil

A A san R 53l (Deleting rows and columns)

A 2 R we 0 wridal vl @A :

o dil ¥ A g RAU HAdl dld d A GU dd vl

o d A R ude By K.

® ¢4 Delete rows Wie .

il o fd d slan ua g2 530 46 6L Wl 6.940 A A fauq e sl uBud uedq 53¢ 8.

C )
] Format Cells...
Column Width...
Optimal Column Width...

Format Cells...

Row Height...

Optimal Row Height...
Insert Columns

"Defete Columns )"

Delete Contents...

Insert Rows

N

Delete Contents...

Hide
ﬂlde §how
Show

Cut
Cut Copy
Copy Paste

M Paste getd
Sheet 3/3 Default

A 27 glaul g2 sl

2uyla 69 :

104 Fayea-viun : 10



vy Rseuzd, A 3 slan g3 Rl 4R A weudal widivld v

e ANYH SldM ¢Ydl A Rl
® Edit > Delete Cells Wt 53

L Bu 2ugla 6.100 uRs cwlddl 8. 3w RAsar Q) wvel #3Ruld Wl Add WA 2wl
fad vaal A g2 KAl wy 8.

A A glauA wais sl (Selecting rows and columns)

ufl Qoll AN UAE sl W2 SdH AR (column header) GuR [Bs s, dil AS wsa 3 2unll
Gell ¢ idense 4ddl 8. 2 o WA, el W ¢ANA urle s W2 A &R (row header)
Gur (FR1s sA nA el 2wl Wl sAa ddade aldl Aa w4,

[Rous 2B sirad (Freezing a pane)

ol ¥ o afslledi Avsiy A A dandl W sami WA 3 AL fay AR waal
QR ¥l GU euug Wq Al & el 2 dAad Yodka orll Wy B, slan AR ud A &R dlal
g 28 A w2 A e sl s

e oMl fAad &R tAadl wd ¢dadl A4 Axuifl AS As Ad wde s Aau-dl Budl ¥
slan ddal e Audl u ddl el suy-dl slan uwde s

e d¢d Wit N\ : Window > Freeze

A4 uldd (unfreeze) oi-iladl W2 Window = Freeze 212 53] 2udld Freeze [Asey «lurie 5L

© @ @ untitled 1 - OpenoOffice.org Calc

g:re-:{mw Insert Fgrmat TJools Data Window Help

Undo: Delete Ctri+Z e »
, & | [ A .
Repeat: Delete Ctrl+Shift+Y - »
¥ Freiy aﬂ A I %a Dn?, éﬂ. 4
cut Ctri+X _— '
Ctri+C I 1
Ctri+V
pecial... Ctrl+5Shift+V C 1 D | E |
Ctri+A
Find & Replace Ctri+F Delete Cells X
Headers & Footers
hift ¢ ‘ K
S Fill . & Shilt cevls up
Delete Contents Delete tc Cancel
oAt |
: Sheet X . belp !
Delete Page Break .
Plug-in
Mot Sheot3 . - |
[Sheet 3/3 ~ |[Default i sl a1l 1l Sume=0 le e ®l[170%]

vugld 6.10 : A4 g sHa
A4 sall Buwasll (Cell Level Operations)

vl [Aeudl dud Aadi &5 Ad URA avll asny Al auwr 2y, 0 R ks aviel, Ava,
RAN), Yl 3 wiu Aasl Aeol S Ak 20 GUAd al s A4 3 wds Adell WRAAL Ase 3d)
d LRl wd 3dl Ad wAdl A susd um aflwal,

Seflui 321 AREA 2 gidARa 105



A4 ude sl (Selecting cells)

GuR osuell WSl Aanl wleRs duuel, Avul, RAN) ol 3wy Aa-l Aeel eva =1 wsu ya
Al 46 uel elviel Sl uddl wuel Adq wie KAl Q. Alddr SR Al aviel AL 4l
Adrl WAL A W2 &5 M dell GuR dg2 (5 529 wedl. d uedl Aani ail evurl s Asal

A4 [ waie sl (Selecting a range of Cells)

A A4 AR ue s W2 A [ARclxl uddl A4 Gu oS Agz [5as 5. WG ag2 (Fas sAA udal
A ule sul uedl G- slert 914 Al R uGA W2 SR Rrdi-l Deal da Y-l s Aax
e Ay cdl Yl 391 5. Bl AN [AdReL o A edaide us ad ul UG sledn 814 €L

GuR Rudell WAL §5d Bsollan-(l ougrii Wal Adq aw, w3 8. A Ad ellay A Aol wdA
Q4 dl did CTRL 4 eould vl W3 8. 2 adid vl adaflz (adalle-t ol A4) weie sl
du dl dil 38R A fan ARl w3vidd sed ¥ Fad B 52q W B, A wA slan-i [l
Il uBl dd [l uaie 530 AN L T3 5 SJA sl Al:B12 aeudlq.

A5 As A8 vdl Ad-U Rl wedll W 52 W2 dd $3d HGA 93 A y A4 Gur As2
Gas s24 W 8.

Ad-d wlRA 28 sl (To delete the content of a cell)

A 25 A4 I Aarl RRARHL Well URA g2 Rl 4R A WL sd s :

o As Ad Al A4 QR wde K.

o A ol Guarll Rellz 4 (Delete) eeudl el Wl GU Ag gudidl oisd welld ad.

o [R5 s aud]l a9 e Ye RlAl Al di wleRs avul 2w sl Su9dl €U dl Text
GuR (Bas &, il W sdl iy uweiesll 2wl a8l el

o gl 6.1130 ealen WA Delete Contents dudloL ollsudl OK ti2d GU Ris 50 ¢l
wiealll YR s

Delete all — -
2 Text Cancel
o Numbers Help

o Date & time
& Formulas
o Notes
Formats

Objects

wugld 6.11 : Aal WRA 26 sawu [ARAy [@Qsed

Al GuR Uelld Sudivl ofisn A v Slad 2w sl ARY Ased Y 5 8. fnes 6.28 Delete
Contents Jludlol olsunl Guasy [Asaldl Wl 2y sidl 8.

106 $222-UUA : 10



Rsen agir

Delete all Qe [ A Rl Ayel WRA e 2 B,

Text wie sal Ad [da Qi wbks avum w2 8,

Numbers Wwie sdl Ad /A4 Rdruidl @vu @ 82 8,

Date & time | Wit s3el Ad /A4 QMY $5d dlb v AHY % 52 B,
Formulas Wit s3dl Ad /Ad RrdiRdill Yol 2 ddl uRBawdl e 3 8.
Notes A 55 Ad W2 A G QU dl w K1 8.

Formats Ad sBIRA (uon)) e R B ya Aadl 2L AW B,

Objects dadl quAAl dredl @ 2 B - ¥ 3 S,

S5 62 : Delete Contents Siudlid slisu-u Guasy [sell
A wlRdui yupA-awrn s (Editing the cell content)

Aaul Wdl RN 3R R (2R2 - edit) W2 #5d A4 Yde 5 A WGA R sog [BRiy
530 R Y KL 2wl YR R snd yel wy o ugl A 4l eoudl

Aa-ll -sa 53l 2 AL AU (Copying and moving cells)

Wdellert Aari s wsiRel 320 A B, Fu 3 Avwy, WRs avig, Wi, gz (uav) i
Aa-) FEd. 0 Ad Al wRA 2Ra B, sk@ ¥ A vids wsiR-l Budl wud 8. A As Aq,
afeflz 3 A4 Rl dsa Al w2 ) yud sl A

o Al B+l «sd LAl S0l Y A Ad [/ Adl oudl [ AaD PR [ adelled we s

® w2 ) : Edit > Copy »u-il Rsel ad Ad uie s34 d«l Gu A2 (s ugl 530 25l 65 uA A
ugdl el Copy Rsen v, wisa adel 21 2usi 2usidl il dodluyi eidaise addl euudl,

o ¥ wyl ladl dsd Al du d WU Al s wA Paste W WML

Paste Wi atiurl Rsad w2 vgl 6.1240 eulen Wl Edit > Paste Special 2wy .

Paste Special ddlol ollsd & HRAM s sl & A« H2 A5 uBRHE) (parameters) 414
8. il yied(lxll wel ey 6.3ul widl 8.

any Qg

1 g5d Wees quuml Ase (paste) &3 8.

g5d Avusll wse (paste) 2 8.

g5 il A uHurll Asd (paste) s B,

s5d YUl dsa (paste) $3 8.

g5 el «is@ (paste) 53 9.

AS Bud waal e siledl «se (paste) &3 D.

N (N v W N

g5 iosedl s (paste) 5 V.

g% 63 ¢ Paste Speciall wigollai)

sl 32 AREBa 2 gl 107



£ ©® ® untitled 1 - OpenOffice.org Calc

Insert Fgrmat Jools Data Window Help

Undo: Input Cri+Z

Repeat: lnput  Crel+Shift+7

Cirl+X

Cirl+C

Ctrl+V

& Cuita I
i @ Paste Special

R REEERIE

B [Chapter 6

Syblract

wusld 6.12 : Paste Special U [Asal
Paste Special Bul a3 d3d sidel A4 GuR MR 3dl Ad Az sdl dq Fdaa s ws 6L
AWARB 24 (Autofill tool)
Aadi wund 2 eRal HER WiARd 24 auud 8. [ weudal waal wwd sl s

was A4 AvUL evd S
d udl-l Aauwl A ¥ sian) ARwdl-l v sma .
ol A4 uAe R
Aarl 4= (handle) Gur dse (FRis s

G o2 eoudq Ul SRBA Ad R Y L (D) s
dd uGA o2-l WLl €L

sugfd 61341 ealon YAl Wld d S wsall.

2 8©® Untitied 1 - OpenOffice.org Calc

jnsert Fgrmat Jools Data  Vindow Help

+ S ¥ = L B o
L) c 13 [ G
' [ d 7 T I |
After b

2ug(d 6.13 : AR mAdel 2van

SAY2 /YA : 10



Gu2 weldel 2NAR ARl A AnidR Al dR1F ww vy 8, ¢d ad (A el wud
wadl Fd AMidL S0l WU

Al Al ALl Aval (WA F 1) aull, d-l suy-l Aadl By A4l vy (Uuen Gerganl il
uglel A4 v 3 B) evl, ¢ o Aad Aswd wde £ A udl-il 10 Janl WARA 28 Q
BRAl Hucl S 84 dd WNAA el Avwy Rdaa 2 A s AW Qv B 7

g ey Wl Aell add udal sdl vl FH X

e 10, 20, 30, ...

@ 25, 50, 75,..

® 2 4 5,.

Bl 2d ARl ddl Avadl ses (1*1=1, 2%1=2, ...) ot-udl sl

A dil §5d ws o Aa-ll Qv A HNAGa 2a-dl Gualal 528 dl 1+t WAL vl el Anqal.
s5d QWA 3 Aqui vl wwn AS Ad 3 3 Ad Fin & dl § a7 ddnd Jeaws Aa
WA quil 2 olyel deals Adl ARG A Wt 3 gl

e aeunis w4 [MRUaL 2eu-is (Relative and absolute address)

UG GelgRRnl Rl 35 Aarll Yol s ofl vy Agul A odl. 2 A Aanl Yo avlg
QY v A Aarll Asa 2Rl ofln Al sAN dl Wil Wle Al wUALs(AJ-address) Il
Wdaiy seel \wvl B, (@ 5L wddll Badl Gelgwil wWud d WY &d)

da AlHL A A = C1 B, 2wl xd 3wy ¥ Aa Al da Cl1+l URAA Geduw 3 B; Ned
3 A4 Aldl Al Aa-dl ¢d 9 ad A4 Al Asd A4 Bl 53 dl A4 Bl d-uel ol Aa
Bed ¥ DIl Méu 5@, sl wsr-l nis(Aa)-0 wBad wla sl »ud 8. awd ada
Widisdl sa s Aquidll ol AUl KRABL Ad 3 d NP QealS NnY B, i -l
WL 204l W2 WA weAis Rl 1[I vl W2 WD =$AS] (A A [ wuda Sad-dl wdal
Jderd Ria (5) GWR) Fq winils aviq WA 2 WsRAL Wisn [FRUA WS sdanl 2ud 8.
ol Yoiell dsa sl 20 ¥ wAsani d R MO8 wdisul AF uRddd wag Al Frila
wHis ddul S Ay Ad-l Baad Féa 52 8. Gewa iy, A uelalRdl w4y =5A54
U A4 Addl B Anad, swd e ddl «se sHD 20d § wALdD 2wAd.

Al QS sl v § avlld Slena uAG WA A A AR 2l Al Quld ua 53 Wl Gelew
a3, A dl AS Widis =A$4 a3 @vil A dn ol® WU s KLl WU 5L d
§5d slen ogald wel A Adl oledld. Aui dAal A 4 WA

Yo WA Aaul WARA s W2 A vl sl A

o Yl A Aa Wwie R

e Ad-l d=d 6w Ase (RS s

o HGH oledn soudl WA B A R YL Jou A

o ¢d WGEU o2+ WLl €L

Au gtz sl (Formatting a Cell)

Q. da- ol sedl wada Bl wud dad o @i, wd wda, dadl vie: Sy G
afl, A4q B-udl 20l WA A Aadl 2iex wWa R sie wa sedl wflA Gl wud
el WRAA ARY sz (format) @y Wi 24l F 3 adls ud A sl seaq. Aed
3, v, »igd Wa WRAA, i, Aadl Bl wd A yaggfia sile s wny B
v 54 W2 Format cells sudioL olisu vual sGRa gaosurdl Gudlal 431 uflA. sugla 6.14%
sl gasiz eule 8.

sl 321 AREa A giEllBa 109



> - A

)=

3 4 8 6 7 8 9 10 11 12

sl 614 : Aua WA sidBa gao

gl 6.14u euldal doad sl 4wy 64340 widd 8.

Yel), ¢ U SR Jzells 2ol ATV A Wl dd Gur wRldAdl RRY SR widar) adaflanl

w o m G b &%

13

ang Qe
1 a0l (style) @l widl
2 §l-2
3 slee A8 (sle2 s8)
4 il sl (italic) »id wse (A dld ladl
5 Ssasl (veudiee) : qoll ougy, el wusll euy, ordlsin
6 e s3el Ae cluqal (MF sRdl)
7 e
8 21
9 sl Bia Gled /e 4
10 | $=- quRd /U2
11 | Aadl Bl sisle
2 | da-dl vaBid 3
13 | Aeui gieesll WU
14 ghile 4 53¢l Aa-ll Budl Gladl /2w sdl

fife 6.4 : sIARA gasur Guru Rsed

Jeals da Gu uyal s il
43 ﬁﬁa (Number Format)

4ok 8132 Adul Wl WA MR 2 D, 2 du sile A5 Vs Aa, As WA wie KAl WA
Ad v Al QAR @, Wi asa 8. sl 61540 eulel WA Format cells wiie 1A
Numbers 261 )el wq, 24 Gu nelld qudiol ellsuaiel daudl vaieoll wwd siife A2 R gl

6.1541 ¥ Ane 2wdal B ddl Ay s 6541 2l B,

SR23- MU : 10

14

ane Qe
1. Yoy gide-ll udeoll ¥ ¥ Numbers, dates 4913,
2 wie sdl siledl alas g
3. wells ARy
4. ude sl Aas By, enm W2 AURR (Wesl wsa w2 Ra) GiRq
5. et Ra uedl disdl v
6. Alldnl Yeusll v
7. el Avd dd safadl
8. L TREETC TR TR

5% 6.5 : A4 HI2 Number {r‘iﬁﬁﬂ-ﬂ [Aseq)




[8 Format Cells

Numbers Font Font Effects Alignment Borders Background Cell Protection

Category Format Language
All . General IB \Defauit - English (USA) 3
User-defined -1234 N o
Number E -1234.12
Percent -1.234
Currency -1.234.12 E
Date -1.234.12
Time
Scientific ¥ o
Options
Decimal places | & I 0 A Negative numbersred |_Z I
Leading zeroes 6 I 1 m Thousands separator 8 I

Format code

General

oK | Cancel Help | Reset

s 6.15 : A4 W2 Numbers SAR-U Rsed

duul 4Ruadl A W2l Number sUIRo-w Rsed sugla 6.1540 eulail 8. aidlm, 2am ¥ 241
gz olgacn W2 Yoy wde R %3 B,

Format Cells $iudldl ollsuri ofln Rsey Font 24 gl dil slee meell usl ol gl 6.164
gulan Wl Fomt Effects 260 ad girell wuR oiedl sy 8.

Untitled 1 - OpenOfi

Eile Edit View Insert Farmat Tools Data Window Help

2 L 7 - e | | b s < F
.. Tl | | b4 i:‘, ﬁ | 4 % ] ae | r_i T o= I = 2 ] MWz W | I
e o R 7 »
i | Liberation Sans Iml (o ol & 4 A |E| F = E | % T | e i
@ Format Cells
E9
: Numbers Font Font Effects Alignment Borders Background Cell Protection I
A I
13 Font Typeface Size
Century Schoolbook L Italic 10
14 Bitstream Charter . Italic 10 3
Century Schoolbook L Roman 10.5
15 Courier 10 Pitch R Bold 11
Dejavu Sans Bold Italic 12
16 Dejavu Sans Mono 13
DejaVu Serif 3 14 5
17 MNinnkate 18
18 Language
*% English (USA} &
19 —_— — e
20 The same font will be used on both your printer and your screen
21
22 Century Schooltbook L
a3 | 4
o e = = Help |
Sheet 3/3 | e — e E—t)| | A

wyl 6.16 : gl2 tigaq

Scflni a1 ARRBA wA gldlRa 111



dil sei il Jedls sirerl AR @) wd us u F § wa (sles), Al (Sauas), usedl
QA dld] (2u-elSH) Aual glved s6. 2uAil J2ells A2 QAR 2a002 GUR WA 3 2udell
B, &5d WU WHAA ude A B wydl ) vug s wsw B,

Y2l gusig slsael 2 Rxiga (2t il 2 Be2(fa - Data Sorting and Filtering)

o 56 WA sHHL 2 AsUddl U Al dl AHFAL A AN WU oA D, 2l A s
g4l olgarlA Ao (sorting) sdami 20d B, 321 Yzt ¥ Gl #HHL sllsaqrl wBu kellui
Guest . A 20 W o Slad ¥ NH QU dl A Ul SEDd Ad W 4. un A 2 WAk sl
awd A ¥ Saudl Qadldl D d qdl o slad uA A seald wA A ad.

Gersrat a2 2uud Reusfloledl o adl. su Redl Wl awd ga o Aney & 4 Nl szal
W2 wA AR2 Rie dwiR &0l 4R NA Gl s34 (D DA Bua uddl wiad) Ao sd
Wl B VoHNA sl M2 As Adl Wealle vl A gl 61740 sulen wwd 2 sva s
d usl oy« Wl sfadl Aug KA

© © @ Uuntitied 1 - OpenOffice.org Calc

File Edit View |[nsert Format TJools Data Win

L

)

p

)3
i

(k-3

No [Name|Test 1 |Test 2 Total
L Sita 56 44 100
2 Mita 60 55 115
3 Rita 65 70 135

4
5

Gita | 40 | 55 | 95
Nita 30 35 65

T
[Sheet 3/3 | [Defauk T eIl I smw  J© > oj(ieo%]

wild 6,17 : adslleui ema 3 Wk
4L 6,174 Guaey 21 slad E-l Baud, Red ¥ “Total’ GuR Al s2al #2 1A wud 514 53 :

o ¥ Sladdl 32 GuR A Al ¥R QU ddl AS un Ad Gu Bus s

o sl 6.84i euldg Formatting géollR QUL Sort descending ol QU [(Ris 3.

@ %z (N

112 £922- B : 10



i o B oflw A ue a4 Ak, WL W2 I §5d Data > Sort ude s 8. vl s Qudial
olls, uelld 2. Qudlol ollsunil sort criteriadl Descending (Blad) #3) wde 5L 2w 6.194
sort JMdidl olisu-l Ay clalRis 2wua vl S,

Untitled 1 - OpenOffice.org Calc

File Edit View Insert Format Tools Data Window Help

e % . . »
- @ NSV A LD 26 -@-1@ v ual |
N 4 = ’ — ; . =
AL'E6 4 Sort Criteria Options :
ry Sort by ET
. = Ascending
1| No |N| e Ly
- undehined - @ Descending [}
2 i S o
1 Name i g
Test 1 @ Ascendin
i L—f: ;E:tstlz Descending
a 3 R 2
s 4 d
al 5 )
7
8
: |
10 |
: oK Cancel Help Reset
Sheet 3/3 [Defaul Il [so][E ][ ][ sum=1035 IE e @][180%]

2usfd 6.19 : Sort Swudial olisu

$90lg sl el ddl AS wsAl 3 Aaudl ga w135 yddl WA GUR 2wdd 8, we T 2w
oR Rita L+l Rendl) dudear B 2, 20l Reueflellll Al Slanul de s uas 2ad s,
A il WRRUM d§ w9R sl dl weud ¥ el ga d@ WA dddl wy 2w uddl eAna
wAJA B, el vl A Ay F al AS Sian GuR WS sA ¥l AR dugl 6.2040 talow wwd
aell A uRL W sead. sl 62040 sieaidal IUQRA) sl -l 52

© @ ® Untitied 1 - OpenOffice.org Calc

File Edit Yiew [nsert Format Tools Data Window Help

| | i 3 : »

$-@e NewwB Aot a6 @5 |
5 | Liberation Sans w10 |m B 4 ﬁ | | %% ﬂa I | 4 ;
3 s E = |
- D F 1 6 [ w b

A G E
No [Name|Test 1 |Test 2|Total
N 3 Rita 65 70 135
o 2 Mita 60 55 115
1
4
5

Sita 56 44 100
Gita 40 55 95
Nita 30 35 65

Il « .|_
I |[sTo] [ Sum=0 [e———e— @]80%]

wugld 620 : Glavdl sHul Mswddl 2

sali 32 AREA 2w giFlBor 113




ddl Al GUR o §5a A Al &3 wsal ua DB qouad AR uel s 48 ¥l e el
AeAAL el dl 3 i wsEl sss1UR dlsandal i B, wivd glani ¥ Rl 21 Gu ydla
&3] 2@ 13 A+l GUR Ao Fdl uA A 2t Rl AL s44HL dlsadlHdl Juet 520, GUR wrudd
3209 [Qenelalel «lseil Aadl s34l olsaal (Al saL) N agney wyd sid 4 -

® Wit %R\ : Data > Sort
® ¢ slaut U4 Name UL
o A s auwrll %, ydRaRd A o Ascending 8.

dil 32l & wudl awl A (Bes field) Gur uwl WS &3l w48 L Al WRRAR QA ¥ sl
WA Qeneffeddl yel s, d-l aoul i d-l ot ¥l R Wl Qenslel wel 8. di JaA
way o3yl (location) A Ul A« U (name) GUR A sl xSl . 1A Alg Gelgw 6,

1. Sees 6.6%0 wldl 2 k@l afullaui el s

Name Location Marks
Nita Vallabh vidyanagar 65
Gita Anand 95
Sita Baroda 100
Mita Ahmedabad 115
Rita Gandhinagar 135
Kavita Vallabh vidyanagar 110
Punita Ahmedabad 105
Sangita Anand 8
Sunita Ahmedabad 70
Babita Anand %0

A2s 6.6 @ W A WS Al 321
A wd Y wie R

Wwie $A: Data > Sort

2
3
4. Sort by Betil "Location” ude $.
5. Then by Beti "Marks” Wie %R
6

dd OK ol2q eolldl

s ol Bual wugl 62100 euldl 8.

114 FR22-2UA 10



Untitled 1 - Ope

ice.org Calc

File Edit View |[nsert Format Tools Data Window Help

. - 1L 3 R »
6 Ll INE®ITEAUE-216- @il §
l - 1 »
LI 0 sot W
Al:C11 i Sort Criteria Options
7y . Sort by
Location r @ Ascending —a
1 o - Descending
y Nlta—, Then by
] Glta— Marks : @ Ascending
4 Sita - =— Descending
s Mita | ™enby
6 F - undefined - : @ Ascending
ocem crenanal I o Descending
7 Kavita
8 Punita |
3 Sangita
10 Sunita
11 Babita ' - ; It
DA, sheetl L} o | ancel | | belp || Beset ||
WIDE?BUIE ][ ] E]:” Sum=970_ ; _[_:_ — - @U_l_-ﬂiqj_

sl 621 : widu [Asel

L ol uadivddl e sl ude sdl 2L uud location (oul) A uedl marks (&) GWR
Ale ud (GDscudl). il 2 W wu % Ahmedabad - o) Rene(ill wel dd Aaden @
3dl sHHl (A2 w09 oL Al Renell wan) wod, 3l location Azdl s+ A sl Qauell
Ahmedabad Awa4 ¥ Vallabh Vidyanagar »ladi iad, 20lé s3el 2l 2wl 6.2240 salew
Fdl twud, A 32 QU A ad ol daad A ua G wA WL

2 © ® Untitied 1 - OpenOffice.org Calc

File Edit View |nsert Format Tools Data Window Halp

-Gl INSEIVE s D0 &l v il

% | Liberation Sans B (0o im A 4 A== 2 B | % | .

F12 o fo X = | |
A B C D | 3

1 [Name Location Marks |

2 |Sunita Ahmedabad 70

5 [Punita  |[Ahmedabad 105!

4 [Mita Ahmedabad 115

5 |Sangita |Anand 85

6 [Babita Anand 90

7 |Gita Anand 95

& |Sita Baroda 100

9 |Rita Gandhinagar 135

10 |Nita Vallabh vidyanagar 65

11 |[Kavita Vallabh vidyanagar 110 L&

Sheet 2 /3 = [Default I |[sTo] ][] Sum=0 I[e @]|140|':a|

Ealnl Y2 ARE A gidlRa



321 [Azig (Data filtering)

21 (Ze2RoL duvetn 2t suolld Breaargdl 2L g2 RAml Hee 2 8 wA dadl ¥ Su9 d ¥ 2L Y
S8, Wy gHel ¥ WG [Rewsmi W s34l 2t ¥ ¥l QRenslfldAl un e oyl QA g,
dl @l wel 2udl 2 Gur As Res (Reeafilter) GAIA. @R 3 2uvd A QRenelfeldl suRdl
Aal $%dlR ¢l § FA 100 el 100 sdl 4wl @ oo @ W gl sa W2 WA
Bezz wuRl {2 W G i :

1. wwsl 62340 eulen WL Data > AutoFilter ude s d ¢uld adelle ¥ il udal ail
1 eve sl B d UL Al asl el

2 @ @ Untitled 1 - OpenoOffice.org Calc
File Edit View Insert Format Tools - Window Help

Define Range... »
Select Range... B
" I DataForm... Standard Filter...
Al LY Jes Z B Subtotals... Advanced Filter... |
A validity... | E |
1 Name LOCEtiDﬂ Multiple Operations... _
2 Sunita Ahmedab e
- Consolidate...
3 Punita Ahmedab e R
4 Mita Ahmedab e
s Sangita |Anand Riiosh Bange 85
6 Babita Anand 90
7 Gita Anand 95
8 Sita Baroda 100
s Rita Gandhinagar 135
10 Nita Vallabh vidyanagar 65
1 Kavita Vallabh vidyanagar 110 L
M4 ) O Sheet]l Ay Sheetay 1« : |
[Sheet 2/3 | [ Default I |[so] [ ][ ] Sum=970 B o— @|[140%]

gl 623 : wie s 2 Gur (FeR awy s
2. 835 Slawsil Hd ad QuaG- A (dropdown arrows) AS wsel.

3. [Fas 53 A8 Dsy slem (2] Marks )il dlR(AAA) wsdl vl viA Bod v . ¥4, d U8
gud sl Gudl vl qisuue (phrases) 3 5 uddi 10 4% <93, A dl 516 RRre Rsey
ASl U dl dd standard filter waie 57 sl 6,244 enlewt WD quiell Bad) uale s

4. @ AS wsa 3 BWeallewi ¥ Qeuadldl 3@ 100 sl et gl A duollA g2 530 €l B. gl
62541 sulan uwd -l sieandel 3oL 3 ¥ Jedls Y2l ouelld g2 &l @ A Yud B, Ad sel
al Rdlae & edl

§9 ude 4 :Data > Filter > AuntoFilter ¥l Berd s o wy

116 $Ry22-2UA : 10



Untitled 1 - OpenOffi

File Edit View Insert Fogrmat

ce.org Calc

Tools Data Window Help

ey

1 Nan Operator Field name Condition value I
2 Sun Marks ol & B k= -

3 Pun * =

a Mitz -

s San > N :

6 Largest

: Oty el R s o

s Sita Baroda L

3 Rita Gandhinagar gﬁ!‘i&?'ﬂlwnw.;h

10 Nita Vallabh Vidyanaga|EndS\\'lth . )

u Kavita Vallabh vidyanagar——— '”'“'.L.w; I
o4 v EIERR Sheet2 FT 11 .

I |

-
| | |

|

© Standard Filter
| Filter criteria . ‘

sl 624 : Standard filter SwaldL oy

2 © @ Uuntitled 1 - OpenOffice.org Calc

Eile Edit View Insert Format Tools Data Window Help

b - LEA| IDNESEIVE - DR-A1%- -l@ 0 |
& B mA4A|EE “ %ol §
AL:C11 [ fo ¥ = [marks |
A 8 | C D E | A

! [Name -JLocation -IMarks =

3 [Punita Ahmedabad 105

4 |Mita Ahmedabad i

8 [Sita Baroda 100

9 |Rita Gandhinagar 185

1 |Kavita Vallabh vidyanagar 110

12

13

14

15

16

17 T -
MONOA Sheetl YTy SHESIAY, i+ '.'.='_’Irl'_'l!
Sheet2/3 || Default 1L J[so] ]I Sum=565 lle - -

2ugld 625

321 asuell (Data Validations)

29UE YU dq d WS Bheallz Waasel) Guulol Rl R3ANR Fai & A4 QuIR 59, wiA ruRAifly [Rsdng
AR2 Wl QWR Ll 217 Rene(foiieil WReun-L Risauei i 8. vu Bruml A di -y (valid) URd vl
sl dl o du Al Yol L [AB) w1 uReus U, B 3, Rzl Guadolsd] ddan e 21 siuie 523 Al
AS vl vid] 2sg el 321 elvie sl uHd ) el (2le1ar) 2 20U 321 A (data validations)-)
Guulal s3I sl . Al Wel ARl WAl & (i 8) dl vdl saL W2 Ad e A w4
Data - Validity %122 3wl 2uell 2u4la 62641 ealey W Validity uelivl olisy wad).

Salui Y2 ARBa wA AR

: sufed ((Beef) a1



marks 1.ods - OpenOffi

File Edit View |Insert Format Tools Data Window Help

- P : i’ . g [ z »
O SO L E® s Al @ v
) E SE _ - — — 00 »
SR o validity [ El |
G10 Criteria Input Help Error Alert E
4 . : RN
T—N Allow Cell range =
—_— 3 All values
2 o Whole Numbers
==L 3 Decimal
3 £ Date
__] Time
;__4- Cell range
5 2 éource List h
- Text length contiguous selection of rows
6 - and columns, or a formula that results in an area or array
7| |
8 | |
2 |
10
11 |
12 |
13 | oK cancel Help Reset c
M4 nl = — S |
[Sheet 3/3 | [Default I [[so][ ][ ]I Sum=0 I[e o ®@][140%]

wisld 626 : Vvalidityru [QAsad
¥ 2 dd GudoLsal WAl Aadl B Al W2 ¢ Al uadl Qe A2 50 AN Bl w2
gluld ol Asal 2 R gl F2efls vilamsdivl (Adl) A2 531 AL B0 vuARSABHL Ae
Rrdr, ol Budl, ssd yals vl eva s2dl, $5d dilvl % ey Avdl adliqdl auda ay
8, ¥+l W2 Cell range, All values, $5d Whole numbers ¥l Date dil3 [RAsedl i 8. Al WSl
AR S Criteria 200 aY viigld 6.2640 euled WA 43 wilA el ol 261 Input Help
B Fell A 2l evia sdl ANA A Gudasdld Asie yIl wdl wdA gl

2 GURid 2 g Error Alert ¢ot U 8 3 ® 45 o wy dl o@ W2 As Aaaell (ad)
20 8, gl 3 iug AT 3 A dil Delete Contents [ASiell Format viaql Delete All
e LR dl al A2 sdl Validity [@sedl g sl iad.

Sllui @0 WBwd (Other operations in Calc)

3l 2 iels Gualell WBAL YA U B, ¥ ¥, vide stk ARl (RARN ) usuel, wbes avir
Ag A otead, abelle srudl a3 vl Jeaws Rsel-ll wdl 2 R Al 530 8.

oidelldl asuel (Spelling check)

Yl afelloui Rl 28u sadl avid wellar Guiloisdl vidle-d ARPML o &3 B, ell wuas
asell (AUL) sl Y& 2ud B, A diL 2esuR Gurs Spelling check die-t (& % 21 sle B i1
dn 2l & ullg 530 wny B) il Avlg ¢ ol w2 Ad avudal acel die vl il Yd. R iS55
ol2) gte (RARDPIAL ea) a4 s dl d wserdll (A alg 2l WA A ase didaide 4l dHR §5d Al
Gur U2 (Fas Rl ¥3R dlu B viA w1l uea(lpii]l Doy [Asen we s el s M2
il asehlaxil Guulal $3 8. A adl elve sd)l Ase A o WRIdL W asefami Holl My dl A e W2
ol »1d B, R 62741 ARl Asell A YU WAl s Bsey eafon B,

118 SUY23-UA ¢ 10



Untitied 1 - OpenOffice.org Calc

File Edit View Insert Format Tools Data Window Help

- g ) 3 A z B
& " law | |T~.!E|n?f?%'|N"_:r_.'ﬂ| = '|U % wall a
Spelling: English (USA) [ 4 ;
- ! Text language | English (USA) = :I
l Not in dictionary =
i ' Moniter . lgnore Once E
| Ignore All
2 1
D v Add -
3 81 Suggestions
|| Monster " hange
4 'k‘ Monitor - 2o
Il Moniker
| Change All
5 Monition -
I! Masonite
6 MonifL____
7 ; Help Options... ! Clgse
8
9
10 h
[sheet1/3 | [Defautt i J[so][H][ ]| Sum=0 [@ o o|[162%]

agld 627 : el unuelu RAsed

s AHA A UL oA & Ak WAL U P BUF UM, URL A UE WG ASEHUNL A U i
Boatth aqRL ~ud (A u a3 6 uk ! wdl wWRRAR anda W2 g um “Add to
dictionery" [RAsed a3 wsesanl GAIL sl d wedl dily Un w doe ddld eldande ud «dl.
ARl usiell sral W+l As A wol  wal §suq 4 F7A eonaaidl, uAd Al usinawg
anal W2 dad W ¥HE wie s3 w8l : Format = Cells > Font language=[None]

dlug w1 eigad (Find and Replace)

Find and Replace »u12a afyllenl wjor syl wRdl Q21) sl A Aadi wbes aum § fea
AYeEiug vadl Wik A sedal W2 auaa B, 3l s se R A wel waai el

e Wit U : Edit - Find & Replace
® Find & Replace Qudlol ollsadl ygoaui wuddl 33l Bl s
Ys@ (Printing)

afallenl Hlel seqd 518 afelle eoyal w2 (R 2) v sl #3308, wwe-uBus (ad NAAR)
Algadrell ¥ Blsalle RMAAPLIAL erdidys ud FBid Al d wids 2l ¢Qn () u Qell gAa
(Slan) a ofeidel srcid Ay Ul oiadudl « uaL 2ud. 20 Gurid d2dls WRA sws @My An
uel o, ayui, 2l adallz ol #3dl ya <l &l 2], A5 uel skudy wiudl udel, print
preview (3gal Ydd viadlsd) Rsen aiurdl adiwe] 8. print preview Rseuw wie 43 wu d
Fandl (A6 ds) A giRu () w8 Walledl gvia YA uR B, adalle- yaladisd (Bisy)
W2 A wwe widi @R :

® Wit U : File > Page Preview

o el 5w Wldrl Guanil cwol g 62840 eulon WA Wy R (bar) HaL 0. d
gl yaladls 2 auasdl Gualoel 4 4 A Guied euld 8.
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@ W ‘I Format Page  Margins @ o @ Close Preview

sl 628 : yaladist (Bey) o
Yoy sudHA ue s WD 3R] UBARA s wdlA dlA gl 62841 culdal Asa el ¥el
Bual w2 8, a-dl wel shes 6741 2wl 8.
dna aglr
Uidl sigdal
Seal Well U usiyal
oM gd
1L WA UL Bl
Wil AR W queon ollsu vilaal W2
gl galaa
gl
Ry oy s

sres 6.7 : ydladist [Asedl

Wil yaladls« weilsl sEIRo Badl A2 sl 2 e aud 8, weid SR (page formatting)
Sa w2 Ay woal @i :

® Wit 5A: File > Page Preview

e Wl Gu uelld gl dudla olisunidl Format Page o2 esudl

o s 62041 salon YA Page Style -undl duelal sllsumi Page avlal [Ronad wie $3.
e %3dl ueoflall wae 531 OK o2 eoudl uRaddldl Aje s

o0 | =J [ ON | | W D

File Edit View Insert Format Tools Data Window Help

- — »
& -l I 5 s R S [ i) X
| (M) | &, &, 2] |[FommatPage | Margins  © Tt =0 Chse Provien. |}
© Page Style: Default A |
Organizer Page Borders Background Header Footer Sheet
Paper format
Format Letter -
Width 8.50" A
Height 11.00" >
Orientation @ Portrait
Landscape Paper Lray [From printer settingsl
Margins Layout settings
Left 0.79" B Page layout [Right and left A
Right 0.79" A Format 1o 2y 30 een &
Top 0.79"- + Table alignment Horigontal
Bottom 0.79° & yertical
i — ok || gancel | | Reset e
TR et =Ty

-'bll.g[?l 6.29 : Page formating-il [Qsen

120 $222-uur : 10



dd Yyt Wy (Formaf) A4, dldlg vadl S5 us $RBA Wi seedll wiedll A0 us) ol A
Margins Al siofl ougy, oniel sy, GuR #d QA WHq (¢iRw) Az A wh 8, 2w RAsedl
Guld dil v~y Page formatting-ll [Asedlrl W $3) 95\ : Paper Tray [Qsed 3 9l Gu+{l 2uidl
3 QAL 2uidl adg ue Beeani 3wad A oeudd] §W 8 24 Page Layout [Rseudl Guaal
Aol AL WY B W Hs GRS WAl GU dN W sl AW Uil ol €. Formatell waiesll
wd we ¥ Go) weq ¥q Orientation wRUAdL U2 ua WY B.

o dil 2udl ¢Aadl Haal, Gefl ¢Auel Haal WA A4 A (Aal 2wy B2l wd) vual
Suodl &l dl (A aeuen wEldl Bual s

Wit 50 : Format > Page ¥& Juelol ollsd 244 Gu Nelid ad,

il ([Aseuzd, wie 43\ File > Page Preview v\ Format Page o2l gsldl

89 Sheet 2ot wldl (vuglani Beal o)

vigla 6,304 eale WA Grid Asolisua Rs s (FRUs s2cell vl Raurl solsuni 2und).
¢d Column and row headers Asollsn Rs 3.

Jduellal sl 68 5.

Untitied 1: 4 - OpenOffice.org Cailc

Eile Edit View |[nsert Format Tools Data Window Help

L =l @ Page Style: Defauit [

| Organizer Page Borders Background Header Footer Sheet I

Page order

@ Top to bottom. then right ' 1l

Left to right. then down | m :

& First page number 1 ¥ ==

Print

of Column and row headers

@Gid [y

uf Charts

wl Drawing objects

Comments Formulas
Objects/graphics o Zero yalues
Scale
Scaling mode
Reducefenlarge printout e Scaling factor 100
OK GCancel || Help Reset
[Page1/0  |[Default || || (N [@e ®][32% |

2l 630 : column and row headers dd ¥ cell gridsh A2 sl

Borders 261l GualaL s317 ddl 320, Bul2l yer ol a8 o), dd B-udlsil (borders) A2 sell iy
Rsedl R Brudldl wsi2, Breudls 100 w1 l2-l 2as R uie 53l 26 6L g0 63140 Aadl Bl
A2 sl Rsedl calen 8. 3y AR d wad (W) A2 530 € wll OK o2 esudl. d wedl d
et yaladlsn 530 a8l wusld 6,310 ald DI Beul duy v sdan 321 ol walgoy 2 2t
yaladls (o1 dolRan siou i Q el 8) culdg 8. o & yaladls sAal 32 Borders, cell
headers ¥\ background A2 s4l el A4 Page Preview™l o W .
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EFile Edit View |[nsert Fgrmat TJools Pata

A Y § - g . »
O - § Page Style: Default W
| | Organizer Page Borders Background Header Footer Sheet I
Line arrangement Line Spacing to contenis
Defauk Style Left 0.00
OOOS0 | -t =
: taF b_ " == 0.05 pt Right 0.0
adrcame - 0.50 pt Top 0.00
1.00 pt -
8 : 2.50 pt Bottom 0.00
5 00 pt v o Synchronize
Color
- -
Bl Red 4 — || -
Shadow style _ | A B o] [ £
mienls || 1 [No [Name[Test I [Test 2|Total
—— |2 [ 5 [ Nita | 30 35 | 65
DSooo B
Preview fT—T%m [ 5 | 44 | 100
s | 2 [Mta| 60 [ 55 [ 115
IL 6] 3 |Rita 65 70 | 135
el __
T TS I ) Tl

2u4(d 631 : Borders 2 Background ¥2 5l

ayd eds [Qsew 2 83z Az 4 any A udl al el Gua-dl QA Well Bz 2 GuR
ghd BUs sAA srcidyr edl wsl ),

Uy Qs tedd (Modifying page breaks)
Wi yi wa ddl G (A8 6ls) dal v dd seaql w2 0AA Buivd s
® Wit $A: View > Page Break Preview

o W dil Wil eviadl AR € dl ad A B 30 w9 ol dlar audl ¥3Rud wwd dAAd
wafld (3oL s3) Sy As siedl.

Al 2URY View > Normal Uyl di sl ABPU<d 2uia AS usl ol
RECEETE §2% (Header and Footer)

eds Wl Gua+ll sugd uel eds weledl JAL ouy Al Q@i W-iHd Aviami 2wd B,
Guadl A flAl RARA 2 &R (header) il §2R (footer) sl »ud 8.

Q4 oirldal w2 +{ld wuE el WY :
® Wit 53 : File=> Page Preview - Format
® 83 Header 26 W) i Qi el Edit ol2qa o) ¥ %330 wRad-l s

aflldl 8 A ek [ARARA AR cudul [Aoulrd Rant wd & @ ofl suyd [RdR, u [@AdR
A el gl [RrdiR. dA 2l [RARHL ¥ 46 dvll 8l d 2udlzun kddemi GRS ¥, sl
6.3241 AR G suldg B,
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LIS Organizer Page Borders Background Header Footer Sheet

{ Header »
& - = |
e i wf Header on .
| & Same content left/right .
Left margin 0.00 s R
Right margin 0.00" -
Spacing 0.10 =
Height 0.20 &
& AutoFit height
| More... Edit... h"
© Header (Page Style: Default)
Left area Center area Right area oK .
heel2
Cancel
. Hep
v
; H_ d ' A e
Page 1 { il Sheet? ' :ﬁ:]

susld 632 : &3 Girg

uge Anadl — (Getting help)

-l vigx ¥ QRN sdl v w6 addl Hee Aqaql W2 WwieRis (manual) WA
8. A6 Bu suoid WRA el w2 Qi (Gelui) wd (search) B Yl wsasi 2wd B,
W2 dMR §5d Help > OpenOffice.org Help 228 20udl Ul 8. 2l dil Hee Al 3z
B D O AR 2usfd 63340 eulall Wbl 2wl vl il oflA W Ry 4 o) Gurell
F1 &3+ $l ool 8.

2 © @ openoffice.org Help - OpenoOffice.org Calc
|Openofiice.org Cale = | 2SS [@ =3

Contents Index Find Bookmarks

Search term

|
|| (Dchons Welcome to the

aigring toa cel - |OpenOffice.org Calc Help |

J recognizing i

#NAME error message
#REF error message

| 12 replacement How to Work With OpenOffice.org Calc
| 3D'chart: : - !
| 3D ::E; csreaz,oﬂ Instructions for Using OpenOffice.org Calc

abbreviation replacement OpenOffice.org Calc Features

ABS function : ;s

absolute addresses in spreadsheets List of Functions by Category

absolute hyperiinks
absolute references in spreadsheets
i absolute saving of URLs

Using Charts in OpenOffice.org

Hl accents OpenoOffice.org Calc Menus, Toolbars,
= =1L
Access databases {base) and Keys
i access rights for database tables (Base)
|| accessibility Menus
| general shortcuts
L OpenOffice.org assistive technology Toolbars
OpenOffice.org Calc shortcuts Shortcut Keys for Spreadsheets
B OpenCffice.org features
options
! ACCRINT function Help about the Help
| ACCRINTM function v

bl o«

The OpenOffice.org Help Window

:u.gla 633 : uge Anad)

Exlni Y21 ARBa A ¢k 123




AR

vl wsRl vl kel Wealledl 2 visls qd 9 sl |2 6oy, ABa (lsaell) v
Alide (usuell) B sioid v wuudl Vsallz studl Buad QA Mgy ¥ ¥ <Al & dud
£y viddld, erldyd sl duy we Siilenl Aue Rad Ay s18d Guarll v Buisl
Fdl ¥ excidys udld ¥ el scuqd s W sud B, . Guid W2 sl Busd &d
3 oalled v sedd wA dlledl 39 ogad), dlz GARAL 3 g2 sddl adll ousid @A um flbu,
Bl WSWHL 2UEL 3L Ui A saudl A A duw Slem sau-l Basdl susid gL lleyl, vuwd
-l olsasll, Y2l asel wd wa @RY sl 1R Buasd Fdl 3 iy Aau ulkdl
eRalAl WBw (WABa »uiud), dR »d 522 A2 s, LAY Qe Rq, Al asusl
Rl dxy uge Amgdl 493 ousid @A wel v

N @ =1 A R W N e

11.

ey
il «dl gadldar 46 A ol wsy A ANl
30l aselled it 58 A cedl sy A ddl L &5 A sedl wmu A WAl
dalii adellz 5§ dd GARl asu @A quuddl afdle g2 3l wsu A wiAAL
Al Wl WRA g2 R Gu gy ln av,
Il wARa 2¢ &5 Ad sd 2 B A AuAdl
dRll-u deoldi wla wqis A MNa WHis aHnel,
2l Feied (Beelol) Gur g5 -l vl
Jal soig olsasll (ARo) Gu s -iw avi,
2 uasel 4 B 7 d w2 w3l B A @l d 55 Ad £ B A wnadl

QM B2 sl auid 3R ud g2 &5 d GAI sy A AL
{3 wwilal Rseddifl Doy [Asen wie & :

(1) ~0A-uniel &8 SR 27 sy s1+l ¥+ 3 Azl $44L 3 Bldrdl s+ dsaald sl
8 Y7

(a) 2l SR (b) 32 ARy
(c) a1 ReeRaL (@ 32 Wlka
(2) Al &5d A % e R W2 (AUl 5§ LR A S ?
(a) 2L SWIRa (b) Y21 AR
(c) 32 (el @ 3a Wk
(3) DAl s [Ase 2 WAe AN WA B R oL 2l ARA3AA g K1 B ?
(a) Delete formatting (b) Delete all
(¢) Delete formula (d) Delete me

SRY2-UYA : 10



(4) ¥l 5§ worasell 2Rl B sdi duY Rl A wse oeedl AW Yl ?

(a) Find & Replace (b) $5d Replace A

(c) Copy vugudl (d) Priview ueael
(5) U Moy «[Arniedl s AGsL w2 wawwpdll »ud & ?

(a) Borders (b) Margins

(¢) Column and row heading (@) el and Rsedl
(6) sl asel w2 Ielui s §saq S Guydol aw & ?

(a) F1 ®) F2 (c) F4 (d) F7
(7) 3eflni wee Aqaar w2 A-unidl &5 dsud Al Gualol wy & ?

(a) F1 (b) F2 (c) F4 @ F7
(8) ol AU sHdl dsaal Wl wBwA o4 s B ?

(2) A2 ®) ¥R (c) BelRa (d) ARG
(9) Buaargdl e onulld g2 sacuel uBwA 9 &8 & ?

(2) A2 ®) A& (c) BeRa (d) ARG
(10) 3aa -y 2 o evia sl WBUA ¢ 3 ) ?

(2) Ao ®) uBEa (c) BeRat (d) ARG

I ECRESTE O]

1. 3l de Save as Asey AudlA 2 Slalzd] Ag &3 ail ¥ Sllewl das sl
d Ae2drD Gullal A AR vl

2. kll ©dy wlel vl Sheet 260 X Qul 7 2 GAR, AR ul A Aawgan P FU
3 wod]l, aieefl o1 ... @33l eds el L ooteel. d wl wid A ¥ 35 2 A wwd-n
Wil B 3 34 wed 3 awrdll Wil W2 cqieull Pl sz & adll.

3. e AR G AWARBE ga-l Gudlal LR

4. 8 alv R AR 2 Al gl 35 Aadi 15-08-2013 avil drll sugell Aaui o uglll
ARl @vil. 20 URAA A udlda e Aaui PL A A seldRA Guadlal s3 ks AR
oirladl Hdcl 3L,

5. wefadi dwg ud GIA Fell durl -wn DA ala dldl wella 4w,

6. au Bl s wel dusll a-saidlv Ad-l si-idl, @R uedl d welA City 27 wedl Names-il
sl olsdl. el sl el fA wwd d:

sl 32 WREa wA glllEa 125



Name Address in City Mobile Email Date Month Year
one line no of Birth | of Birth of Birth

Khushi | 1, Gokul Park | Anand | ..... 01 July 1995

7. W WIRAYAL GelgwW 6H1 Qi s3ell Bod-l weld ¥ Ad Beey s 3 ¥l 55 N Bl
WRA ueBld wy el w-uddlvl Wowe waudl &,

8. Sorting A Filtering QA Help 43 WwRdl Aadl. »u @yl Gu Helpdl Gudlal s34 «ln
QUR SR,

9. 2 asuel{Aldacd)dl Aladl Gualal i L wRUYAL GEld 6L Elud sl 32l GuylaL
504 date of birth Sladd s 2l A6 Ald ARleei 33 Fdl Awi emd 530 4 b
Al 2l A Ad wmAdl W ¥l A ARluAdl Badnl ssa 1 o 310 v o sl

126 FR22-2UA 10



ofRa (eldl dairll 52903 2 yason waRl 2u (Rrdnel WRddl aRd@s gFas RFERDAL w9t
2 217 AW SRS uelafivl slvia sl qell avtd Yaell 4l 2L wsRdl sl s W2 IR0 Fal
Wsalle W uRils, alds, Nishble, aHd A Adv, WAL A WBRs dviel duer vyl
ARl @dldl WRa RANA duedl e o W du d a3l yai wd 8.

A velalil 9 QAU azvsidni susid Ra (=), d wsl Rl wn W dell Sianl ¥is vaal
qty [A8udi a4 (argument) oenadidl wd 8. ugllaR @AY WA o WA "+ (axid R&) Fal
UBUs (operator) uRt Al wsy B, A & RAuA s wel woRs avie dA 2wman W2 ydo adld
= (o) Re Al As wn usudl 8. RACL va (ufde) dd AS Buq, e
WAL, wloes arun, wd Bud vigal A5 3 awd QAW & ud. wsel 5HL 2uuEl 2asur Guel
(WALl Brarl GerdRdl) sum (R34 Guadal sl gdl. A wouA U zasuz Gudll (R R
T o culda B F s wsrel g8 Rl B.) Y sum BAY @) W 8. A ¥ QAL gk
=SUM(A1:A10) avll 254, ¥4l SUM 3. RAu Ay, aeon-d aBasd Gudol il @ a- [y
5380, A AT dul A10 el 3 o adelle-it Aa-l Rifa 52 B, Aa A1 ol A10 9s Wl (A1:A10) R
s Aa-l QAR (range) weud B FHL 10 NG W21 Ad . RAAAL A yedl S0 avledl Rkdl
B84 utarl ¥4 (argument of the function) di13 Wi &, RAU-L Ad dk A Ad Wiy
wudl A4 R sed ULl A8 wAd Bud, ¥4 3, =SUM(23,25) uaL auvll asla.

2 o Al se1d dd Ad @S Al 211 A10 <A Rl () A aed A@AA () uaal xRN ()
Gudlal s30A RAY =SUM(A1:A10) Yacl S $9L Y@ vl dA Fdlam 431 a8l 3 1) vaal 1«
g5d Guilol sl Ad Al A A4 AL0 Bl dail o s3] asa, uaL A A Aldl A10
Y ot o Aarll Budldl a0 529 Sld dl R 2 vigdl o4l % Ad WL-Ls gel el W2d )
=SUM(A1,A2,A3,A4,A5,A6,A7,A8,A9,A10) dAMcl ASA,

250 7.140 uRaou-ll Bu set Fld 530 asy A salef B, ddl we sial Aanl Bad (SUM=55) A
siafal ol WAl 2l uetald AS w8l Sl dil 3 ur b 43 & 3 rwd Yol Al) FEa
KAl 20d 8 dl del W AR S A Ad Al W YRl oRL 8. 3 ugld evd s3al Yol a
Anaa] ($laAs a0 wIvR ve Guilel v 8.

RAu($5u)d wla saai-l uBu sr @AY w12 Asuandl 28 B, RAu-AL sy ad (wwsyd-2) uA
RAUAL AL 2l oAl el MM 8. W2d 3 AS uel RAYUHA) Gudat sdL W2 U A Alus
o3l ue WA RAY 6@ qoRq Aud (u) AR eva s2q ¢33 B, wel Rl asuas
(AAuAL (Al syntax) sdatsil wud 8. o 208 @A il WAl ARl WA ddl AsA A4 ALl
4 AN dl d sl Wk

selli Ay 127



X 1 55 Using ¥

: 2 55 SUM(A1:A10)

3 3 55 =SUM(A1,A2 A3,A4 A5 A6 A7 A8 A9 A10)

4 4

5 5

6 o

7 7

8 8

9 o

10 10 [\}

11
W40 T \sheet1 (SFe7 fSReesy ] « B 71 |
[Sheet 1/3 || Default |[nser][sto][ L ][ { Sum=55 -.\, 0 @|[152%]

vugld 7.1 : @ Ad vl sl Ga

Aqul RAY elud sral W2 A wdl sl R :
o % Aaul and uReny wellld s394 du d A4 yae s,

e ¢d [R8y elva sl 23d = Bla Wl KR, A d = R A qull (AL w1 e JA1ds
g4 3 "+"), dl d QY Ay wlRs auuer adld aeudl.

o [RAud U elvd s

o qd ugl A Aa e R
o ¢d - 4 goudl.

dsa- [Aond (Function Wizard)

2dolR GUR s RADAL w8 vl (U A WAl el Gua-l ) maar wuE awm
RANA ausua WA e AvdL sy Aol el qell Wi @A) §suq A (function wizard) a3
gluld S0l w4 B,

§5url Bl Gualal (1A galdell Ad wa B :
o % Adui wReuy welld s S A Ad e s

® UdE 53 : Imsert > Function. 2l 514 dil wDdal sz exdidenii Cerl wa F2 esudld ua
&3 w8 L

o Ul Rseuzd ad suglR 7.240 eafen wud sfal gaeu GurAi Function Wizard S8
goudld wel d s1d 4 sl 6L

128 SR2- YA ¢ 10



E3

v f z — |
A | B |Function Wizard

2l 7.2 : s Rond

o el 2y Qualol ollsA Al Gu 2uud. udid slisuniel o339l By wAe A wugla 7.3 2

sl Qudlal ollsu caldd 8.

€ Function Wizard

Functions Structure
Category
All

Eunction

SMALL

SQRT

SORTF
STANDARDIZE
STDEV
STDEVA
STDEVP
STDEVPA
STEYX

STYLE
SUBSTITUTE
SUBTOTAL
SuUM

SUMIF
SUMPRODUCT

Array

Functions Structure

Category
Mathematical
Eunction

QUOTIENT
RADIANS
RAND
RANDBETWEEN
ROUND
ROUNDDOWN
ROUNDUP
SERIESSUM
SIGN

SIN

SINH

SQRT

SQRTPI
SUBTOTAL
SUM

Array

Scllni [RRa

Help

Function result | |

SUmM
SUM( number 1, number 2, ... )

Returns the sum of all arguments.

Formula Result |

Cancel

Motz | o

sl 7.3 : dsurt Rondq Sueivl olisu
e SUM [8y wiie 4. d udl Next ote eoudl.

o (Bl smva 53 vaal asellenid]l RAUAL ad yae s, il afd 30 wal Bad), wndis (REa)

wudl Rz 3s vl Wg erva 53 A 6L gl 7440 ealon YA dd number 1, number
2, ... A3 ealdlA wadl wgl A wh oL

© Function Wizard

*

Help

SUM Function result ID |

Returns the sum of all arguments.

number 1 (required)

Number 1. number 2, ..
calculated

are 1 to 30 arguments whose total is to be

number 1 | fx Tg[: s
number 2 | fi —@
number 3 | fe (]
number 4 | fiy z &

Formula Result IO
=SUM() 4
Cancel << Back Next >= oK

vugld 7.4 : QRuul w4 sma s



o 2 ad dvadl Baud 3 Aafled A 54l D A A 2@dl & dl dd adellznial Al ude s
2694l

® Values e g9l W2 gl 7.401 G-l dlRY] ealdan Select orer-l Gudlal 53

® A adl Select sz g8ladl dl A dxAl afsfle-i Radirul ad ¥d. §sa Roandd v quelal
oll5A s ~lledl AR U dedlRunl URAA 4 o, 4 GUR dll adelle AR dn -
uld §sud Al A6 asll ¢d d G Audld A ¥ Ad AR e RA W2 Ysd Bl
vyl 7.540 i wdd (minimised) 5 Rond (oF] Ivi A doARA eulda B) wid abyl2
Rrdik elddl 8. % J2il adl @ HRLadL €L A adsuet Wlenl Guasy 4 A dL dil sy lz GwR
w2 %S A 9l §suel AR GuR A 2L sl viueu Bkl A Sheetl:Al:10 8.

A 8 ] C I

1 55 USiI‘rg z Maximize button
55 SUM(A1:A10)

55 SUM(AL A2 A3 A4 A5 A6 A7 AB A9 ALD)

o|lw|a| w
|I:-(.dl\)~

Select data from worksheet and
press Maximize button

]

O W~ oWwm

=

————— - 0 ] I [
gl 7.5 ¢ Select tiz 4 A4 [rdR wrie 2
o 2 s sul ul Enter 4 »1uel Maximize tt2t (dugla 7.540 D3¢ adn) esudl. gl 7.540
galon Wl &30 2] fsudd RS Wl GuR vl ad AS usdl ¥ dil wie el a1 AR
number 1+l ollsAni 2eusuA B,
o s Yol sal W2 uA 6t 5391 W2 OK e golldl.

3xll QRY el d-l ¥iex ¥ wwddl (built-in) 3ds RAD Y2 W 8. yeu Aelxdqi RANA]
AMBRRS, Ay, s ¢ WERs @run-i SHARA @l RAD B, >0 ad As QAL A a3
2y A6 QAR Gualol 2L sl €1l o RAY-L -l 2ier 22 sl (text cursor) AR
RANA welniel g [R3 wrie 4.

suldlas QAL (Mathematical fanctions)

ol AR Tl Av) W s sAA A AR URRS RAN 2wuaA v Hes3u onl B, we),
¢4 R F2dis suRIRS AAuA)L Gualol S

vl R Bud (Absolute values of numbers)

ABS QY amel Avqidiefl Be Ra (—) 62 43 8 A Avdid YA o 8. A 0 (Yed) 3 4 dvapd

S8 FER sq ll. Al asndl (RiRsd) ABS (o) 8, w4l n Ws dv 8, 2usQ 7.680 ABS
RAu- 414 euldg B. ad slfan sur Gur QAU Yo (RAdsR Rld) va AS 26 6L

130 $R22- U : 10



| '

" Value of n: -13
=ABS(B1)

* Function used:
' Value of ABS(n): 13

auhld 7.6 : ABS [QRuq sl

U I S5 Ul Avuiedl o w3 A A AvA ABS RAY g, Gualell wy 8, WA 3 ad s
velaf-l e oflew velalt Al w6 ol vl 2l IQll Ayan vie-l velal-ll Baua ud -
ugl gl velaledl Botarl Gualo sigiRl uelafni s aa (auadilee) i 53 ya Wl 3
a1l vglal (34 3 adlym) g5 vl 4 Adl Baud o (4 2Eal 0) ed AN S, dual yud
A viedl velalif wRRUH B 2d dl 9 wd ? vieardl velalig e wRRUH s+l yeralin
iy oeldl £ . vudl RAMR 21mal W Rl viedl velaliqi uReundAdl Fia Botdd selRr+l
uela@al Hislal e,

ldiflu R34 (Exponential fanction)

EXP (284 uidifly (@24 el Bua wesl 2ud 8. aui x 2 vude]l v & wA e ol Bud 2ued
2.718281828 stz 8. a«ll Ayl EXP(Number) 8. tld. . 2048 S A4ui = EXP(1) eyl
A el omd wd A B 2.72 wedl wnd. R 7740 2 RAY wumey B, ad i ou2
(@ls4R Rlha) Gur AU Yo AS usal

B A S — 1 R

" Value of n: | 1
=EXP(B1)|

* Function used:
|~ Value of EXP(n): 2.71828182845904

2usll 7.7 : EXP s
suyd QAu (§52R»4 §504 - Factorial function)
FACT R2u el vl suoRid @A Bud well »id 8 (14l 2«0ldl yails v n Yol
BUSR). 2 (A4l syl FACT(n) 8 o4l n 3 yals v 8.

Gewsa ddld, A U =FACT(@3), avll2l dl 3@ A1 veial (1 * 2 * 3) 2l x4 yd Bud 6
53, W o Ad FACT(6) vl 14l 6 vl oRusiR (Wed ¥ 1#2*3*4*5%6) uad »uud, & ¥
720 8. gl 7.840 Avl 6 WA R4 RAY suldg B

felui Q3 131



r fin X

==

| B
" Value of n: 6
* Function used: =FACT(BI)
E JVEUUE of FACT(n): 720

»ugld 7.8 : FACT [adu
wilds agams (Rard @QBRYH - Nataral logarithm)

LN Ry »uldl 4q dvadll yuglas agoms (agoesi sue e) Buad vad sl 8, w @yl
asayAl LN (Number) 8, %3l number 3\ el vl 8. el.d., el A6 Aqul =LN(8) @ullA d),
sl 7.940 eulow wud Q 2.08 (log,8) weuel ddld wundl.

LN Wl fo X  [-tnen

A B

" Value of n: 8
=LN(B1)

* Function used:
ilVaIue of LN(n): 2.0794415417

syl 7.9 : LN Rly
QYORLS SUNIR 10 WA (Logarithm base 10)

LOG10 RAy 2ld]l 4q aivudl agoas siw 10 Wd Bud uid 200 8, d-l asura-
LOG10(Number) 8. a4l number 3 4 v 8. Gels@t dild, LOG10(6)2 LOG{ (6 el 2ud
® A wugld 71040 euleit wud 0.77 [Baid wad =l 8.

LOG10 Bl fo X  [=Loc10(81)

A B

" Value of n: 6
=LOG10(B1)

* Function used:
;lVaIue of LOG10(n): 0.7781512504

agld 7.10 : LOGyy Ry

132 suy2-nkad : 10



il (Power)

ald (waz) RAu Avndl wadl ol sal wdldl Bad wad sl 8. ddl asura-
POWER(Number, Power) 8. % 1§ Aaxi »uud =POWER (10,3) av{lal . A 1000 (10°) Baa
Yd Wudl. d 1043 <L A3 sl B, Y3 vyl 7.11.

POWER 5 fw ¥ f [=PowerBLB2)
' Value of n: 10
* |Value of power: 3

. =POWER(B1,B2
* Function used: ( )

* Value of POWER(n, power): 1000

2usld 7.1 : POWER [Qda
Q- 28 aa-l AqAUSR (Product of many arguments)

PRODUCT [afy a3l ai 30 @Ay uduxi aa(x], x2, ..., x30)L 2RusR Wl ¥l 8. (Qux
els ud S8 s A4 3 A4 QB &1 wd. 2 Rl asyaql PRODUCT (ul, n2, n3, ..., n30)
8. W 3 wnd 2ugf 7,124 ealon wud adulleuni 21 evid s36l B,

A4 8l fw ¥ = [=PRODUCT(A1:A2.81:B2,01:D2)
A B | C | D [ ¥ E
110 il 3
1 20 2 1
3
+ 11200
5

214(Q 7.12 : PRODUCT [R2u- Gudlat 43 RAuAL 217 a4l JeusR

Y2l 3 56 A4l vyl =PRODUCT(A1:A2, B1:B2, D1:D2) aull ¢flal. v @y uReus 1200
i, wudl, 2uyel 56l wlA 3 AL product QAU A4l Wl ol Bud), Aadl [@QdiR vy W
Sl a1 Al [EBRRA buil d 8w sl JeusR s wReun 2wl 8. 2ugld 712400 Gefl
gQU (Slan) A, Slad B A siau DL e 6 Budl avldl 8. «id £ 3 siay C vudl 8,

Wiy (Square root) (SQRT [QAu)

SQRT (A4 4 vyl adlyn wigd wd 8. s AUl awsaryl SQRT(Number) 8, %4l Number
A b vyl B, 28 100 adlym dhar w2 A4S Ws Aaui =SQRT(100) $4d avig, W, xR
7.340 ealon Wi o Bad 10 ad 204l



SQRT 2 fw ¥ f [=50rTBD

A B

" Value of n: 100
=SQRT(B1)

* Function used:

;lVaIue of SQRT(n): 10

sugfd 7.13 : wiyn (SQRT) R4
yeuls vl (Integer) (INT [Q8)
INT Ry A€ el dvud Aol Aol dwsd -udl yels dvami 524 8, ddl asura

=INT(Number) 8. 24 3, B dil A5 Aaui INT (15.3) @l A sugla 7.1440 eufen wud A Rl
15 alval Wd g,

INT X fo ¥  [=Ine1)

*\Value of n: 153
* Function used: el
JVaIue of INT(n): 15

uisld 7.14 : INT R84 audlA yals v Anadl

AG~$ (Round U~ yeu )

Round QA% dad el v dil oendal salafe Y AG¢ (Zstaald) sid 83 S, aan uxd
Yol WReUAHL vl cainfia usdl ael 2isl Sl 8. Gelgarl dild vl vy & 12.6546. A
dfl eulafia udl s5d 6L o i $u9dl €l dl Bulldl Ad A A A sl A W, i o dvaeg
UGMPDL s2q WA, 21 Avl 12,6546 UGML ula 12,65 Avul Hd, Renlod-il wReun (ga d@
widl 24) vids AHA A Ad UG sl 2d B ¥ ¥efl & Ws yal v ol 8, Ned ik, A A
Rendlz 76.66 25l Rl Ao QY dl d Rendl 77 25 Anow & g ARl wd 8. ROUND
R84l a2l ROUND (Number, Places) ®. ROUND [RRu«i 32ais Geuszll 1 2udal & :

=ROUND (76.6633,2) 4 WReux 76.66 ua\.
=ROUND (45.1634,0) « uRoun 45 u4,
=ROUND (—56.5467,3) - uReun —56 ud.

Gudi oflon GengRei 2uud yel v Auaar w2 0 euiafea Y A G 3dl B. vyl
7.154 ROUND [Ry sale 8.
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F7 B e X = |

A T B | C [ D |
* Value of n: 76.660000 45.560000 -56.547890
* IDecimal places: 2 0 3
> [Function used: ROUND(B1,B2) ROUND(C1,C2) ROUND(D1,D2)
Value of
* IROUND(n,decimal
places): 76.66 46 -56.548

sugld 7.15 : ROUND [R¥u-i Geigeeil
ROUND ARy %ai o »i-u 6l Q84 ROUNDDOWN ¥4 ROUNDUP & %+l aisuu-i. ROUND
Fdl o B. 20 RAY Gu AR A @ AR 530 gl 214 durl a2 dglad mell.
g;!a (Truncate — %1“111&“) (TRUNC [&Au)

zwh2 QAY(TRUNC)HL 8 3 i &, ¥l uddl aa 3 dvul & wid ofld ua 3 wvaue ayals
eudiell J2al vis vl WA sl @ B el tuld B, g-dz RAY A wauda du Al caiubig
ugdl 3eels 2is AL B0l Ava-l wyRils cnad sl AU B, A dvaini suiabig el y 25 du
s TRUNC (8l ofly ua « 2ulg & dl 2uldl Avymiel 2l o wyals cwat sl ssani
wid 8. vl R4l asuuql TRUNC(Number,Places) 8, %4i Number 3 uldl dvu 8 a1
Places 3 ealiafig uedl J2al 2s v 8 A wRud O,
(1A wdi GelgwBl weUA 53

=TRUNC(1.239,2) 4RRuM 1.23 44l 8 . »is 9 spudla ¢l

=TRUNC(12.5)< uReun 12 34 & A »is 5 dpudla gl

=TRUNC(-15.72 ), URRUN -15 4 & 2 ¥is 7 3 2 pudl) ¢,

GuR+i GewsRHi TRUNC (A%l oowiad INT @AY vl gl vt wRend-l détad @ Rur
s, adl AS wsal 3 TRUNC RAu 2udell dvqniel MEIR oudl ssd sl o vl 8. a dvaq
UGS 528 Al 20 Gelgwd sl 71640 eulon B,

E7 oo X = |
A | B | G | D
' Value of n: 1.239 12.5 -15.72
* |Decimal places: 2 L
* [Function used: TRUNC(B1,B2) TRUNC(C1) TRUNC(D1)
. |Value of TRUNC(n,decimal
places): 1.23 12.00 -15.00

24l 7.16 : TRUNC [RRu-i Gesal
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ROUND [@8yxi 2nudai Gelgw-l ugl Medly $A 2 3 % Geldwel-l TRUNC R84 wd wylol
3] oL,

i3 Ay (AR (Statistical functions)

3l awals oufifas RAN Guld Bud-l Aell Gu wds RARY sy QAN Bl dxa yau R
8. 2 Wisslu QAN 2i) AL s, df RsAuEL s dHY Al AHFUNL dll Wil sl
qeegw Wi O Fefl 2ndl 3 Rl Rdid 2w Feldl dad sl dam adl 3 B, wd), ¢d
149 32als NARd wisddly QAN vew 530,

U3 (Average) — AVERAGE [d3a

AVERAGE [Q8y 2006l vl 3309 Bad wedl 200 &. AVERAGE W 2A531Rid+L 128 did ua
@il wid 8. dd weldl Well oyl Al uanl 530 d el edl ga v (weld ) Q
ePUAR 524l W, dR 2l Heddt 30 Budl @ af Fa wdRan(;)ell gl wsanl wud S, sd ad el
9L 3 BHAl sigd adl A4 @IS vadl Wiy A4l R vl slue 530 asl v [RB3y] ausu-
AVERAGE(x1,x2,...,x30) 8. Gelé@l dil3, A ail A A4ui =AVERAGE(10,7,6,8,9,5) @vil dl -
oclel 7.5 wid, w14 7.1741 AVERAGE- s eafdd 8.

B3 v fw X

A T T R —" F— —] [ ——", W_—"7c -

10 7 6 8 9 5

— I:AVERAGE{BI_GZI

* INumbers:

(%]

w

A

Function used:

Average of Numbers:

AVERAGE(B1:G1)

Fg T

»u3(d 7.17 : AVERAGE [Q8u Geigam w1 Redn
s (Mean) — GEOMEAN [Q8y

GEOMEAN (Q8y 2w10¢fl vyl a0l 2s (geometric mean) Bd widl 20l 8. 80l
Qu Adl n dvaddl aHeld: Hes Aadal W2 ol o n AL RIS s7l el A nth 4
slaaidl 2d B, adl Hedd 30 A (Bud), winls xnudl Qi) ad w8 8L 20 RAus] aisua-l
GEOMEAN(x1, x2 ,..., x30) 8. 2 ad 32l A Aaui =GEOMEAN(10,7,6,8,6,5) &vil dl
6.8 s HOA.

3R ey WS+ HUs wEL Guast ® ¥ HARMEAN (gR1cis s harmonic mean) 8. €lets Heisedl
QU HARMEAN(x1,x2,...,x30) 8. GuR 28U1ddl 321 dAs g Gurs (A8 adlal bl

W28 (Median) — MEDIAN [Q8y

yaRe 3 WAL A0 s3ui olsen uedl-l e v . A ad Bls Ml s Ava + Aad]l 48
(el ga o4l vl Ad Qu @AR) dl 9l 8 vl Auw . MEDIAN [Q84 Hsda 30

Yaid w93 8. @Al AL MEDIAN(x1,x2,...,x30) 8. A Wslle-i 51 Aasi ad
=MEDIAN(10,7,6,8,6,5) @l dl 6.5 %06l HNQ.

oiges (Mode) — MODE [Q8y

MODE [Q8y 20al HdnM 30 A6 3 % g5d s Bud vyal Aa-) R €18 a3, d 32 Az el
iy AWM B wiedl 20l 8, Al dlsdus-it MODE(x1, x2,...,x30) 8. tlLd. % a3 MODE
[Af4A =MODE(10,7,6,8,6,5) avall dl d 6 dle »uud. sugla 7.184 QARY wisadla @YD
saldal 8.

£¥Y23- AU : 10



A ol sl oD i | B
' INumbers: 10 7 6 8 6 5
2 |IFunction used: AVERAGE(B1:G1)
* |Average of Numbers: /
4
5 [Function used: MODE(B1:G1)
& |Mode of Numbers: 6
7
s |Function used: GEOMEAN(B1:G1)
9 |Geo.Mean of Numbers: 6.822
10
11 |Function used: MEDIAN(B1:G1)
1z |Median of Numbers: 6.5

vugld 7.18 : GEOMEAN, MEDIAN %A MODE [23dl
CountA [A82

COUNTA R4 8§ (Bl A g 326l 4l 2inal 4ail A4l el 8§ adl Ava 208 8, ddl
yead 30 3 (Baid), weis mad)l Radir) WAL BaG)dl xnad wdd 2l af) 8l dxidl
T2y aadi wys Bud (A4S R wsRel) S ok A 2eals vudl va S ak. COUNTA RAy 2ys
Gad duddl dadl ga A wul 8. wdl Jadl a@ddl dul 1l «dl 2w Qla-dl asura-u
COUNTA(x1, x2, ... , x30) 8. % a3 A4l =COUNTA(10,7,6,8,6,5) aviall dl aralst 6 nusl.

Wi WA Bua (Largest value) — LARGE Q84

LARGE (@834 2udell x vyl aigl kE el {2 misadla Bud wgdl 208 8. Al disaas
=LARGE(x, k) B, ol x 3 w5 Bud) 4uadl Ad Rrdi- REd 53 S 2 k 3 dvaud enq suld 8,

2L [QAY el A Gladt s34l aR(A k -+l Avu wedl w0l 8. Gelgw ails, 10, 7, 6,
8, 6 ¥l 5+ Budi-il ARl LARGE [RAuni 2 Gaid w3l dl 2@l orcuer 8 Aedlyl. »u v 8
W, el Yl e ol (20d) DA Gua S.

2l Ry 2a k-l Bud ail SRS yals Aval 20l 9 R 3 A 3 4 S 13 v wuddl
vl ARl ga AvaL sl AW A &S ud,

AUl Ul Bad (Smallest value) - SMALL (84

SMALL (283 20l x 2ivaiel algiiell k% ceidi il 2isagu Bud wiel 200 8. dedl aisua-i
=SMALL (x, k) 8, a4l x 3 w45 Budl buadl A Ri-A) FEL 53 8 s k 3 dveg a-
gald .

21 (A8 2] Avaipla A2cdl s+ el k @il v wedl 20l 8, G a3, 10, 7, 6, 8, 6,
5+l Batdleil A2ui SMALL RAuuI 4 Bud 2l dl oot 7 Aadle) & wullel Avavilai 24l Al
At il vl B, BUsR 71940 LARGE, SMALL 314 COUNTA R3x Gelgagll 18 eafon B,

el [ 137



H12 Bl o X = |

A 1 B | C | D | E - —
' [Numbers: 10 7 6 8 6 5
2 |[Function used: COUNTA(BL:G1)
* |Count of Numbers: 6
s [Function used: LARGE(B1:G1;2)
s |Second Largest Value: 8
s |Function used: SMALL(B1:G1;4)
s [Fourth Smallest Value: 7
10

aigld 7.19 : LARGE, SMALL %1l COUNTA [d344i Géigzell
3 (Rank) - RANK R34
35 R 1S 206l Avapiildl aRnl S s8] s3ell Avasdl 4 Ud 20 B, 2 W2 axld S Bua
(maal Buasl a-is) § 3+l s34 dand 2nedl 8, Avial-l oel (Ad-Dl [QadR) 1A Avuizil- sllsaal-il
£3; Uadl 44 U2 1 A GldRdl 53 W2 0 wenad) W 8. v A8y wldl vaiel A2 Aadl ¥ Gdradl
$HL dNsa B 2uuel sudel e wun (udg, ofly, Hlly... adl3) J2ari 8 A Bud wad 20l 8.

U (A8y~{l cdisyu-l RANK(number, set, order) 8. Wl ¥ ad sl 67 321 Anadl 8. aii Wi
Fel2) 47, 56, 78, 59 w66 A& Anen B, dN ¢l L 3 dl Fedal dHl s ofld B; Wl aul
sairl uddl «lo2 »2d ¥ g Gladll sHHl B, 0 WRAL ai Wl g $5d A9R AN o Aadl w4d
S % dN §5d AR Bl o (69 BolAl) R Luqdl Il 8. ugl Qu % % qon Renel-dl
WRA €u dl o iy ? ycus 8gl uddl 8. W W2 RANK (@34 ARl Geiget dild, dad «isiR
ool H12 (3v{ldl Ad Guryl), d RANK (284 =RANK (67, A1:F1, 0) AUl 25 21 sl dHiRl
<oz 2 ¢4, 3usR 7.204 RANK (A eale] B,

WgdH (Maximum) - MAX [Q8

MAX Q3441 atidni atd 30 24 (35 Ad vigal A0 Qi) 2udl s v 20 2anifl QaHl
WA Avul (dgad Baa) vl w6 8,

w1 QAU asuu-l MAX(xl, x2 ,..., x30) 8. G oeudal Rendfd-a -l Gelgedl Heu
J8l WAl W2 ddl MAX (RBudAl Guilal =MAX(67,47,56,78,59,66) 2uMld s wnl 6l 2wyl
7.2041 ¥Rl WHIR A [[RY 78 ol Urd vl

H12 oo X = |
A | = T - T
' INumbers: 67 47 56 78 59 66
* |Function used: RANK(67,B81:G1,0)
* |RANK of 67: 2
4
s [Function used: MAX(B1:G1)
s |Largest Value: 78
7
8 |Function used: MIN(B1:G1)
s |Smallest Value: 47
10

2ugld 720 : RANK, MAX %A MIN [Q2u-l Gualal

138 £9222-BRUA : 10



4YdH (Minimum) - MIN (A8

MIN (Q8uui at3nl ad 30 44 (s A4 g A4 [AcR) WYl Wsd A7 20 gyl Al sl
vl (agan dvar) wigl wd 8. w [AU] asuaal MIN(x1, x2 ,..., x30) 8. Gu arudal
Renaffuilril djRil Geldel aydd R el W2 di) MIN RAun). Gualol =MIN(67,47,56,78,59,66)
A 53 w8l 9. sl 7.2040 eaulen wdl A [ARY 47 st wad uvdl.

-+l 2249l (Calculation with money)
adell R+l sriddl W kel umifle RN Yl R 8, WA & A A sst e WA wd 8
v 5 8 :

“tlal, didt $3gee-l Gualn $387 4 sd 3 o A sisuidll § uwi4 v af

2 A Ysqar W 635 und suvil il Ysg il Quv-il 62 Wsuevil 28

dl szl vl ana aad P
241 W2 anld 48l AR sl Ul HuaAl As 22U SR WA quidl udl, IR0 dig s
W ol B B, Ml 35 danl W RAY aud R B :

=NPER(7.5%,-12000,100000)

gl NPER-L Guaol dd Gedlril el Al sasll -t anapnai-l agiadl 22 ad 8. 2 Rladg
udq A4 (7.5%) A wyw aux- 62 B, ol Ad -12000 A UMs ¢ui-ll 24 (3Rusl) B (A v B
S0 & el ¢l Yl wd Al ga G-l dlfdl samiell 2w . ole srell WR); wdl ani sl
1000 3. WR WL west ysd & A adul ge 12000 3. weor wUA; Ay ud A ga Gedll el s
8. 2 dd il Yt IR AT gl du)l Ol AR A 13.56 al walst Wl WU, 20 A o wae B
F AL S5l MBI SAIAL Sl U Gersw SR 7.21340 sufde B,

E7 B e X = |
A | B | G

_ |Total amount
~ |of loan taken: 100000 (Rs.)
, (Interest rate in

%o: 7.50% (Constantrate )
, |Yearly total

installment: 12000 (Rs. 1000 per month)
¢ |Function used: NPER(B2, -B3, B1)
_ |Duration in
" lyears : 13.562227330178 (vears)

vugld 721 : NPER <3 G&Sl-u dldai -umi wesl ysaan -l aHusui

NPER [38u-~{l aisu3-t NPER(Interest,Instalment,Loan,Future, Type) 8, 21l interest - e+l €3,
Instalment - €xtiv{l 25, Loan - Gefl-l flfell 243, Future - e gl Yseu ussl 8l 3 (uau-y {d
U8 Geflll eflAefl 2waiell Yyl ysaell sA ¢2) WA Type gicirll AqudLousl wdal Ysaell seaunl 2
8 % <l (A anuoun-l uddi gl Al i dl arll Baa (type-ll Bud) ws du B, v o 4
Aveul 209 8.) wdl Futire 41 Type A6 3 3B © B dil AS wsl ¥ 2D QUL Geleal 21
ol Yeiefl GuElaL Sl el SR % 2w Yyl el ysasll s Sudla Bl A wipum-l udai
ALY {d 20 gl Ysaell 3030 el i Fg ol AU QU 20y Ysad W3 8,



3all -l dwaddi sd W2 AW UsRAL v 2As RAN Wl ud B, Gergelul edxdl awiadl,
Al wys i-{l uy-ll Bud (net present value), @l 254 (Future value) il 24 Wsarl
dARlu 8. ddl klldl help-il GulaL 5 ue del (B a3 [Qdid Aad)L

Feld (Making Decisions)

2R v Yl vul sdai AAN) s5d Jears wa-d) Gualol 6309, A< Gu WBW sAA AS Bua wel
WAL Sl d BRIBIR WNRU W2 UYL S S D URL 9l A RAN) ANeal waly 4l A QAU Jeans
Wil (sl Aol uas i dl A QAU wals sday. sian Wikl sid 32 suvell W ard) @AY dai
AL 3 ¥ ydFulRd sRdlA st Frela ¢ ad. w20 vied Gew@ 8 dudl uland uReua. 2
g Vs GelRa dl Fl dxiL YRR seu 48] s W2 YdFuIRd s 2l K3l B.

A dMIRL AR >=35% A < 48%; AU Al a} PASS 4ol Aad) ¢,
N iU @ >=48% U < 55%; Y4 dl a} SECOND asl dudl ),

M A YR >=55% A < 60%; €4 dl dA FIRST ol Aadl e,

2L WSRAL WA A U B i 2L Al aslvicls df v wouGel <l siefl -l %32 W
D, IR0 U WAL vAs awwlds RADN YA ud & F aw sdd A eAdl & D, wd), 2ud
UsIRel deals QAN viouy s,

IF (A8 a3 Rgu s (Making decisions with IF)

el audl ot Rl RANMI Alell wu-sds (Waid) RAA TF &, v QAN 28l 2 u B :
Test, True ¥ False. Test Yelald /4 dul ¥ d-l S0 sl & Al Ra 83 D, il
yelafi-l omdi] 53 B A A wRaud WY U dl A True Reusrd saldell Bua ud 53 8 il
False Rouaail eldel Bud uaa 52 8.

¢d ad -lIA wig el €l ¥ Il afelleni wuci £ -
® Ad A2 31 B2ul wad vadl Bud duil.

o Ad C2 3l w854 flA g [QAY auil :
=IF(A2>B2,"Value at A2 is greater", "Value at B2 is greater")

o ¢d Ad A2 w1 B2+{l Baudiril 33 5 3 Ad C24l g %1 WA B drl vewn .

sugfa 7.2240 ealon W @ddl drl A AL Bl Andal oL 6 Adul eima sl dy dl
g5 WUl S8 AFd 2l A Feld sal W2 s Yot di qvfl Wil

B4 B fo X =]=IFiB2>C2. "I win". "My friend wins") )

E—__——-—E""F

A B C
Me My friend
, | Score of a
game 13 17

Result of the
game: My friend wins

agla 722 : RFa Ha B ?
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adl gidal ol (vissrRell Alhd) Yot AS wsall. Gur weudal Rendlal wRBUMAL GeldRni Ag
$dl a43 IF @3yl -1 sai-l 32 W 8. vudl Ay (A 2ulg 8.

Wil ¥ Ad A2 Hi Renefl ga a1l 2nl Ag 53l B, 3 W2 dd TF RAY A wud avll 4 :

=IF(A2>=60,"First" JF(A2>=55,"Second" IF(A2>=48,"Third","Fail")))

Gua-l RAuML, udd IF Rud A4 A2l Bud asid 8; 3 ¥ Rendl ga dar 2s 8. A A4 A2
Bud 60 sl 3 il ¢ dl veldRi-l Bua 0l aud > @8y uddl yelafui oRuddl Bad
wedl v, ¥ ¥ "First" O, A [Qeuelldl 60 sdl 29 251 ¢ dl A RAuA ollw ueialidl Bua
A 3 ¥ vy IF R 8. 20 qd dil 25 [F (g 21s IF) aHd 530 usl v 20l dA
nested if sdalil 3 8. gl 7.2340 w0 euldd 8. suglanl IF R g€l o€l wsaail ealaa
W2 2 vins Al U v dR Aade 24 2ulal 8. A 3 BN Yot F5d s ¥ AR Avlg
8. (9l sbafal i Gu Randl sia 8) A sl 72340 ealen W A Yo v Qenefo w2
L (15a) 53¢ D

_— ——
econd”. IF(B3> =48, “Third *_-_‘;_,,)J
o | 5|
_ |Name of
" |student: Mita Sita Rita Gita Nita  Babita
Student's

marks in %: 77 69 59 49 44 30

s Class of the
student: First | _First Second Third  Fail  Fail

NS

Copyving the formula

wugld 723 : IF ([QQadq Geg@

g Hl2l Yol uiainl Y O ld deil GuRl uss dlell U ol asudl adll Ay 8 vie d aual og
af a¥ B, i 210dl W2 dd $sa- QAL Hee A whl Ol $su R AvRa As s A B &
Al [ARue udel wg At 268U 539 uig el g quid dil §san @AM YA wA AR Al 32, ¢
Structure 20t Yae s Aul wusla 72400 eulloq WD dd avlal Yoief WA Ad vad 3 ¥ @AY
sirilaelie], oitRRL wuolgol Ao welld 43 B, A dul 56 el ¢ dl A Wil awa Big a3l eald 8.

]

Function Wizard

Structure of the IF r
function Then_value [fiel “Second n
(o o

60."First” IF{B3>=55,"5econd”, IF(B3=>=48, “Thud","Fail"]] |

Array Help Cancel Next == oK

vugla 7.24 : [QQud slwre

sellni (Qdy 141



Aoild uBus (Relational operators)

GuR-L GergRaml TR YA IF Rl wal 52l gdl A wund >= Fai uBus (Aulzr) Al sdl. vial
WEUA (2ludal) RAuqa 20wz s3u 8. fes 7.140 dHR 239 RAara suiza- wgl 2udd 8.

Fdada wivwdaz: R&a gl

Equal = oid sl (operands) (FH ¥ Al 2l A2) Al B,
Gelel =IF(A1=A2, "Al is equal to A2", "A1 and A2
not equal™)

Less than < wuy As oflot Wsd sl ~u-l 8. Geler =[F(A1<A2,
"Al is less than A2", "Al is not less than A2")

Greater than > way Asd oflon sl sral WA B, Gelsw : =[F(A1>A2,
"Al is greater than A2", "Al is not greater than A2")

Less than or equal to <= way As oflan s sadl AUl g sAGR B, GelsE

: =IF(A1<=A2, "Al is less than or equal to A2", "Al is
not less than or equal to A2™)

Greater than or equal >= wai Astd oflan Asid sl WA 2”4l BRAR B, GerdeL:

to =IF(A1>=A2, "Al is greater than or equal to A2",
"Al is not greater than or equal to A2")

Different from < ol And A e, wun And ol And oo ol

Gelsa®l : =[F(Al<>A2, "Al is different than A2", "Al
is not different than A2")

sres 7.1 : RQRY fdaa 22 (silRd wBad)
alEs QAW Logical functions)

IR0 2iru Jeals @AY Wi uld 8 ¥ dwlfs Feldl daimi see3zu iy, 20 RJYME AND, OR 2
NOT-l uxda iy 8, s QAR s2u2l Yol i urd BAANAL 2l KR Gudsll sid 8, »1
Reusail Gu wguddl 28l dlfs QAN Anwr wild] &,

TRUE

W RAY 2uved ¥ Bad wel 2wl 8, d dilfs Bud TRUE (W) 8. »u RAa-l asura-
TRUE() 8.

FALSE
2l B8 e ¥ Bud wedl 20l &, A s Bud FALSE 8. 20 @3-l aisuranil FALSE() 9.
NOT

> [ aisRaq NOT (uaiald 3 @ uRaus diffs Buaul 20d) O, 2 NOT Rl aulfs Baar
Al Qud sieuq O, vuell FALSE siecid o TRUE 67 ® »i TRUE olecid A FALSE oiq 8, (13-l
Gelgel ol :

=NOT(6<>6)<l kud TRUE 44 8.
=NOT(1=1)-{l B3id FALSE 34 6.

¥Rl NOT(TRUE) ¥ NOT(FALSE) av{l aslsl 7 uact 430 g2l wigla 7.2540 TRUE, FALSE
3 NOT (FALSE) «ii 32dis Gerg2ell suddi 8,
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A | B |

1
2| Logical function Value

3 TRUE() TRUE

4 FALSE() FALSE
E | NOT (TRUE) FALSE
9 NOT (FALSE) TRUE
_il NOT (6<>6) TRUE
8 | NOT (1=1) FALSE

9

»uld 7.25 : TRUE, FALSE N NOT (A8 Gewgazll
AND [Q8y

2 A8 93] alIR 30 Ad(arguments)il WReUMLA Uvladl W2 auAY 8, A ol o Aad) [ Y
WReun TRUE 248 dl % AND< uwReun TRUE uad. 1 R3]l aisuad
AND(Cond_1,Cond 2,...,Cond_30) 8.

wdl AND [y &1t 3¢ 3 el 8 ¥ WReud TRUE »udl FALSE Al wudl 23, 224 & ojfdu-
Gaadl (Boolean values) sl 3w, ¢d i Gelgaw Al % wNR Mg & ¥ Ad Al, A2 ¥ A3l
Badl w0l 8 & 4dl dl 2uusl 2 nRid ASW I AL A A2 Wl B F <Al v uel wuugl el 3
A2 ¥ A3 Al 8 & Al oA biel-l wEeun AUl @ dl WD sl 53 wblal 3 A8 Baid wvll 8.
22d 3, 2uysl "=" RAune e Ay & ) sirlladl W 3 ¥ A1=A2 B A2=A3 ® . v,
AND (R4 =AND(A1=A2,A2=A3) av{l usd. Gu ¥ 33l sA A 2R 7.2641 ealddl 8.

5 3l fw ¥ = [-AnD(A1=A2.A2-A3)
A | B C | —
1 12
2 12
3 6
4
'_ 5 Are the above values same? FALSE]l

wuyld 7.26 : AND Ru Gewszm
OR [Q8y
w1l [yl asa34L OR(Cond_1,Cond_2,...,Cond 30) ®.

al OR [@AuML Qw3 atil 30 URdlAl (arguments)ii WRBIAMA Avlqdl W2 Wy 8. A el
wcdlniell weoni wefl Bs Y, WReuM TRUE ¢ dl OR e TRUE Bud wel 2wvd,
Geleel a2, 2uud Gur aeldal dilfs AND QAU Y 4l U yaul Bl §25R 7. 2006
WA 28 Ad AL, A2 3 A3 AU DAY Sl ddl. ¢q WL ARl S ugl A -l Bid
AN U L 2R AN qtal Sl ¢l 2 W2 =OR(A1=A2,A2=A3,A1=A3) aull asu.

(120 Aolil Gua Q84 TRUE Bud wiesl 20 :
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e N Al 6lALR A2 Qly;
e A A2 6N A3 Qg
® A Al SRBR A3 &y U
e A Al, A2 uA A3 Al Bud al Q.
ol Gual ot o Rl W2l i dl [Qtud FALSE Bud uiedl 2044, 3Wed 3 Al ol Qs
AR Qe ANl At FALSE (B siivel.
o Al SRR A2 «2l; A2 60 A3 el; 3 Al oRINR A3 «ell; % il bl Rl
A €U dl % yReun FALSE wadl.
wed & o [Qluni wuddl ol 2dl FALSE &4 dl & OR (@84 FALSE [Fad wiedl 2um4l.
R 7.2741 OR RAx-L J2ais Gersel 2ddi B wiA shey 7.200 dilbs QU Jeails Gergrell ullal 8.

A4 8] f@ ¥ = [=OR(A1=A2.A2=A3,A1=A3)

A B | C | D | E |
1 12 12 12 6 6
B 2 12 6 12 12
3 12 6 12 12 3
4 TRUE] TRUE TRUE TRUE FALSE

sugld 727 : OR [Runi Gerdal

Gelgel uslafa-l Baua MELTEN
At-ll A2l A3l
Bad Bua Bud
12 12 12 Al=A2 > TRUE TRUE
A2=A3 > TRUE
Al=A3 > TRUE
12 12 6 Al=A2 > TRUE TRUE
A2=A3 > FALSE
Al=A3 > FALSE
12 6 12 Al=A2 > FALSE TRUE
A2=A3 > FALSE
Al=A3 > TRUE
6 12 12 Al=A2 > FALSE TRUE
A2=A3 > TRUE
Al=A3 - FALSE
6 2 31 Al=A2 - FALSE FALSE
A2=A3 > FALSE
Al=A3 > FALSE

shes 7.2 : dlfs QAu OR(A1=A2;A2-A3;A1=A3)-i [A[Q4 Gergam
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@at &5+ {String functions) — wlEes avua Gu-i Q%A
wlbes avua- & REa osel (Joining two strings of text)

CONCATENATE [QBu w(s auugi-l awidi awl 30 REa (string) 4 Ad a3 8. 2 @Ayl
alsaRul CONCATENATE (textl, text2,...,text30) 8.

did. CONCATENATE [38u-i «iuq o1gd ‘&' Q& wal il as o). 28 ¥ “ice” 2+ "cream” %<l
ol ol a2 il RAuA 1A yarer avll asl:

="jce"& "cream" VY
=CONCATENATE("ice","cream")

Gurrl oin [AR¥ ulReun [P0l "icecream” Al % ol uoEl qd g wudl YUl (space) dui
ASA € ol dd dHiell A us s FEoMi dA GAN W P I ="ice "& "cream" 2uql

=Yjce"& " cream"

% [RFoL duil wddl-l 8 Al 23S el Madl (WA & Al v A2)ui 536l A dl ad =A18&A2
vl =CONCATENATE(A1,A2) ual axl us.

(12 el Y R
o A4 Al Guz ¥S g WA UM avil

o A4 A2 GUL ¥ dwRl Rdig st @ull

o Ad A3 G ¥ awdl ws quil,

o A4 A4 GuR S s vuel o " " @ul

o & [RAyAl Gualal 3 Ad CIUl =AI&KAIKA2&AIKAS

s14ld 7.284 CONCATENATION R8ui J2ais Geldrell el 8.

A4 Bl fw 3 = |=CONCATENATE(B1.82)
A B ’y’ C

3 ICE Function used
2 + cream

4 icecream | N
5
s |Use of & operator
7 "ice"&"cream” icecream
8 “ice" & “ " & "cream”  ice cream
9 B1&“"&B2 ice cream
10 Bl & B2 icecream

wiigld 7.28 : CONCATENATE [Q3u-i Gewgmil
LOWER R

2 @AY el ot QAN el ynadlower case)l 329 8, w1 Q8- aisu- LOWER (e
VIR ) B, GeldR@ : “LOWER("School™) @ raistHi Baid "school” Yad 2l 8.
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Upper (g

il @AY wulel oty waAA Wel Youad(3R2a 2a upper case)dl ¥4 8. ¥ QAU aisuRa-l
UPPER(text) 8. Gewd:8l : =UPPER("School™) 2uugle, wawopi Bud "SCHOOL" 1 8.

Proper [@an

2l QAY o1t w6Eld) Uddl B Hl2L AUl vin sldlel 4 Al Yol 324 8, w [l
syl PROPER(text) 8. Geldel : =PROPER ("I love my scHool™) «ll (3ud I Love My
School uitsl 2UA 8,

A d LOWER, UPPER 24 PROPER (B8 eacidad sy gy il w2 (slle s
W) qutd B, qoy Aa sz slel treldll Yaurdl i aedl well w3 &y B,

AuA 2 WIS ¥is (Roman and Arabic) W2+ [QRy
ROMAN (@84 20l 2vaiq i #isnl §4 8. d-ll aisuasit ROMAN(number, mode) 9.

wdl W iy 520 & 0ol 39991 aivul o Ad-L 2isHi Y 30 wmu, il UG AaHi ddel vl
Gud 21 dedl o dldl ASA. ail el L & A A yell gel o€l Ad anll wny 8. W 3 v
8 did Ax-l duidl 8, dR U Avul VIO {ld avll ws), 24 3 3 o v ad IIX dd wa
avil asl, RAuMIY ofly aa L A WYUd-ll WK W2 AUy B, 2 Mode uadl Bua 0, 1, 2
udl 3 &S wh TV 2l Bent Geloul Bedl ufl viq ofle arqwdd widlas el wsa w2
A3 AvAl GudloL iy 8,

36 QAU dit RAY 52l QA B, d st AL Aell A4 dfl2 A A 23618 Al 329 D,
(A e, Gers il :
=ROMAN (125) {1 Bud CXXV weil u4 8.
R3y =ARABIC("MMXI") 3| G wedl 200 8 A Al 5181 7 d 2013 B ?
sugld 7.2941 d2¢is ROMAN 17 ARABIC (A4~ GelgRell wulai 8.

A [ ) | C
Function Value
ROMAN(125) CXXV
ARABIC("mmxiii") 2013
ARABIC(ROMAN(2013)) 2013

Also consider following examples to see how mode works

~J o wn +a w %] ]

ROMAN(999) CMXCIX
s |ROMAN(999,0) CMXCIX
s |ROMAN(999,1) LMVLIV
10 |IROMAN(999,2) XMIX
11 [ROMAN(999,3) VMIV

2ugld 7.29 : ROMAN 7 ARABIC [R3uni Gersel
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Trim QA

2 AfY el wles aviamidl (REauidl) aunl viel ooul (spaces) &2 2 . Wed & w adl
TRIM("I Love My School!™) @ull dl d ddd I Love My School! Wi 2ud. 21l
[@fy~{l awsuy-u TRIM(text) .

[REarl urvunell s24l (Comparing Strings)

EXACT (@83 2udd] & ol auunell 43 8 A A A 2uell (ol Blaga avll @ dL 1 Gad

W 42 8, v AN AWl 4 QU dl 0 Bra yrd 53 8. Gedw ¢ =EXACT("Blue", "Blue")
iy 1 Bud vad 52 § el =EXACT("Blu", "Blue") 2048 0 Bud Yd 52 8.

uil [Aurl aisuy-l EXACT(s1, 52) 8.

(REat-u Q21eust Wil (Substring)

Il ol ougel REadl daieua sal w2 ui ofly iRl suydl Rkl audl sadL w2 W &
QA4 Guasy 6,

LEFT A8y wbes avianidl ol sug-i uddl a2 madl »uysl wridal n xa:) wesl sl 8,

wl A4l aisua-l LEFT(Text, n) . 2ufl, suldl [Eoiel sioll sugell 4 aaRl gel wsal w2
Y8 =LEFT("Ram Dhashrathbhai Patel", 4) el 24l % "Ram " s wedl 2uusl.

2 o we RIGHT [A8y sived 2udal s avuadl [REaidl ol sy« Sael n 21831 921
wdl wus, wel 2w B, Wed ¥ o Wy =RIGHT("Ram Dhashrathbhai Patel”, 5) au{l®) dl
"Patel" %aiel Ho1g), 2 [l asuy-l RIGHT(Text, n) 8.

Jall RForell qdefl avurl o€ seusll wrasdl ua Yyl R 8. . [RAurl aisyaAl MID(Text,
Start, n) ©.

Gu-l Gelsedl wudal syl a2 Ay oE wdal MR NS =MID("Ram Dhashrathbhai
Patel", 5, 13) aulad dl "Dhashrathbhai” Ggal wiedl wudl,

([@a-ll douS(Length of a String) LEN [d8y

LEN [R8u 200dl (s auig) GFoidl dons (32al uaRAl 2uda 8 d) aeud 8. d-dl aisuza

LEN(Text) 8. 202l 9 28l LEN("Ram") avflal dl suueid 3 wawn qai. susld 7.3040 REa
adldl [AAYHL Gersell wlal 8,

A [ B

: Function Value
 [TRIM("I Love My School") | Love My School
> |IEXACT("Blue", "Blue") TRUE
* |[EXACT("My School", "New School ") FALSE
> |LEFT("Ram D Patel", 3) Ram
° |IRIGHT("Ram D Patel", 5) Patel
” [MID("Ram D Patel”, 5,1) D
® |LEN("Ram D Patel") 11

vugld 730 : R¥AA aoidi [AAAAL Gerge



Time i~ Date [Q8) (Time and Date functions)

3@l uuan auy, A dflvidl aeal Wl RAY Y1 ud O, FHL el AnuouulL (BH 3 sals,
B2 vadl Aswui) U dl ad time [QRAuA Gualol &30 A8 e 2L AxonuL 2 (FA
s, HRAS) iudl 9ul) dil Date RAU-) Gualal 53 A

el Al gl W2 (Today's date) TODAY [48u

TODAY (B2 duil sl A sl 2ol vt arud 8. v [yl A a4 <ol @Rl 3
ol ardle 1130 yaus 2013 8 dl TODAY() (@34 2uu@n 11/07/2013 wadl 11. Jul. 2013 (a1
sl % A gl A2 53¢ ¢l A W) rawe wudl.

Date (284

DATE R84 2udd 2ddl af v 29 Rau wsud we adlve 2ud 8. Azd 3 o dai
=DATE(2013, 1, 1) 3l dl A @AY 1/1/13 Bud wiedl suyal.

Day EE]

DAY (84 £ ual et @3yl 2l dRlue afddidl Rausil 3dal w2 quuy 8. Geldrel @ o
3 113 yas 2013 @y dl =DAY(today()) YuMetd 11 ¥t Uyl

GuR orudy [Au wuuel =DAY(DATE(2013,7,11)) ut avfl uglal. »u @fadl asara-u
DAY (Date) 9.

DATE [@Auui 20ld 2a diflv 2a3usi Y3 widdl viddl 212 w8 21006 ey ¢ d dd DATE
RBAu quil as. DATE [@Q8u Auus suldl Avid et didluedl azudl 89 8 wid usil
ArRluinigl Ray-l «o12 wiel 2l 8.

WEEKDAY [Q3y

WEEKDAY @84 24Ul duel 3l alvid slsanludl aiz (33 3 dHar, {aaw,...) 4l &d
8. Radld daqsd <ok 0 (RAQaAR)HL 6 (UMAR) wndml 2ud 8. Gelgww: A ad
=WEEKDAY(DATE(2013,7,11)) @vil dl ¥als. 5 1o,

»il R qusRudl WEEKDAY(Date, n) 8. 1€l Date 2 516 Ml iRl © did n 2 vl & %
wigalldy sul Rauell a3 ey & d wzud 8. di n w2 A Gidl vl us oL

N=1 : ARy Mardl a3 wu 8. R 0).
N=2 : Ry Aniardl 3 wa 8. (Ran 1).

o dil U4 (argument) <L FRUAN dl d BHd 1 AL, ded & Gurrl Geigw i R WAL [RaiA
s <o 0 (RQAaAR) 6 (wFiaR) AR,

(1A J2dis Gelgall 2wl & :
=WEEKDAY(DATE(2013,7,11),0)-1L st 3 a4,

=WEEKDAY(DATE(2013,7,11),1)-) it § (ydFulRq) 3 &
=WEEKDAY(DATE(2013,7,11)) 8013 14,

=WEEKDAY(DATE(2013,7,11),2)«\ ¥ 4 104,
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Month Q82

MONTH [8y £ sq dwlvd  dqlsdidl ded] §d 6, Gelsw o ad
=MONTH(DATE(2013,7,11)) S Ad4i amall dl s 7 1adl.

il [ABYl aisuuL MONTH(S) .
YEAR [Q84

YEAR R84 #ird didluid avdail 24 8. Gewsd a3, A ad =YEARDATE(2013,7,11)) )\S
A4Hl auiall dl s 2013 Hud.

¥l [FAul disuRal YEAR() 8.
il (Bl v (Number of Days in a Year)

DAYSINYEAR (@84 uas{l didlv wida iy d adql ga ReRll v 2wl 8, wlsalle-u dani
(124 RAY quil :

=DAYSINYEAR(DATE(2013,7,11)).
il [QBY 365 aie il
3l [QAu{l aisuRudl DAYSINYEAR(®) 8.

slg a¥ dlu 42 8 ¥ 3x d wedl W2 se dd wu6 A8 AR Wud ¥ sjaaae] Yo avy
Sl Asil 6ed ad Al Jedl Rad & d sl el wsl L.

& ardlvie) astad (Difference between two dates) — DAYS [Qdy

DAYS R84 2wl & dailvt 42l RBal adl 53 8. wdl A 4 s 3 [@AdY w4 DAYA
oed DAYS 8. 219U6 3l 53¢ DAY [Ay dR-u-) keandl Rax & d weud 8. DAYS @Ay »uud
el 6 ey Al a2l RBariledl dval 2l 8,

A s =DAYS(DATE(2012,7,11), DATE(2013,7,11)) awlal dl 366 st ®ad. 2012 < dlu
42 Qe dul 366 Ra & !

¢ v QY (A calen W@ qwi:
=DAYS(A1, NOW())

wdl Al 3s Ad 2SO Tl R Rl ot diRlu quiadl 8. ol a4 NOW() 8, ¥ sl
AU sl el awdlvt uHy 0 wesl wud. ¢d RWA 3 Gu weudg RAY g waus 2und ?
oRAGR B, di WAL O, d il (R Badlmi aeuad. . A FRAAUR dd Ml wsell & dwl
aslui Alfl W el B ?

NOW [QBul aisaydl NOW() % 9. s [Qynl AS ad -l

B An A 3 ollw v ydel alvnidl s sl wd O, el qau aHd QY wel Bud
Wesl vl 2L 204L W2 dd ABS RAuA Gualol 53 asl wugl 7.3180 didlvl i Auu- @il
Jedls QAL Gelgrwl »udal 8.
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A [ B [

1 |Function Value
jTooAv() 11. Jul. 2013
| ° [DATE(2013,7,11) July 11, 2013
| * |DAY(DATE(2013,7,11)) 11

| ° IWEEKDAY(DATE(2013,7,11)) 5
i‘WEEK DAY(DATE(2013,7,11),0) 3
| 7 |WEEKDAY(DATE(2013,7,11),1) 5
| ° |WEEKDAY(DATE(2013,7,11),2) 4
| ° IMONTH(DATE(2013,7,11)) 7

| lYEAR(DATE(2013,7,11)) 2013
ﬂDAYSINYEAR(DATE(2013.7,11)) 365
2 |DAYS(DATE(2012,7,11), DATE(2011,7,11)) 366
7 \WEEKS(DATE(2011,7,12), DATE(2012,7,11),0) 52
EYEARS(DATE(ZDll,?,ll}, DATE(2013,7,11),0) 2

gl 7.31 : didlvt 2R wHEA avdl [0

wUl 61 didlull 923 sl vl (Number of weeks between two dates)

148 Mol ¢l 3 DAY il DAYS sl a4 [RAY) 8; 3 o Ad WEEKS 6 diflvll g2
AsalRuaA Avyl dR1dR 52 D,

=WEEKS(DATE(2011,7,11), DATE(2012,7,11),0)'11 waley 52 wul.
GuR aeuddl [RAus] 6L DATE (R84 Guilol s3dl 8 % wldl an W didluedl @3uil 24 8.
20 GuRid, WEEKS Ry 3s gl 34 '0' «il u@ Gualal 3 8, 3 ¥ wsdlRuusl wsi-l Fifa 52 8,
2 Al ‘0" Bud viscuRuidl anuaual asid 8. wdl dil ‘0" A sed 1' eudld 3« wsculuidl
GualaL 53 sl €9,
WEEK ([@8u«{l aisu3u«l WEEKS(t1, t2, Week type) 8. 2l Jld DAY 211 DAYS & #1¢dl el
[@RAY) & 3 % d WEEK 214 WEEKS & 2ddl wad Rl &,
20el o dudlell a2’ ani-dl v (Number of years between two dates)
YEARS (8% el & ey aidlvl a3 ai-]l vl oamadl 53 @ 3 ¥ adqi axusuasi (ua-l
Gua 0 weudl) xadl 2R adail (ada-dl Bad 1 arudld) du 8. Geldw dadld, A add
=YEARS(DATE(2011,7,11), DATE(2013,7,11), 0) @4l cl dl 2 %alst duas,
2 @AY 4 dd Jeai ad-i aui d #ell asdl. dwdl o dlwdl suel alv a2 deal of & A
&5d Wl s12).
-y @lselle Warni Guany RAY {Functions in other Spreadsheet Packages)
qel v Alsaflz Waer L o wsdAl RAY Y ik B, A d uwdskilse Nsuad Gelgw dal dl
dil el ¥ d weL vl wsrel Al 530 duiqll H2wewoi RAD Yy wd 8.
s03s adR A+l AsURAU (syntax)Hi o8 URAdA sl U3 B Fu I sl AR LS Al FreR
al QY0 ¥a g 5 (REAM) 3 ) (efam)-)l Guylat.

1 Weellz W% [doc.google.com] UeL U % Wslr<l RANL YL ud 8. ad 2nell ) & d $-2rqe,
Qoudd Sl A NS Fell Weas wgld anRdl 0 veL Gual awy 8.
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Bl Guria o1 Wer dud Frges Wiellz 29d2 wa wids sidl seal - 3 3 Rene(fuild auusts,
woluasdl dena, NFse e, Reudll v a0 s, 2idld wds-ondsd Fuus,
GANADL W2 4Bl e, Ae-AARg @AY, st-ilag a9 W2 Yal wd 8.

Bl 2wdenl Uik weri ¥ ¥ [Qewsd), Gell ¢ A 2l gAal N8, 3R Aadlu) sa
M2l Pl Ay e Qu 8, sp1a Wsdle Fai AR eslidl dda w1 vy wouia Frddl
we Qlawdl ol o waldd sl wu 8.

ARl

Mgl w1 WseHl [ARY suBRs, Hisadly, (o, s A ynuA addi duy SR Wi-i
RAYAL woewd sdl. 2 §sud RAE WRsd &6 Ad RAY evig 530 sy A o Wy s
Guaid, RAD WA sd Rdl WM el dre REU R A A YaRUHL §s5u RS Heeau
iy B o vet vl

UL

g5 Rtd] sl gsnii unandl.
ARl waied(ll 516 vl e 2uRifas [AlY oy Geldw We Al
ARl waiedllal A6 el seL wisaslu [ABy oy GelgRel W AHandl.
Al waieoll-l Fiefy Qani Gualoll A vel »a RAY oy Gere WA Axand).
Al wedlll A6 uA 2Rl dAdlvl WA AHYA @dlal [y Yoy Gelswet We AxAn),
xRl waisoll-l QS wat AR WERSs Qv Guaru RAY ([RFEoL d5an) Wou Gelswt A, Axand),
daflul Guasy TF [RAY oy Gelgael Wl uxamd),
o8l s @AY Yoy Gelerel WA Anamd.
(Al 1) [Rsen el :
(1) ~DA-usiell S A 2uu8 3di [RAY erva 530 a4lA ?

(a) Aai QAU A {18AY adu sA1

(b) &5 [RY viaal 2asi Guagl e $A

() () ¥ (b) ¢in

o -1 A th b W N e

(d) Ay waRa
(2) RR3al a3zvud fAnHil su Rsen wd iy & ?
(2) = Ra ®) yal () ¥l (d) Uil 1S val
[Aseny
(3) QAR s Alés QY < ?
(a) OR (b) AND (c) NOT (d) PROPER

(4) g a¥f v 42 B ¥ ¢l A Al W2 ad Il wd A drlvd addi @RI
PONECORE T i

(2) DATE (b) TIMESTAMP  (c) YEARS (d) YEARDIFF
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(5) ¥eflrl Aani RAY svig saL W2 (Admidl 56 Y5 wsu & ?

(a) $5u- Rnd gl (b) 9 RAY v s

(©) () ¥ (b) v (d) @Ax wwRd
(6) %ell-i QAL Jeel w4 Al sy ?

() A5 LE! (c) A=t (d) (Y 2uuRd
(7) [ABu g g &S u% ?

(a) Baa (b) wkks auumt (c) xnd A2y (d) 20l a8

wAlBls xney

dwl el el Al e 4 As A AUty o) A dui e A, Qendldl dowr,
Qeueld Ay, DR 3 el A . wlal R W3 250 wA @l (wan asl, wa,
AWA ad3) uel L U L W2 d ddg o ald R RS g8 wel andl ws.

3@l adld dauRl v dlwtlld Bia sieidl,

dMIRL 2Rl w3 wdalld dle ouoidel HURAL Yol NPER (A8 il dld Wd saur)
AU DA

28 el el AdHl 2R Al avil, 2 Budl Adl gell 3 F A Wy v adl 4. ¢4
DATE [R8% awdld 2 Budlal sy didlwal &R,

AS didlvt a Al 1L 3 d ¥ B 3 adl ?

Housd, WE-HA A 26U W2l }alle Y3 A HRA Aaqal Yuct A s And-dll
e HLAdl Uk [ Wsalledl wn A sial

SPYQ2-vRA : 10



2yrilelo-l s A dgfill RaAuR-l audl w3RUAA £Q wudvi(s-chart)) Gualol aell awil
8. Wsalle Wy cuusudl AR Adld 2ls s vl GudBla 8. 2waw A Rwa uRkdq
usls A Y sl aid wiadl cnauls B W5 Gesw 8. wduad wisigly uRdl
Boluots @3l 3y Radl dd uel sdami »ud 8.

AV QUR KAl W2 A wel i RARY duil Hasd il A Bduidl AU AHy d-l
RMRAL0AL vie R ARl ddl ASn. ANed 3, Bl Wl wa AT uel s 2wd Yt
s394 udul du 53 el i A v Yeld Wq Al ddd duduiel vl aee €l
o ASH & vl ad Hauladl 56 A Mee3w 4. A GURid €35 Ayl B yel wed AdH
3 a8 sy wsRel 20Qu () LAY Aurdl ASA, d 2wl AR Yl ud 8, A4 su
sl 2R YA Ul D ud w WAl 2u WsR-L Fely @ asy B,

wAuAL USIA (Type of charts)

RAAL wsfa 2 vavel o3Ruid wud 2udvui-d wsR waie s2d) AR, 20dv [ARY sl w2 auan
8 ¥4 ¥ : SR sdal w2, [RAsallrl Yeuis W2, S5 dde 39 539 W2 A wRHREL B albal
2. wuell i A e % ulal wsie udni yiedll vl Wyel 9ld 52 O A s235 ARANY G~
53 0. ol ofley ougA, don wsle-ll 2uduel yaiedfl 0l A syl (Rl daudi Hee3zu i B, wuue
A A2 2udu quurcal FSW dnl wald sel (R oo 8:

AvMell w2

[Adal wuydl suuan w2

RAQ AwaL w2

wys AU ANYUNAL qdRly ReAuR 54 w2

Fud wReindl 3RsRl sudls dw s we

ARy drgull (WRZ) q-l Aokl ddavidl . AnFal HR
sfua WRRRYML 2w AR sar w2 {A wlal yaail wqull :

Al ¥ 46 sddl Sl QU d ousid AR oA,

wWRA R21) Al 5 v Al

HY 2L Sl ),

dlefl ay Doy vl AR sl 4 2L viddl A T w0du W2 Wsdl sl 2L Yol B
LR LN

AV (A) i)l wiA
A qwd wsds WA Aoy sl (12 5).

GuR wuell wHISL Y sl gal uel 2udn oiqal w2 AL wud wdlg 2L dUR s B, s AR
B3l ecudaHl 320 eud 7 sl vd Wil did A Rty (QuiEsd) a3uHl S as ol

sellml 2udwdl - 153



wudm (M) BN (Inserting a chart)

afofloni »udv Gl w2 A

wadl s 43

o Wllaul 2l (AR ude 2.
o ¢d Wiz $A: Imsert © Chart
A ¥ dud dals adaul gypudde]l AMa i Al el DA (surprise quizzes) ¥R

ol ulawadlel o Aees 8.1

oRlledl PHIGL AW D,

Quiz marks Test marks
January 35 27
February 28 30
March 37 42
April 31 a3

fnes 81 : Reellu o

Bz gcddy el WA dres 8.1 safon wwd el e s 2l s sleddl ALl wumL

U didl WUAW Sl AU A

B3 WEBUM YA, 2l AU ULl AR L.

AsdlR dd Ayel A smg 2 E el A Rrdr wdie LA udl el Brudi dad Rar
A Al ol da €5 8. ) Rrar wie sl A0 o ¢ Tnsert QAsew 2l Ws Qo Asid-
Al Gu 2eud. Auiel Chart Rsed wde s sl dell 2ugla 8140 euldl 8.

O © ® Uuntitled 1 - OpenOffice.org Calc

File Edit _!iew- Format Tools Data Window Help

e T
N

Page Break ;
. 2 & & L
Rows
Columns
Sheet... C
Sheet From File...

Link to External Data... TeSt marks
Special Character... 27
Formatting Mark

Hyperlink 30

Function... 42

Function List 33

Names =
Comment

Picture
Movie and Sound
Object ’

Floating rrame

SR : 10



